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Dear Reader, 

I take this opportunity to convey
best wishes for a very happy,
prosperous and safe new year to
you and your family from Team
Digit. In the new year, we at Digit
look forward to bringing you all
the latest excitement in the area
of technology, computing, gadg-
ets and a lot more.

In my last letter to you, I had
asked you for feedback and sug-
gestions — to talk to us and let
us know how your favourite
publication could serve you
even better. A lot of you
responded and reached out
through letters, emails, the
ThinkDigit web site and person-
al calls. It became quite clear to
us that you are not just readers
of Digit, but rather a part of a
vibrant, well-knit community
of technology enthusiasts who
not only care for Digit a lot, but
are also highly demanding in
terms of quality. It has, there-
fore, been our constant endeav-
our to raise the standards and
justify your trust which has
made Digit the No. 1 Technology
Magazine in India. 

We have been constantly
investing in strengthening our
editorial team. Last month Ahmed
Shaikh joined us as Editor-at-large
and Online Architect for Personal
Technology. With Robert as Editor
of Digit, Edward as Editor-in-chief
for Personal Technology and now
Ahmed, I can say without doubt
that you are being served by the
most formidable tech-editorial
team in this country. 

In keeping with our endeav-
our to bring more value to you,
we are increasing the number of
dual-layer DVDs to two from this
issue onwards, thus giving you
even more content to enjoy every
month. We are also enhancing
the Fast Track content.

As we were entering the new
year, we were faced with an
important question: should we
keep raising the quality and
value of what you get, even if it
means adjusting the price a lit-
tle, or should we maintain the
price and the offering?

Over the last few months, we
have implemented all possible
cost-reduction and austerity meas-
ures to help hold the price, while
enhancing the magazine.
However, this was not enough to
allow us to continue our innova-
tions and enhancements. Based on
your feedback and inputs, we came
to the conclusion that we could
stay true to our commitment to
innovate, and to our community’s
expectations, only by increasing
the price. Although Digit will now
be available on stands for a slightly
higher cover price, the subscrip-
tion price will remain the same as
before. I am confident that we can
continue to count on your support
and goodwill. 

In the coming months, you
will see several innovations in the
magazine, as well as online at
ThinkDigit.com. 

Assuring you of our best
efforts, I once again wish you a
very happy 2009.

asheesh.gupta@9dot9.in

Publisher’s Note

“It has been our constant
endeavour to raise the

standards and justify your
trust which has made

Digit the No. 1 Technology
Magazine in India”

Change is in the air

Asheesh Gupta
Publishing Director, Digit
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A
ALL OF US pored over the papers and
were glued to the TV, as reports
updated us on the sophistication of
the Mumbai attacks. GPS devices,
Russian re-mailer servers and
Blackberry devices were used by the
terrorists. It must have been infinite-
ly easier to find someone to teach
them how to use a GPS device or a
Blackberry, than to fire an AK-47…
even if they are, allegedly, from poor
families in little villages. That’s the
beauty (or the horror, in this case) of
technology today — absolutely any-
one can learn to use it (for good or
evil), with very little in terms of a for-
mal education required.

While most of us have lambasted
our politicians and intelligence
agencies, and played armchair
Prime Minister for a few days, the
real question that remains to be
answered is what are we willing to
lose to make sure that our country
and our way of life is more secure?

After events like 26/11, people are
generally more accepting of security
measures, and patiently wait in line
to be scanned and patted down at
public places. Unless you’re a crimi-
nal, and are carrying drugs, guns or
explosives, you have an air of accept-
ance about you when your “privacy”
is being violated by these checks.
“It’s for the greater good”, you say to
yourself, and move on.

So why is it that you don’t feel
the same way about your online
activities being monitored? Why is
the world so paranoid about Big
Brother, and the techniques he may
employ to keep us in check?

I, for one, couldn’t care less if my
mails and social networking profiles
were being monitored — personal
IDs of course. Monitoring work com-
munications might not be such a
good idea, because most businesses
survive on privacy and secrecy of
intellectual properties, and leaks
could ruin them. So, companies

could always choose to secure and
encrypt their work mail, and not use
“free email” services.

I expect people to brand me
insane for welcoming the idea of Big
Brother into my life, but I think it’s
only logical given the times we live
in. I’d rather some government com-
puter network pick out a billion
innocent messages that we send,
than let even a single mail from a
terrorist go unnoticed.

What have we really got to
hide? I’m sure the government or
its computers will not care about
how much porn you surf for —
unless it’s underage nonsense, in
which case you deserve life impris-
onment or worse. A government
computer will not care about your
affair with your secretary, or what
you were up to on your last holiday
either. Besides, with a billion peo-
ple online world-wide, which gov-
ernment is really going to have
time for irrelevant rubbish?

You’ve probably heard the
phrase, “The internet’s biggest flaw
is also its biggest draw”. This refers
to the lack of a governing body for
the net, and the freedom and
anonymity it offers. Like little chil-
dren in a fancy dress competition,
we don different costumes online,
and always wear a mask. However,
terrorists, paedophiles, stalkers and
other sick people do exactly the
same thing. Isn’t it time we started
to realise that without some form of
governance, chaos rules? 

How is it a good thing that just
anybody can Google “How to make a
bomb” or “homemade bomb” and
get over 4.4 crore and 4.5 lakh
results, respectively? How can we
shout about privacy and freedom,
when some innocent eight-year old
is being made to act out sick fetishes
on film, by some of the same people
who stand next to you in this self-
righteous picket line?

YouTube videos that spread
hatred, terrorists who use sat-phones,
BlackBerry services, and Google
Earth, paedophiles that lurk in chat
rooms waiting to prey on your kids,
and vengeful, lovelorn idiots making
indecent profiles of their exes on net-
working sites; how much more idiocy
do we really need to see before we
welcome a change that will stop
allowing the law to throw up its
hands in helplessness whenever tech
is involved in a crime? In this day and
age, we need more preventive than
reactive measures. I don’t think my
desire for “online privacy” is stronger
than my desire to never again bear
witness to a sorrowful candlelight
vigil at the Gateway of India.

Editorial

Robert Sovereign-Smith, Editor

Let Big Brother watch

“I’d rather some
government computer

network pick out a billion
innocent messages that we

send, than let even a
single mail from a terrorist

go unnoticed.”

editor@thinkdigit.com
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communicate with users of AOL,
MSN, Yahoo and ICQ instant
messengers from a single program.
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n .net Framework 3.5
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n Avast Home Edition 4.8
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3.5.55810.432
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n Free Download Manager 2.5 build

758
n Irfan View 4.20
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n VLC Player 0.9.4
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UPDATES AND ADD-ONS
n Adobe Shockwave
n Avast Update
n AVG Update
n Java runtime update
n Kaspersky definition Update
n Norton Internet security update
n Spybot updates
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OFFICE
authorPOINT Lite for
PowerPoint 2.0

authorPOINT Lite converts and
uploads presentations to
authorSTREAM and WiZiQ, the only
services that retain PowerPoint
effects on the web like PowerPoint
animations, rehearsed timings, sounds
and gifs.
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XAMPP 1.6.8
XAMPP is a very easy to install Apache
Distribution for Linux, Solaris, Windows
and Mac OS X. The package includes the
Apache web server, MySQL, PHP, Perl, a
FTP server and phpMyAdmin.
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1.2
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Converter 1.1
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n CASE Studio 2 2.22
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n Database Design Studio Lite 2.21.0
n DBExplorer 2.2.2
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n RazorSQL 4.2.9
n SQL Weaver 2.50 for ODBC With XML

2.500h
n SQLStomper 1.0
n Survey Power 6.10

CAD
TigerCad 3.001
TigerCad is a simple technical drawing
software (CAD). Ideal for garden design,
mechanical engineering drawings, elec-

trical / electronic, building and room
plans, and general diagramming.
Output in PDF format for the Web. Copy
and paste graphics. Create standard
symbols to re-use. Scale, mirror and
rotate. 

n AutoCAD Drawing Viewer 2.1.9
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GAMES
World of Goo

World of Goo is a physics-based
puzzle / construction game. The
millions of Goo Balls who live in the
beautiful World of Goo don’t know
that they are in a game, or that they
are extremely delicious.

n Arc Aether Anomalies 
n War Rock 040808
n Harvest Massive Encounter 
n Lost Planet: Extreme Condition

MODS
n Far Cry K-9 Vision v1.1 Mod
n Naruto Little Fighter
n True Combat: Elite
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n Mirror’s Edge
n Ninja Blade
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n Star Ocean: The Last Hope

Entertainment
HD TRAILERS
Star Trek

From director J.J. Abrams (“Mission:
Impossible III,” “Lost” and “Alias”)
and screenwriters Roberto Orci and
Alex Kurtzman (“TRANSFORMERS”,
“MI: III”) comes a new vision of the
greatest space adventure of all time—

“Star Trek,” featuring a young, new
crew venturing boldly where no one
has gone before.
n 2012
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n The International
n The Reader
n Yonkers Joe

MOVIES
n Elephant's Dream
n Man in Man
n O Grande Ditador (The Great

Dictator)
n The Terror
n Voyage to the Prehistoric Planet

FAST TRACK
n Fast Track
n PHP Source Files
n Fast Track Video

PHP TOOLS
n PHP Designer

2007 - Personal
5.0.2

n EasyPHP 2.0
beta 1

n PHP Generator
for MySQL 7.10

n PHPTriad 2.2
n Source Edit 4.0

revision 3
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n Firebird PHP
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n DontKillTime for
PHP 1

n Easy PHP
Highlighter 2

n DSV PHP 
Editor 2.3

n MS SQL PHP
Generator 7.4

n Oracle PHP
Generator 7.4

n PostgreSQL PHP
Generator 7.10

n CodeLobster
PHP Edition 1.4.1

n SQLite PHP
Generator 8.1

n StarPhP 2.0.0.5
n Smilehouse

Workspace Small
Business 1.10

Suites
ADOBE
n Adobe Flash Pro CS4
n Adobe AfterEffects CS4
n Adobe Illustrator CS4
n Adobe Indesign CS4
n Adobe Lightroom CS4
n Adobe Photoshop CS4
n Adobe Premiere Pro CS4
n Adobe Acrobat Pro CS4

ASHAMPOO
n Ashampoo ClipFinder
n Ashampoo Core Tuner
n Ashampoo Burning Studio 2009
n Ashampoo Internet Accelerator 2
n Ashampoo Photo Commander 6
n Ashampoo Photo Optimizer 2
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The first thing anyone notices
in the P3400i are its looks. I was
surprised that it looks pretty
good when you have it in front
of you. The touchscreen is
responsive in most cases but
the stylus is not comfortable
enough for my taste. I am
currently using an empty pen
with a big tip and this is much
better for navigation as well as
writing on-screen.

The user interface is a bit
erratic. It isn’t slow at all times
but sometimes it slows down
erratically. Once I learned it;
the erratic-ness has gone. Still
the overall speed is not
anything to talk home about. It
is always somewhat slow.

Memory usage is high with no
programs running. Very little
free memory is left at startup
(just 33 per cent)

Camera is just okay for
posting photos to blogs and for
for emergency uses. Despite the
2MP sensor, quality is not
much better than my age-old
Nokia 6600’s VGA camera.

Music quality through the
single speaker on the phone is
fair for soft numbers, it just
isn’t the thing for heavy metal
stuff. The treble is more
emphasised through the
external speaker, as is the case
with many mobiles. Music
quality through the provided
headphones is pretty good for a

PDA but the mids are over-
emphasised. I used Metallica’s
Nothing Else Matters as the test
track. I hate the propietary
jack. A 2.5-mm jack would have
been tolerated. You can buy
extensions which plug into the
phones jack and give you with
3.5mm jack. 

The phone allows creating,
viewing and editing Word and
Excel files. Viewing PowerPoint
files is supported but is
sluggish. The Adobe PDF Reader
also makes an appearance. For
all practical purposes, it isn’t
very usable because of the slow
processor. The games that come
along are pretty nice, but one
can install more games as it

supports Java as well as
Windows Mobile applications. 

I definitely am in love with
this device. It may be because of
my first experience with
Windows Mobile. I have used
Symbian 7.1 and Symbian 9.0 on
some of my earlier
smartphones. There are
differences but I have adapted
to them in a short duration of
one day. 

The only major advantage
the HTC Touch has over this is
the WiFi but that isn’t so
important yet as there is a lack
of WiFi hotpots to use this
feature. In short, if you are
thinking about buying this
one, don’t hesitate.

IronMan

Forever

Join Date: Jun
2008
Location: Metal
City
Posts: 721

Just bought HTC P3400i...

A quick and easy registration
process that gives you access
to all the goodness on offer

Download only the
best software on
the Net

Read the best tech blogs
and submit and share
your own blog with
others

Find the best
product reviews
online, from the
Digit Test Centre

Interesting and
exciting videos
from across the
globe

Buy and sell tech products to
people from all over India at
our Digital Marketplace

India’s largest and
most influential
tech community can
be found on our
forum

Buy older issues
of your
favourite
technology
magazine online

Experts at the Tech
Q&A section
answers all those
niggling problems

Y O U R  T E C H N O L O G Y  N A V I G A T O R
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ground-level, 360-degree
views of streets in 12
Japanese cities and is also
offered for some 50 cities in
the United States and
certain areas in Europe.

As for the Android, we’ll
wait and watch. At the time
of going to print, Kogan
Agora Pro, the second
Android phone was
launched in Austrialia for
$399 AU (Rs. 13,000). Unlike
T-Mobile’s G1, this phone
comes unlocked for use on
any carrier.

WHAT WILL APPLE DO?

No more
Jobs

Mid December news
wires are abuzz
with the hullabaloo

of Steve Jobs quitting
Macworld and Apple opting
out of the event altogether,
after the January
installment. Mac fanboys
cried themselves to sleep
speculating whether Job’s
health is behind the move,
but the more plausible
reason is that, like many
companies, Apple is getting
tired of trade shows. For
many companies, the
expense and complexity of
exhibiting at huge shows,

then having to compete
with hundreds or
thousands of other
companies for press and
industry attention, are
making the shows less and
less compelling. Goes to
show that the trade show
biz isn’t exactly a growth
industry these days and,
with tough economic times
ahead, luxuries like your
precious keynote are the
first to go. Apple now
probably plans to go in for
its own exclusive product
launches. Although Mac
and Apple are synonymous,
it is worth mentioning here
that the Macworld Expo is
run by IDG World Expo.
Knowing Apple’s penchant
for control, chances are that
Macworld Expo didn’t offer
Apple enough control.

Also interesting is what
these expos do to the share
price of Apple Inc. A
prelude to all of Apple’s
media events is crazy rumor
mongering and speculation.
The result is that almost
every Apple extravaganza
since Macworld 2007, no
matter what news comes
out of it, has triggered a
massive sell-off of Apple
stock. Initial reports suggest
that Apple stock may have
dropped nearly 7 per cent
on the news that Steve Jobs

is quitting Macworld. 
For Mac enthusiasts

what Steve Jobs’ departure
means is that there will be
no more jazzy stunts in the
Keynote, which Jobs was
famous for. During the
launch of the iPhone he
pulled out the phone from
his jeans pocket and called
the local Starbucks Café for
4000 Lattes to go. But
realistically speaking, Mac-
lovers can probably rest
assured Apple’s not going to
come apart cheap the
minute Jobs leaves.

NO MORE RECORDS

Data
Retention

Post 26/11, security
measures and privacy
issues are much talked

about. So the news that
search companies are
cutting down on search-
data retention time, is of
much relevance. 

Search companies keep
the IP addresses of their
users for a period before
making them anonymous.
Until they anonymise the

Security Watch

Critical security
flaw in IE (again)

The problem
Microsoft recently issued a
critical security warning
regarding a malicious code
that is making the rounds
and attacking vulnerabi-
lities in Internet Explorer 7.
The infection had the
potential for wide-spread
damage since IE 7 is the
latest non-beta version of
Microsoft's browser and is
bundled with XP service
pack 3 and also Vista. The
code,  infects a users'
system with a Trojan horse.
It may even start down-
loading other malicious
elements into the users
system. Microsoft says that
the code can creep in even
through legitimate websites
in which the script has been
inserted to run in the
background. Earlier
versions of IE are also
vulnerable. It is being said
that Microsoft Corp.'s
developers missed the bug
because they didn't have
the right testing tools.
Microsoft's testing tools —
including “fuzzers,” which
are automated tools that
drop data into applications,
file formats or operating
system components to see
if and where they fail — also
missed the bug.

The solution
Microsoft has released an
emergency update patch
MS08-078 which addresses
the vulnerability. The patch
fixes a flaw in the data-
binding function of all
available versions of the
popular browser. Users who
have automatic updates
turned on will receive the
patch automatically while
others can access it via a
download from Microsoft’s
web site.

n Snowboarder Shaun  White and swimmer Michael Phelps to feature in video games  n Lawyers use Facebook to serve legal papers

BBC allows
YouTube to
carry content
Small sections of programs
and promotional segments
of BBC videos have been
allowed to stay on YouTube
in exchange for a share of
the advertising revenues of
the video sharing web site. 

Viacom
removes
content from YouTube
Viacom and subsidaries MTV,
Nickelodeon and Comedy
Central have pulled more than
100,000 clips from YouTube.
The lawyers are unsure of the
website is actually giving a
boost to the content owned by
Viacom or dealing it a blow.
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No there’s no
grammatical error
there. Well, although

there is, it’s intentional.
Think about it. Since the
time Google announced its
open source android
operating system for
mobiles, people have
wondered — why is
Google launching a
product that has no
apparent revenue
model? The question
has come to the
forefront once again
with the launch of T
mobile’s HTC G1. The
phone is pretty nifty
and we especially
like the flip-slider
opening keyboard.
Android works fairly
smooth too. But
coming back to what
Google is upto —
perhaps its recent
announcement that
the iPhone and T-
Mobile G1 can now
show Google search
ads sheds a little light on
the question. Is Google then
going the Microsoft way?
Monopoly being the name
of the game. For instance,
reports suggest T-Mobile’s
G1 works fine with many
online services, but it works
especially well with
Google’s. It delivers a lot of
the basic core functions and
of course, tight integration
with Google’s products,
including Gmail, Google
Maps, and Google Calendar.

Having said that, there is
also a lack of basic features
like video recording. Is it a
miss out, or more like an
opportunity for
independent app
developers? Google has

come up with a mobile
application store of its own,
called Android Market ala
iPhone. Besides, some of
Google’s latest antics
include asking broadband
carriers to create a special
fastlane exclusively for its
content. This would be done
by placing Google servers in
the ISP’s technical facilities.
Another somewhat
alarming warning sign is
the removal of Firefox as
the default browser in the

Google code pack. In a
recent US survey of the top
20 most trusted companies,
Google has fallen off the list
entirely from its spot at 10
on last year’s list. Google’s
fall is probably due to the

big company syndrome,
where people just
start trusting big
companies less.
Perhaps Google
should treat these
signs as early
warnings. Besides
this, there is a lot of
fuss being kicked up
about Google Maps
post the Mumbai
terror attacks. An
Indian lawyer filed a
petition in the
Mumbai High Court,
arguing that Google
Earth and similar
services “aid
terrorists in plotting
attacks”. The
petition is
demanding a
removal of Google

Earth satellite images of
India, or at the very least,
blur images of sensitive
places in the country, such
as Indian nuclear plants
and defence establishments.
And it’s not just Indians. A
group of Japanese lawyers
and professors have also
asked Google to stop
providing detailed street-
level images of Japanese
cities. Google provides this
through its Street View
service, which offers

Enter
WHY IS ANDROID? 

Who is Google?

n China blocks access to New York Times  n Dell to launch ultra thin laptop to compete with Macbook Air 

Eugene V. Kaspersky
CEO, Head of Antivirus Research,
Kaspersky Lab

One of the world’s leading
experts in antivirus protection  

What were you thinking of
doing after your degree, how
did you think your career
would go, had you thought of
going into this kind of work or
were you planning on doing
something else?
I have done my degree in
Cryptology. I think I was
planning on doing something
else, I didn't enjoy myself, it
was just antivirus systems, it
was just my hobby. I got into it
by accident. My computer was
infected back in 1989 with a
cascade virus, back when there
was such a virus. That’s why I’m
here.

How do you tackle human
gullibility, which is one of the
greatest vulnerabilities out
there when it comes to internet
security? 
There are three things you could
do against cyber terrorism, cyber
criminals and against all threats
— education, law enforcement
and protection. We have a special
education system for kids and
students about this. We do it and
we do it for free, because we take
it as part of our mission to spread
the news. We have presentations
given by about 80 experts and
this method works. 

Isn’t it difficult to make
people sit up and listen and
take notice for such a thing to
work?

The problem is that they don’t
pay enough attention in social
networks. They think they trust
everyone in a community, and
give out data, some personal
information, which is enough for
to see some serious
repercussions. It is one of the
greatest threats, probably one of
the most serious because there
are millions of people who are in
this network.

Search may become passé
Contextual browsing may become the new avatar of
search. With browsers and web sites becoming
increasingly aware of what you are looking at, all your
web content needs will be custom delivered to you in
the future.

Another one for the Eee PC
Eee PC the ultra-light, ultra-portable and ultra-cheap
Netbook from Asus just bagged itself another award. It’s
now crowned Forbes Asia’s Product of the Year for 2008.
The product was chosen for its Innovation and Market
Disruption.
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identities of its users, the
information is used
alongside other data, such
as search queries, to improve
relevance of search results
and target advertising to the
user, among other reasons.
The most recent
announcement came from
Yahoo!, saying it would cut
down data retention to three
months in most cases, from
the prior norm of 13
months. “This was our
attempt to put a stake in the
ground” Anne Toth, Vice
President of Policy and
Privacy Chief at Yahoo said
on the issue, thus making
its retention policy the
shortest among peers. It is
reserving the right to keep
data for up to six months if
fraud or system security are
involved. Earlier this year,
industry leader Google Inc
halved the amount of time it
stores personal data to nine
months, while earlier in
December Microsoft Corp
had said it will cut the time
to six months if its rivals did
the same. The spate of

reduction in retention times
is a response to pressure
from the European
Commission’s data
protection advisory group,
the Article 29 Working Party,
and other data protection
officials to do more to
protect the privacy of users.
The commission is also
pushing for the sector to
adopt an industry-wide
standard. Currently, there is
disparity in the method
companies are adopting in
the process of
anonymisation. Microsoft
said it welcomed the move,
but made a distinction
between the timeframe and
the method of making data
anonymous. Yahoo! will
delete the final segment of
the IP address, which it said
makes it no longer unique
or identifiable. Microsoft is
deleting all of the Internet
address, which it said will
break any potential link to a
particular set of search
queries. With its nine-month
anonymisation, Google
intends to change some of

the bits in the user IPs
stored on its servers. But
that’s it. The plan would
leave cookie data alone.

Let’s leave search
companies and privacy
issues alone for a minute
and look at what risk Data
retention could pose to
National Security. Even
Internet service providers
can retain certain data.
Back in 2006, this very issue
was being debated in the
US. A major concern was
that the ISPs retaining data
would also retain traffic
information of federal, state
and local governments.
Classified federal systems,
which generally don’t use
the Internet, may be the
exception. What problems
could arise if commercial
ISPs hold detailed records of
all the communications to
and from government
agencies? Data retention
may increase the risk of the
exposure of undercover
police or confidential
informants. And this is just
one example.

WHO WILL WIN?

Chrome v/s
IE 8

Google recently went
away from its
perpetual beta

convention by finally
bringing Chrome out into
the real world. Google’s
notorious beta label on
their products is a great
umbrella cover for them to
receive forgiveness when
things go awry.
Unfortunately, the same
practice can be a major
problem when looking to
gain serious market share.
OEMs won’t touch you with
a 10-foot pole if your
product is still in beta. And
once OEMs preinstall any
product, its market share is
exponentially upped.
Consider IE 8 — it is
currently not bundled with
any version of Windows.
The only way to get it is by
download, so market share
is sure to drastically change

A Round-up Of Technology News From Across The GlobeThe Digital World

US 
Apple TV sued
for patent
infringement by
EZ4Media

EGYPT
The first Nuclear
power plant in
Egypt contracted
to Bechtel, a US
company

AUSTRALIA
Authorities to
curtail P2P and
torrent access
across Australia

JAPAN
Panasonic and Sanyo
announce a capital
and business
partership

INDIA
Lok Sabha passes
bill to improve the
Information
Technology Act

n Ecofont, a TrueType font designed to save ink and toner launched n Warner Music pulls down its content from YouTube 

CHINA
Lenovo’s oPhone handsets
to have OS developed by
China Mobile
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once Windows 7 is ready for
consumers. A quick look at
some numbers online
reveals that in this sort of
level playing field, Chrome
is doing better than IE 8 in
terms of market share.
(Though to be fair we must
consider that IE8 is still in
beta.) The battle which will
now ensue to become the
next browser of choice will
definitely be interesting. 

Coming to the question
of whether Chrome will be
adopted by the masses, it all
depends on user preference.
Users tend to get pretty
attached to the little niche
utilities that each browser
has. The noticeable lack of
add-on support in Chrome
is one of the many items
people who haven’t made
the switch typically cited.
But regardless of how ready
the browser is in the non-
beta avatar, this latest move
puts them in a good
position to take advantage
of OEMs. Having Chrome
pre-installed on machines
will quickly boost its 
usage stats.

INDIA GETS 3G

3Gs are bet-
ter than one

MTNL recently
announced the
launch of 3G

services in Delhi.
Interestingly enough, it was
inaugurated by Prime
Minister Manmohan Singh
by receiving a video call
from Telecom Minister A
Raja. We would’ve expected
one of the private players to
be the first one off the
block, but what is important
is the reaction the
announcement has evoked.
Message boards were actively
speculating what kind of
plans would be available,
whether there would be a

n Cisco Claims About 90 per cent of All Email is Spam  n Electronics Arts will sell Spore DRM Free 

data limit, and if so, would
it be ridiculously low
thereby defeating the whole
point of 3G. For the
uninitiated, 3G will allow
operators to offer high-end
services such as faster
downloads of video clips,
movie trailers and music
files, video calls, interactive
gaming and even streaming
video. The existing telecom
services in India operate on
the 2G spectrum. The
process for the auction of
3G licences in India kicks
off in January 2009. But
before we get on to the
nitty-gritties, two issues
must be addressed. First, of
the 300 million mobile
users in India, how many
have 3G phones? These
high-end phones cost more
than Rs. 11,000 at the least.
And out of all the things 3G
enables you to do, how
much of it will you really
use? Perhaps the average
Indian mobile user may
want to watch a T20 match
on the go rather than video
call someone. In any case,
3G users will still be a small
minority, at least initially.
The second issue is shortage
of spectrum availability in
many circles at peak times.
Service, is after all, as good
as the calls it allows you to
make, so we don’t want any
lagging issues there.
Coming back to the licence
auctioning, under existing
guidelines, the successful
3G auction bidders will have
to pay Rs 1,651 crore for a
UASL licence that entitles
them to offer all
communication services.
The 3G hype also brings up
the longstanding battle
between 3G and WiMax
technologies. WiMax stands
for Worldwide
Interoperability for
Microwave Access. It can
also be used to provide voice
services and rivals 3G as
both the platforms are used

for similar applications.
According to the
Department of Telecom
(DoT), the 2.1-GHz band will
be used for 3G, while 2.3
GHz and 2.5 GHz have been
earmarked for WiMax.
Ericsson — the biggest
supporter and equipment
vendor of 3G — is laying
claims on the 2.3 GHz
spectrum band, which is
meant for WiMax.

BAD BOYS - WHAT’CHA
GONNA DO?

War on
Piracy v2.0

It seems the bigwigs at
RIAA are ready to try
out just about anything

to stem the piracy biz. First
they began by suing people
who downloaded music.
That meant suing just
about every person on
planet earth right? They
managed to sue 30,000
accused file sharers in the
last five years. Clearly it
wasn’t working, so the
music industry said “hey
wait a minute, since so
many people are
downloading, viewing and

listening to copywrited
content, why not try to
squeeze some ads in
there.” Accordingly, all
such content on Myspace
and YouTube wasn’t
necessarily pulled down.
Instead, the original
owners could just choose
to put ads on it. Now in its
latest installment against
piracy, the Recording
Industry Association of
America (RIAA) has
announced that it will
work with internet service
providers to sever abusers’
net connections. Just to
clarify, abuser here means
you. Yes, you with the 20
GB MP3 collection! Under
the new plan, RIAA will
send notices to ISPs that
identify the IP addresses of
suspected file sharers. ISPs
will then send warnings to
their customers and then
cut them off if the users
fail to curb their illegal
downloads. Details are still
being worked out, but
most reports said
downloaders might lose
their net connection after
the third notice. The
termination could last
anywhere from three
months to a year. But it
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seems identifying culprits
isn’t so easy. There is the
Catch-22 of fair use and
besides, many of the law
suits by the RIAA resulted
in grandmoms being
dragged into court, based
on sometimes specious
evidence. To many, internet
connections are essential
lifelines to school, work,
and other important parts
of daily life that we will
not mention. Considering
these, many of RIAA’s
detractors will certainly
put up a fight. Oh! by the
way, the Motion Picture
Association of America is
also in discussion with
ISPs to adopt the same
strategy. 

In a world gripped by the
fears of a disasterous

fallout of a degenarating bio-system, Green-washing
refers to the undue exploitation of
enviornmentalistm by companies. For example, if a
particular product does not perform as well as its

competitors, the product is simply positioned as
being eco-friendly and put on the market. Vague,
untrue and irrelevent product features are
highlighted as being good for the enviornment. This
practice is known as green-washing, which is a
combination of green and white-washing. 

Only 33% of
households actively

protect their children
from the internet

63% of parents using
SMS services feel this

improves
communication with

their children

50% of all returned
IT products work, but

can’t be figured out by
buyers

Green-washing

70% of all porn
access on the net

occurs during
office hours

70% of all
security breaches

are caused by
insiders

In the year
2008, $865
Billion was
invested in IT
products and

services

n India won't levy admin tax on 3G spectrum  n Windows 7 scheduled for late 2009 launch  n EA titles to be available online through Steam

SHARK INFESTED WATERS?

Undersea
cables cut
again

No it’s not the poor lil
sharks. At the outset
of 2008, a badly

dropped ship anchor had
damaged an undersea
Internet provisioning
telecom cable in the
Mediterranean, disrupting
Internet service throughout
India, Sri Lanka, Pakistan,
and the Middle East. And
this year its deja-vu all over
again. The lines, which
emanate from the Egyptian

coast at Alexandria and go
on to connect to Asia, were
probably damaged either
by a ship’s anchor or a
minor earthquake, officials
say. So if your online
gaming experience has not
been up to the mark,
lagging away to world’s
end, then this is probably
why. Initial reports suggest
as much as 70 per cent of
internet and telephone
traffic between the
continents has been
affected by the outage
affecting millions across
the Middle East and south
Asia. International
telephone calls, which have
also been affected, were
being re-routed to work
around the problem. A
somewhat corny outcome
of the outage is that
people have been getting
less spam! Inboxes which
were being bombarded
with hundreds of spam
mail a day now get only
a few.

Despite widespread
wireless internet and
satellite connections, and
contrary to popular belief,
global communications
still rely largely on the vast

webs of fibre optic cables
that cover the planet. The
lines take years of planning
to install. To repair them is
even more of a challenge.
As part of damage control
for this recent incident, a
64-crew French
maintenance boat arrived
on site, off the coast of
Sicily, following a two-day
journey from southern
France. An underwater
robot was sent down to
locate the cables, which
may have been dragged
several kilometers off site
in the incident — and lift
them to the surface where
they will be repaired fibre
by fibre. 

Some trivia:
1. The crack about sharks at
the beginning wasn’t entire-
ly unfounded. It seems that
the very first small diameter
fibre optic cables laid were
indeed damaged by sharks
chewing on them on the
ocean floor. Scientists found
that sharks were attracted
by the magnetic fields
formed around the cable,
produced by the electrical
current supplying power to
the amplifiers which are
placed periodically. To
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reduce these problems, the
cables are buried in the
floor of the ocean using spe-
cial under sea ploughs.
However, in rocky bottoms
and over undersea cliffs, the
cables are still exposed.
2. Cables with 10 Gbps
bandwidth were laid at a
cost of $27,000 per km in
1999. Do the math.

DOWN WITH OPEN SOURCE

Microsoft
Launches
BizSpark

They say all big things
begin with an idea.
And when it comes to

successful technology
ventures, some of the
biggest have their roots in
India. Microsoft is now
eyeing this very potential

market with the launch of
BizSpark. The program
targets early stage software
startups, with resources
including access to
Microsoft platform software
and development tools with
no upfront costs. As you’ve
probably figured the
program is a bid to keep the
open source mafia at bay. It
is no secret that startups are
very cost-conscious. Given
the relative lack of cost-
effective software solutions,
they often tend to veer
towards open source.
Microsoft understands the
price-attraction of open
source, and hence, it is

basically undercutting that
advantage. Besides this, the
program will also provide
access to technical support
and marketing visibility
from Microsoft, as well as
support through a select
group of network partners
— industry associations,
government agencies,
university incubators and
investors — chartered with
advancing
entrepreneurialism. In
India, these partnerships
include The Indus
Entrepreneurs (TiE), NEN,
Proto, NASSCOM and IDG
Ventures, a venture capital
firm. Other VC firms
supporting the initiative
include Draper Fisher
Jurvetson (DFJ), Helion
Venture Partners and Accel
Partners. Virtually
everything a startup needs
to build a web service (many
of the tools and software

compete with open source
alternatives, such as MySQL)
is being offered to startups
for free for three years. The
idea, they say, is to create a
vibrant startup ecosystem 
in India.

STILL KICKING

New lease of
life for
Windows XP

Big technology corps
often phase out their
older products to

make way for newer ones.

Universal Memory
What is Universal Memory?
Universal Memory approaches
memory storage in a radicaly
different way. Universal
Memory is the term given to
the next wave of storage
solutions that are about to hit
the world. 

Why do you need Universal
Memory?
The next generation of memory
devices plan to replace the
current generation by
outperforming current storage
solutions in two basic aspects
of memory storage. The first
aspect is power consumption,
and the second aspect is the
density of memory. This
generation of low-power, high
density memories will probably
be able to store memory even
without electricity running
through them. 

Which companies are
involved?
The list is pretty long. IBM, HP,
Motorola are all researching
different universal memory
strategies. Samsung and
Toshiba are also in the race.
Companies that specialise only
in memory solutions like
Everspin and Hynix are
obviously involved. A company
called Nantero has developed
promising wafers with 10
billion bits of memory. 

How will it be done?
Current research have different
approaches in different labs.
One approach is to use the
nanoscale structures on the
silicon wafers themselves.
Other approaches include
molecular memory and
magnetic random access
memory.

When will we see it?
Predictions vary from 2011 to
2020. 

Will it be any good?
Portable devices stand to
benefit the most. The memory
promises to store all the data
in any DVD ever made in a
single laptop sized box.

They first begin by pulling
the plug on sales and then
eventually stop support.
January 31, 2009 was listed
as the last day that anyone
could buy XP, but Microsoft
has told its system builder
partners that they will be
allowed to continue to sell
XP after cut-off date. In
what is being called the
flexible inventory
programme, distributors
can place their last orders
for Windows XP OEM
licenses by January 31, 2009,
and take delivery against
those orders upto May 30.
Until then, distributors
would have to buy as many
XP licenses as they could
afford before the cut off
date and sell them after the
deadline. Apparently
distributors are quite happy
with the new arrangement
as they don’t have to hand
over cash for the new
licences until they have
already sold them. 

Software companies are
still softies when it comes
to phasing out older
products. Take the case of
processor manufacturers —
Intel does not manufacture
its Pentium II and III lines
anymore. Even if you were
to say “hey I use my comp
only as a word processor, I
don’t need quad core speed.
Can I get a Pentium II for
cheap?” Well no you can’t.
Not from the manufacturer
at least. 

About discontinuing
support Microsoft says this
on its web site, “Microsoft is
retiring support for these
products because they are
outdated and can expose
customers to security risks.
We recommend that
customers who are still
running Windows 98 or
Windows Me upgrade to a
newer, more secure Microsoft
operating system, such as
Windows XP, as soon as
possible.” n

n Martian bedrock analysis shows that life was once possible on the red planet  n Rumors emerge of G2 following up on G1
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There is no such thing as a completely
secure computer, or IT network. The
number of threats we face from

pranksters, all the way to organised crime is
growing all the time. In fact, the threats
themselves are increasing in both seriousness
and sophistication. 

It’s not just a matter of viruses, trojans or
worms that might come attached to an email
and then infect your machine. If you are on

the internet, then you are open to
attacks of many different kinds,
from hackers trying to gain direct
access to your computer, malicious

web sites tricking you into parting
with money, tricks to get personal

details such as credit card information
or passwords, software slipped onto your

PC that will do any number of things without
detection — the list is always growing. As
computers, software and the internet become
more feature-rich and complex, the number
of ways in which attacks can occur also
inevitably increases. Everybody needs to be
vigilant, particularly where online transac-
tions involving banking or online shopping
are concerned.

The original web pages that people surfed
early in the 90s consisted only of text format-
ted with HTML together with images, tables
and the like. Not much risk was involved. But
things are now much more complex. You have
embedded videos, JavaScript menus, PHP code
and many more rich and interactive features.
With this level of complexity also come
programming errors and loopholes. At the
best, these problems cause difficulties with
the straightforward operation of a site. At the
worst, they enable an attacker to take over a
site, grab personal information or infiltrate
hidden software onto your PC.

The language used in security circles
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describes computer systems as having some
kind of vulnerability that is then exploited by
an attacker. However, the most important
vulnerability is human gullibility and lack of
understanding. Conversely, the most impor-
tant form of defence is a reasonable under-
standing of security issues combined with
care and vigilance.

If you received an email from some
unknown source, telling you to click on a link
to “See Britney Spears naked”, would you click
on that link? Most people nowadays know the
danger involved and that clicking on such a
link is likely to lead to computer infection of
some kind. Unfortunately, there are still some
who do not.

But what if the email at least appeared to
be from a known source, and one that you
knew had your email address. What if it
appeared to be from your own bank, and
included all the right graphics, logos and
everything? You may be much more
likely to click on the link in order to
reset your PIN or password, as
suggested. What if the link led you to a
web page, apparently with the correct
URL, that looked exactly like your
bank’s correct page, complete with
Verisign security certificate logo (the
little lock in the bottom right of the
window frame). Would you then enter
your existing user name and password,
thereby allowing the attacker to empty
your bank account, or purchase goods
online and send them to Africa?

Such attacks are more rare than
offers of naked Britneys, but the
attackers are getting this sophisti-
cated, and making increasing efforts
to make money from such attacks.
They continue to do so only because previous
and less sophisticated attacks have proved
successful. People have clicked on the links,
entered personal information, and lost
money as a result.

In the following pages, we will describe
the most likely types of security problems
that you will encounter and give you some
advice on how to behave on the internet —
what to do and what not to do. Software can
also of course help considerably, as long as
you do not allow yourself to become compla-
cent — you may have the best known anti-
virus and anti-spyware software installed, but
you still need to take care. 

Dangers on the internet
The method of attack we described earlier, of
an email purporting to come from your bank
and asking for personal information, is
known as phishing. Basically, phishing is a

form of con-trick, and any such trick stands a
better chance of working the more believable
it is. The simplistic attacks seem to be falling
in number, presumably because people are
increasingly aware of the problem, and so
attackers are becoming more sophisticated.

Perhaps the most common form of attack
used in phishing is known as cross-site script-
ing (XSS). In this method an attacker will
insert code in the embedded link — not the
link that you will necessarily see — that will
attempt to manipulate a web application,
usually so that some code is inserted into the
page that will be displayed in your browser.
This doesn’t change anything on the server,
but your browser will receive an amended
form of the page, and will execute the mali-
cious code as if it had come from that server.
What you see will be the correct page of, say,
your bank, but it will behave and perhaps
appear differently — usually it will send you

to another page that will have been crafted by
the attacker.

In an extended form of this attack, known
as persistent XSS, the manipulated URL is
stored on a server in some form or another —
in a database, forum content, and so forth —
and is then accessed by unsuspecting users. In
this case, you do not have to click on a manip-
ulated URL in a phishing email, but it exists
in some other source that you might stumble
upon innocently.

Another variant on this kind of attack is
known as frame-spoofing, which can also be
triggered by a manipulated URL in an email.
Frames have long been considered to be inse-
cure by security experts, and their use is
slowly fading away, but there are still a great
number out there. In frame spoofing — first
recognised by Microsoft back in the days of
Windows 3.1 — an attacker is able to insert
their own window as a frame within the

This partial screenshot is
of a genuine email from a
UK utility company
presenting a link allowing
the user to pay a bill. The
link is of a known and
correct URL, and the
actual link that would be
followed — which is
displayed in the window
frame at bottom left —
matches correctly the link
in the text. Even though
this is clearly correct, it it
better practice never to
use such a link, but use
your bookmarked link to
your utility company in
order to pay such a bill.
Even a small difference in
the actual link might take
you to a spoofed site
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window of a legitimate website. This means
that, again, the page you are viewing is the
correct one, with the correct URL and with
the security icon visible, if relevant. But, part
of it has been replaced with malicious
purpose. This can be very difficult to spot.

In these types of attack, the malicious
code is inserted in such a way that it runs in
your browser — the server of the bank or other
service has not been compromised. However,
there is a form of attack known as remote
code execution in which the web application
is itself tricked into executing the attacker’s
code. Very often, this results from weaknesses
in PHP, one of the most common scripting
languages used for creating web sites. Again,
the relevant scripts can be triggered from
within manipulated URLs. Many program-
mers have simply assumed that their program
will always receive valid input data at all
times, and do insufficient validation of such

data: URLs, form data, and so on.
Many, if not all, of the websites with

which we are likely to have online transac-
tions are backed by large SQL databases.
Again, problems occur when data that a user
might input is not filtered and checked prop-
erly by the web site. If this data has been
manipulated in some way, a skilled attacker
can make use of special SQL characters (typi-
cally, the comment and end-of-command
characters) and infiltrate his own commands
in order to execute an attack. With this kind
of attack, it is the web service that is the
target, rather than the user directly. However,
there have been instances where attackers
have been able to compromise an SQL data-
base and access customers’ credit card and
transaction details.

Another component in online transac-
tions that is supposed to safeguard such
details, and that has attracted attention in

the last year, is security certification. If you
are online to an e-commerce site and are
about to enter your credit card information,
the window you are working in should have a
little lock icon in the bottom right corner of
the frame. This is the security certificate, and
strictly speaking, you should click on the
icon, and check that the certificate is genuine
and was issued to the right organisation. This
is a pain, and there must be very few people
who actually bother to do this, or even know
that it might be a wise thing to do. Such
checks are being introduced into browsers,
but this has been very slow in coming.

You may think these security certificates
are rock solid and reliable, but earlier this year,
the commonly used OpenSSL package in
Debian — used to generate the keys for this kind
of encrypted communication — was found to
have contained a bug since 2006. This resulted
in the creation of weak keys. This makes the

keys more predictable and the commu-
nication therefore open to attack; the
communication over which your credit
card or other details might be passed.

Finally, although our list of security
vulnerabilities is going to be far from
comprehensive, we should mention
keyloggers, which are a particularly
pernicious form of infiltrated software.
You might pick up a keylogger in much
the same way as a virus, trojan or worm.
Once it is inside your system, it will do
nothing to give away its presence, but it
will sit there noting the keystrokes that
are made and sending these off across
the internet to the attacker. Of course, it
will be looking for the tell-tale signs of
credit card or banking information and
the relevant PINs and passwords. It is

because of attacks such as these that some
banks have started supplying virtual keyboards
when you enter your password. With these,
instead of using your physical keyboard to enter
the password you use the keyboard on screen,
pressing keys with the mouse. The keylogger is
blind to this activity — at least up until now!

It should be clear by now that the complex-
ity of modern computer systems carries with it
a vast number of possibilities for attackers to
infiltrate systems and gain access to confiden-
tial data. The increasing trend towards such
concepts as cloud computing and Web 2.0,
involving more private data being hosted on
the internet and ever more code and transac-
tions being passed across the internet, is only
likely to make the situation worse. In the
following pages we describe the steps you can
take to protect yourself in that dangerous
online world, and the software that can help
you on the way. n

This second partial screen-
shot is from a phishing
email, pretending to come
from PayPal. Notice that
the actual link that would
be followed — in the
window frame — is very
different from the one in
the email text. This would
for certain lead to a
spoofed site of some kind,
with a request to enter
personal data. Always
check the actual link when
following a link in an
email, and if it is for a site
involving financial trans-
actions, never click on
such a link 
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Pradeep Narayan

In the current age of the IT revolution, more
and more people are getting hooked into
the cyber world for their various needs.

There is a distinct reliance on computers and
the internet now for email, entertainment,
shopping (online shopping), airline and rail
tickets, banking, trading and the list goes on.
While it does make our lives simpler and
convenient, it also poses dangers to us in an
unprecedented way by exposing their identity
in the public domain. Details of our personal
information, such as name, addresses, pass-
words and bank accounts are in the process of
being attacked by various fraudsters, hackers,
terrorists and criminals freely roaming the
cyber world. 

It makes perfect sense for users to under-
stand the online security threat they are
exposed to while surfing the web. Just what are
those risks and threats that we are talking
about? Among dangers are hostile viruses, hack-
ers accessing your system and stealing vital
information like credit card details and
committing fraud, unsecured wireless
networks, spyware on your system, and 
identity theft.

As a user, how can you enhance your online
security? 

In the following section, we will discuss
the kind of risks that you are exposed to
and the ways in which you can tackle those
risks. There is no fool-proof system, but it
doesn’t hurt to be a little careful while on
the internet.

Guidelines

How to protect personal and work data
n Protect yourself with relevant software from
viruses and trojan horses that may steal or
modify data on your own computer. A trojan
horse program is software that claims to do
something genuine, but does exactly the oppo-
site. For example, a program that claims it will
speed up your computer may actually be send-
ing personal PC information to a hacker.

n Update your PC with the latest anti-virus soft-
ware and operating system patches. Make sure
these updates happen automatically.

n Install a personal firewall and anti-spy ware to
protect your PC.

n Periodically change your online passwords.

n Check your credit card and bank statements
regularly and report any irregularities to the
relevant authorities.

n Modify Internet Explorer or other browser
security settings to limit the amount of infor-
mation you are willing to accept from a web
site. Microsoft recommends to set the security
settings for the internet zone to medium or
higher.

The need to update your browser
When you use the internet, you view web sites
in a browser. A browser is a program that
accesses and displays files and other data avail-
able on the internet and other networks.
Browser programs are frequently updated to
add functionality and address problems. If you
are using an older version, there could be secu-
rity issues (someone could hack into your
computer).

How to do it?
Download the latest or updated browser you are
using from the company’s web site over the
internet. It might ask for information about
your computer such as what operating system it
uses — Vista or Windows XP. Then follow the
instructions on your screen.

n Save it to your computer, it will be saved as an
executable file. Once the download is
complete, go to the file where you saved it, and
double — click on it. This will automatically
install the new browser on your computer.

Be careful while doing online shopping
n Shop online only with known and reputable
merchants; enter their URLs yourself, and do
not click on links in emails; these may very well
contain hidden commands to trick you

n Do not respond to any emails asking for
personal information

n Check web sites’ privacy policy before provid-
ing any personal or financial information

Cyber crime 
The new age menace
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secure connection, the address displayed
should begin with https.

Spoofing attacks
n Spoofing attacks are as common as phishing
frauds. The spoofed site is usually designed to
look like the genuine site, using a similar look
and feel to the legitimate site. The best way to
verify whether you are at a spoofed site is to
verify the certificate.

n “Lock” icon – check for the lock icon in the
lower-right of the browser window. This tells
you that the web site uses encryption to protect
sensitive personal information — credit card
number,  ATM PINs, Social Security number,
etc. The lock only appears on sites that use an
SSL connection, which is typically used only on
sites where you enter sensitive information.
The secure site lock icon when closed means
that the site uses encryption. Double-click the
lock icon to display the security certificate for
the site. This certificate is proof of the identity
for the site. While checking the certificate, the
name following “Issued to:” should match the
site you are on. In the event of the names not
matching, you are on a spoofed site and 
should quit.

What is 128-bit SSL?
SSL stands for “Secure Sockets Layer”. It is a
protocol designed to enable applications to
transmit information back and forth securely.
SSL is accepted on the world wide web for
authenticated and encrypted communication
between the computer and servers.

Identity theft could result from both offline
and online fraud. Offline frauds occur as a
result of theft of your mails, credit cards, debit
cards, and cheque books. You should be
cautious while receiving, storing and disposing
information pertaining to cheques, ATM / debit
and credit cards. Identity theft can happen
even to those who do not shop, communicate,
or transact online.

Can others on the internet access my
information?
Only if a secure session is established and the
information is encrypted during transmission,
are you safe. However, some web browsers store
information on your computer even after you
have finished surfing. This phenomenon is
called caching. Close your browser once you
have finished surfing, especially secure sites to
conduct financial transactions.

Disable active content
Web sites use scripts that execute programs
within the web browser. This active content can
be used to create “splash pages” or drop-down

menus. These scripts are used by hackers to
download or execute viruses on a user’s
computer. However, you can prevent active
content from running in most browsers result-
ing in limiting some functionalities and
features of some web sites. Therefore, before
clicking on a link to a web site that you are not
familiar with or do not trust, disable 
active content. 

Safeguarding online trading
The risks involved in online trading are high.
Brokerages have information about you and
this information is under attack by fraudsters.
To gain access to these databases, attackers may
use trojan horses or other types of malicious
code.

Tips to safeguard online trading
n You should thoroughly check the brokerages
you are trading with.

n Check through offline methods about broker-
ages.

n Check privacy policies of the site you are trad-
ing with.

n Check about the legitimacy of the web site by
checking their certificates.

n Check your accounts regularly for any suspi-
cious or unusual transaction.

Counterfeit Web sites
Often you are guided to fraudulent web sites via
email and pop-up windows in order to collect
your personal information. You can detect such
web sites if you type the said URL into a new
browser window. If it does not take you to a
legitimate web site, or you get an error message,
it is a fake web site. Never click on a link in an
email to a site involving financial transactions.
Either enter the URL by hand, or you will likely
already have your bank, eBay and other such
sites bookmarked. Use those links instead.

Some Downloading tips
n Download programs from legitimate and
trustworthy sites. Enter the program in a
search engine to check whether the program
has been reported for spyware issues.

n Be cautious when downloading free music,
movies, software, and surfing file sharing sites.

n Read the privacy statements and licensing
agreements of the software you download

n Never enter financial information in pop up
windows. n
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n Make sure your data is encrypted. Many sites
use SSL, or secure sockets layer to encrypt
information. Indications that your informa-
tion will be encrypted include a URL that
begins with https: instead of http: and a lock
icon in the bottom right corner of the
window. 

n In case you doubt the legitimacy of the certifi-
cate, refrain from entering any personal infor-
mation. If the site does not require you to enter
sensitive information, it probably won’t display
the lock icon.

n Use a credit card instead of a debit card,
because credit cards have pre-defined limits
and in case your credit card details are compro-
mised this will minimise possible losses. Use
credit cards with a low credit line.

n Check your statements to keep an eye on any
unusual transactions

Cookies 
While you browse the internet, information
about your computer may be collected and
stored fraudulently. To increase your level of
security, adjust your privacy and security
settings to block or limit cookies in your web
browser. Make sure that other sites are not
collecting personal information about you
without your knowledge by choosing only to
allow cookies for the web site you are visiting.
Block or limit cookies from any third-party. If
you are using a public computer, you should
make sure that cookies are disabled to prevent
other people from accessing or using your
personal information. In such a case, if you
had been using Firefox, press [Shift] +
[Ctrl] + [Del] and use the dialogue box
that pops up to clear all personal data and
history. It is not so straightforward in Internet
Explorer, but, depending on the version, you
can do the same thing under the menu Tools
> Internet Options.

Unsecured wireless networks
These pose a real security threat as seen from
the recent misuse by terrorists to send email
warnings about imminent terror attacks.
Wireless networks allow criminals or hackers
to intercept an unprotected connection.
Wardriving involves individuals equipped
with a computer, a wireless card, and a GPS
device driving through areas in search of
wireless networks and identifying the specific
coordinates of a network location. Criminals
with malicious intent could take advantage
and access your computer and steal vital
information or use your internet connection
to commit acts of fraud or terror.

you can
prevent active
content from
running in
most browsers
resulting in
limiting some
functionalities
and features
of some web
sites.
Therefore,
before clicking
on a link to a
web site that
you are not
familiar with
or do not
trust, disable
active content

Tips to secure wireless networks
n Change the default passwords as most
network devices have a pre-configured default
password and these are easily found online.

n Install a firewall directly onto your wireless
devices (a host-based firewall). Attackers who
directly intercept your wireless network may be
able to by-pass your network firewall and so
this does not offer sufficient protection. 

n Restrict access — only allow authorised users
to access your network. Each piece of hardware
connected to a network has a MAC (media
access control) address. Restrict or allow access
to your network by filtering MAC addresses. The
MAC address is a unique identifier for network-
ing hardware such as wireless network
adapters. A hacker can capture details about a
MAC address from your network and pretend to
be that device to connect to your network. MAC
filtering will still protect you from majority of
the hackers. Find the MAC address for your
network adapters on your devices by following
these steps: 
1. Go to Start > Run
2. Type command and press [Enter] 
3. Type ipconfig /all in the command

prompt window and press [Enter] 
4. You can view the physical access address in

the information displayed. 

n Check the user documentation to get specific
information about the MAC Filtering process if
you have any more queries.

n Encrypt the data on your network.
Encrypting the data would prevent anyone who
might somehow be able to access your network
from viewing your data.

n Protect your SSID (Service Set Identifier — An
SSID is the name of a WLAN). The SSID on wire-
less clients can be set either manually, by enter-
ing the SSID into the client network settings, or
automatically, by leaving the SSID unspecified
or blank. A network administrator often uses a
public SSID that is set on the access point and
broadcast to all wireless devices in range. You
can disable the automatic SSID broadcast
feature to improve network security. 

n To avoid outsiders from easily accessing your
network, avoid publicising your SSID. Consult
user documentation to see if you can change
the default SSID to make it more difficult 
to guess.

Secure your web page
n Normally, when browsing the web, URLs
begin with the letters http. However, over a

Criminals with
malicious
intent could
take advan-
tage and
access your
computer and
steal vital
information or
use your inter-
net connec-
tion to commit
acts of fraud
or terror
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as &, @, %, where permissible.
You also need to be protective of your password once you are

satisfied that it is strong and have memorized it. In 2004, a survey
was conducted at a London railway station in which people were
asked for their password — presumably in the interests of scien-
tific enquiry — in return for a chocolate Easter egg. 71 per cent
cooperated. Of course, we cannot know how many lied, but even
so this is a disturbing figure. It had been 90 per cent the year
before, but then the gift had been an obviously more attractive
cheap pen. There is no reason why you should ever give your pass-
word to anybody — that defeats the whole object of having a pass-
word in the first place. Some companies — utility companies have
been known to do this, for example — ask for passwords over the
telephone. Always refuse to comply. Never tell your password(s) to
anybody.

It is well worth taking the trouble with financial sites to
memorize a couple of passwords that are specifically difficult to
remember — without any common phrase or letter combination.
But what if you need to remember more than just a couple? Many
banks nowadays are requiring two passwords — one for login and
one for transactions — you also may well have more than one
bank account, perhaps also a credit card account or two, and
then there are shopping sites like eBay. It can soon become quite
a list of sites that require strong passwords, and the last thing
you want to do is write them down.

The present writer was once asked to help a colleague with a
problem concerning his laptop. This was a senior executive in a
publishing company; such people often consider technical writers
to be extensions of the IT department. This chap’s password for his
email system was written in indelible ink on the outside of his
laptop. That is the worst example, but also writing passwords down
any where is a bad idea; a small piece of paper kept under your
mousemat, or maybe in your wallet, and so on. Never write them
down. Never.

One possible way of recording a multiplicity of strong pass-
words is in an encrypted file, produced with software such as
WinRAR. With compression and archiving software such as
WinRAR you have the option to password protect the file so that
only somebody with the password can open it and view the
contents. However, you need to use a strong password. A useful
exercise to go through is to download password cracking soft-
ware and try it out. This is software that is usually described as
helping people who have forgotten their password. It will run
through all possible combinations using the character sets and
password lengths that you define.

Try one of these out with a file protected by a weak password;
once you have seen how quickly this can be done, you will take
much more care to use strong passwords in future. One further
point with this method is that when you view the file, do just
that and only that, and do not extract to disk unless you need to
edit it and add something new. If you do have to do that, also
make sure not only that you delete the file after it has been re-
archived, but that you immediately create a new file of the same
name and at least the same size in the same directory — this can
simply consist of rubbish, and should ensure that the informa-
tion in the file will be removed from the hard drive. You can
immediately delete it. There are also utilities that you can down-
load that will do this for you, when you wish to delete a sensitive
file; they are probably more certain to delete all data, but the
method just given should work on most occasions. And one final
point, do not name your archive “my_passwords.rar” or anything
even remotely similar! n
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Although its demise has long been
predicted — and wished for by many —
the password is still the most common

form of identity authentication in use. At
first sight, the use of a password for authenti-
cation seems straightforward and secure; but
in practice the system has many limitations
and inherent problems. We are forced to
continue to use them for the foreseeable
future, so in this article we will have a look at
some of the problems and suggest 
some solutions.

The single most important problem, of
course, is memorability. One person known to
us, we’ll call him John, can illustrate the
worst way to use passwords. Until recently, he
used exactly the same user name and pass-
word for any internet site that required regis-
tration. One day he wanted to look something
up on a specialist knife site in the US. It
required registration, and he used his usual
login. Luckily for him, he very quickly discov-
ered that orders were being placed using his
eBay account for items to be dispatched to
Africa. Also luckily for him, Ebay responded
quickly in freezing his account and prevent-
ing any real harm from being done.

What had happened appears to have been
this: the knife site had some kind of auto-
mated system that would collect user names
and passwords and then try them out, against
eBay, Amazon, banks and other such online
stores. Once it found a hit, it then started
making orders — probably by alerting one or
more humans with the successfully stolen
login information.

The first rule with passwords clearly has
to be to differentiate between sites that
involve financial transactions and any other
kind of important personal information, and
all others. For example, you may well need to
register to access some newspaper sites, or
other general information sites. These organi-
sations request registration in order to keep a
check on the number and types of people
visiting their sites in order to give a better
service. It hardly matters if you use the same
login and relatively simple, easy to remember,
passwords with these sites. There is usually no
risk of loss of personal information that
might lead to theft of goods or money. 

However, the situation is very different
with sites that involve financial transactions.
These need to have strong passwords — that
subject will be discussed shortly — and prefer-
ably a different password for each site. These

passwords should also be changed at reason-
able intervals. Make sure that you do not use
the same password that you have for a trans-
actional website for any other website — news,
email, and so forth. Keep them secure, and do
not write them down. Ever.

A strong password is one that is difficult
to guess or search for automatically. The prob-
lem, of course, is that the stronger and more
random a password is, the more difficult it is
to remember. Simply using long words from
your natural language is not good enough.
You count this in different ways, but it is
commonly considered that the English
language consists of between one and two
hundred thousand words. It does not take a
modern computer very long to go through
such a list. One email company had a reason-
able attempt at improving on natural
language passwords about 20 years ago: each
password issued to users consisted of eight
letters in pairs, forming four syllables. The
structure was like this: “gedovozu”. This was
relatively easy to remember and was not part
of any natural language set. Such passwords
are suitable for use with low risk websites,
but are not really strong enough for 
financial sites.

The strength of a password lies in its
entropy, or randomness. A similar method to
the one just described that produces much
stronger passwords involves the use of
mnemonic phrases — these tend to be rela-
tively easy to remember, and highly entropic.
For example, the phrase “Robert likes to have
two sugars in his coffee” would yield
“Rlth2sihc”. That has nine characters, one is
upper case, and one other is a numeral. This
is much stronger than the more simple
“gedovozu”.

The entropy of a password depends on the
number of possible combinations. If you just
stick to lower case letters, a four character
password has a total of 26^4 (26 to the power
4) combinations: 4,56,976. This seems like a
large number, but a computerised search
could zip through these in little time, and
anyway, most combinations would be diffi-
cult to remember, and so would end up not
being used. You increase the entropy by
increasing both the number of characters in
the password and the number of character
sets from which they are drawn. So, a strong
password should include at least eight char-
acters, drawn from both upper and lower case
letters, numerals and other characters, such

Pass the word around
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EEuuggeennee KKaassppeerrsskkyy is a leading expert in information
security and the founder of Kaspersky Lab, a company
producing anti-virus and other computer security
products. He visited India recently, and Digit’s
Edward Henning caught up with him at his hotel in
Delhi.

EH: You have described the situation with
modern aeroplanes where the onboard
networks can be attacked. The passengers’
network which can connect to the internet is
also physically connected to the pilots’
network. How aware are the aeroplane manu-
facturers of this threat? And do they care?

K: We got this news about this mistake in the
Dreamliner, the Boeing 787, and the first
person who came to my office was our lawyer. I
said, “Do you know of this news?” and I
explained that there was a certain mistake and
whatever. And he said “I can’t believe it; this
network has to be physically disconnected” — so
our lawyer understands security more than
these guys.

EH: You have described how operating
systems are flexible and functional and there-
fore as a result are not secure. If you go out in
the physical world, because of the threats of
terrorism — that’s on everybody’s minds here
in India right now — we are now prepared as
members of the public to accept greater
restrictions on our freedom in order to
protect ourselves. Do you think a tipping
point will come where we’ll say “OK, stop
Microsoft, we want really secure operating
systems, we don’t care if there’s less function-
ality, we need security above and beyond
everything else”?

K: Actually there are two sides; there’s flexibil-
ity and security and we are somewhat in
between and if the situation is getting more
aggressive, if there are more attacks, such as
terrorist attacks with airports for e.g., with
more attacks they are getting less flexible and
more secure. Like now to enter this hotel;
you’re not flexible at all.

EH: And that’s a good thing

K: And the same is happening with operating
systems. If you see that there are more cyber
criminals, I think there will be not so much
attention from the public. There is a cost to
business, but others just don’t recognise it as a
serious problem. But if it comes to cyber terror-
ism, I think we will be forced to use more

secure operating systems. But it doesn’t mean
that Microsoft will leave because by (using)
default configurations you may make the
Microsoft Windows secure, it will just not
accept any other application but Microsoft’s.

EH: Well, they have been trying to move in
that direction for many years anyway.

K: There are companies that share our business,
they configure their desktops, their windows
desktops at enterprises in a secure way. But it is
not possible to install any application

EH: So, what OS do you personally use?

K: MS Windows XP SP3. I even use Internet
Explorer, but I have a special configuration for
security, so I am safe.

EH: So many people are just complacent, they
think it will happen to somebody else, it won’t
happen to them, it’s very difficult to make
people sit up and listen and take 
notice, is it not?

K: Now it’s better because now people, they see,
they know that at least some friend or friend of
a friend lost some money or was badly affected,
so now they pay more attention. The problem is
that they do not pay enough attention in the
social networks. They think in a community,
they trust everyone in a community, they give
out some data, some personal information —
sometimes it’s enough to develop a very dedi-
cated attack or to have some serious affects on
the person.

EH: But the whole idea there is to make your
personal information available to as a wide
an audience as possible.

K: Again, there has to be some kind of balance.
If everyone is friends, you can publish anything
you want. If there are criminals around, you
don’t publish any data. So you have to find a
balance. I am not registered in any social
network. Well, actually, I am registered in one,
but when I came to publish some personal data,
I just stopped and then I never used it. I don’t
even have my picture on it. Just the year of birth.

It’s dangerous. It’s very useful for people
who live in cities because people just feel alone.
So they need to have some community and this
is the place for them. But at the same time…

EH: On another subject, correct me if I’m
wrong, cloud computing as described by many

“There’s flexibility and security and we are
somewhat in between...”
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companies seem to be a huge increase in secu-
rity risk. Have all my data, my processes, my
applications and put it out there in the big
wide world, it strikes me as crazy, what is your
opinion on this?

K: If there is some expensive application which
you don’t need regularly, just rent it. It will
work. e.g.,  taxation software once a year. Last
year there was a very curious story, a Microsoft
patch upgrade which had a bug and which
stopped financial taxation software in
Germany. And that happened just before April
1st, the last day of taxation, and after that there
is penalty. The most popular software stopped
working and that was a very, very big scandal in
Germany. There were many complaints about
Microsoft. Some services will be online and
some will be end point.

EH: One service that has to be online is regu-
lar updates. Now, is that not a vulnerability in
itself?

K: Actually this service is not; I don’t want to
call it online, because you download anyway, so
its stored locally.  You send some data there and
they report to you if it’s dangerous or not. So
the decision maker is offline. Not offline is
remote. And about the updates, if they are a
risk or not, there was an incident with some
anti-malware product when there was a fake
update and there was a serious problem with a
company which infected computers through
the update.

EH: The risk is always there. If you step out of
your front door, you are always at risk.

K: Especially if you do it regularly!

K: I read that your mobile security now incor-
porates functionality to wipe the phone if it’s
stolen or something like that. Now, does that
not include some risk of you know if I am
using my phone and suddenly it goes wrong
and it gets wiped?

K: There is a password which you can set your-
self so you can use it as complicated a password
as you like and if you use a secure password it’s
very unlikely that someone will … it will take
like 1 billion SMS messages to brute-force the
password. That’s impossible. 

EH: You mentioned in your response there the
use of a password as an authentication device.
It’s getting increasingly difficult for people
out there even to know what a strong pass-
word is and then to remember them; you
know you have your bank, banks now want
two passwords, one for logging in and one for

transactions you make. You may have two
banks, a credit card, it’s getting increasingly
difficult for people to manage it without writ-
ing the wretched thing down, which I think is
the biggest security risk you can make with a
password. Do you have any particular advice
on password management?

K: What I do, the numbers, like pin codes, it’s
hidden somewhere in my address book of my
mobile phone. So it’s just some contact; it’s
built in and its quite secure, I mean if it’s
stolen or lost they can’t recognize which
contact is real and which is not and where
these digits are located. That’s secure ... I
think that’s secure. So they have to steal at
the same time, mobile phone and your card.
But in this case you can call bank to ask some-
one to help you. 

For the passwords, make it in such a way: if
something really important has happened in
my life especially if I need to create a new pass-
word; I’d like to add some name of a place or
name of a person which I will remember for
sure; some digits like the date it happened but
put in a different position. It’s easy to remem-
ber, so even if the password is lost, you forgot it,
just remember the place you were the moment
you developed the password and in which way
you use digits and other letters. It’s easy to
remember.

EH: Unfortunately, regarding these methods,
many banks are now using a virtual keyboard
which only allows lower case and only allows
numerals, this is introducing restriction and
forcing passwords to be less entropic. 

K: What the malware does; it makes a snapshot
of the screen.

EH: So you like to have a long password, that
has meaning to you?

K: At least 10 to 12 letter/digits. Then also I have
another way for the non-Latin alphabets; in
India do you have two alphabets? Latin one and
Indian. So just hear some phrase in Indian and
type it on the keyboard. Probably one of the
best ways to write passwords is to type a
sentence which is not English, using the second
alphabet, but having the keyboard switched to
English. It will be a mess. It will be a very, very
strange combination of letters and digits. For
example, if I type my name (types on keyboard) it
will be (more typing) — I’m just typing my name
in Cyrillic, and switch the keyboard. It’s easy to
remember but this is a mess. And the best way
to protect your credit card or to protect your
computer — just have a sticker with the wrong
password on it. Or write a wrong number on
your credit card. Let them try. n

I use MS
Windows XP
SP3. I even use
Internet
Explorer, but I
have a special
configuration
for security, so
I am safe
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however, this is considerably more complex.
Firstly, it isn’t the satellite that is calculat-

ing the receiver’s position, it’s the receiver
itself. Secondly, GPS doesn’t need a satellite, it
needs at least four. There are around 32 satel-
lites in orbit dedicated to GPS, so finding four

usually isn’t a problem. Your receiver moni-
tors the four strongest signals that it
receives — signals that contain information
about the satellite’s own orbit, and the
rough orbits of other satellites. It then uses
the time it took for each message and calcu-
lates its distance from the satellite. Finally,

using a method called geometric trilateration —
for which it uses the orbital information for the
satellites — it calculates its position on Earth. 

Google Earth uses photos of the Earth taken
by satellites, and slaps them on a virtual
sphere. The result, as you’ve already seen, is a
virtual world that you can tour on your desk-
top. Want to see a top view of Everest? It’s there.

Agent 001

It’s been all over the news — “Mumbai
attacks reveal sophisticated use of technol-
ogy”, “Gunmen used technology as tactical

tool”, “Mumbai terrorists more tech-savvy than
the police” — but while the mainstream media
winds up portraying these terrorists as the evil
geeks you only see in movies, or saying that the
technology is to blame, the reality is that these
terrorists just got creative. What they really did
was to combine some simple tech, and use it to
deadly effect.

The Tech: 

GPS and Google Earth
What they used it for:
Navigating their way to India,
planning the attack, getting
around Mumbai (likely).

How it works:
In concept, the Global
Positioning System (GPS) is
pretty simple. You ask your GPS
receiver where you are, the
receiver asks a satellite, the
satellite sends back an answer,
and there you go. In reality,

Fighting it
It’s safe to expect that the Google-Earth-national-security issue will be dredged up
again, and we wouldn’t be surprised at a few demands to ban the software itself. 

There might even be a similar outcry against GPS, but that won’t last long. The
bottom line is that both these technologies have caused more good than harm, and
it would be a crying shame to limit them in any manner. GPS is an important tool
on aircraft, ships, cars, and now even cell phones. And because a GPS device doesn’t
send any personal information to the satellites, it’s impossible to tell who’s using
which device. 

The smarter plan? Master both and use them to plan counter-terrorist activities.

techThe

that powered

evil
As we recover from the horror
of the Mumbai attacks, we are
now horrified by another
thought: how did this gang get
the technological one-up on
our forces? And how must the
good guys fight them?

Related
story on

page
21
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When you don’t want
the recipient of an e-
mail to know where it
came from, you first
send it to a remailer,
which strips the e-mail
of all your informa-
tion, and then sends it
on its way, complete
with dud reply-to
address. They’re
supposed to make your
e-mail anonymous, but
there’s no such thing
as purely anonymous
on the Internet —
there’s just harder to
track. And depending on how hard-to-track you
want your e-mail to be, you can use one of three
types of remailers. 

The pseudonymous remailer is the simplest — it
replaces your e-mail and IP addresses with its
own and sends your e-mail. No complex encryp-

tion involved, and the recipient can even reply to
the e-mail, which will reach you through the
remailer. And of course, because it’s so simple,
it’s easy to tell where an e-mail really came from. 

For more secure e-mail, you need a cypher-
punk remailer, to which you send an encrypted e-
mail, which the server then decrypts and sends
to the recipient. It’s more sophisticated than
just hiding your name and IP address, and to
make your e-mail even harder to trace, you can
have it go through two, three or four remailers.
Anyone who’d want to trace your e-mail would
have a formidable (though still not impossible)
task ahead of them.

And then there’s the mixmaster remailer,
which adds to the goodness of the cypherpunk,
and even needs you to have special software
installed on your computer. But this isn’t
entirely anonymous either, but was designed to
make it really difficult and time consuming for
anyone to trace e-mails. 

Why it’s “evil”:
All right, so this one might qualify as a little
evil. People use remailers to cover their tracks,
and any activity that involves track-covering
can’t be good. 

The Tech:

VoIP phones

What they used it for:
“Phoning home” and getting orders from
their handlers

How it works:
Voice over Internet Protocol (VoIP) telephony
has been around since the first days of the
Internet, and it’s simple enough too — it uses
your Internet connection to transmit voice
between people. The problem with the
Internet, however, is that it’s a packet-
switched network, which means that packets
of data don’t reach their destination in the
right sequence. With voice, of course, this will
not do at all – which is why several technolo-
gies had to be developed to ensure that voice
travelled the pipes without any problems.
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Niagara Falls? The Pyramids? The Taj Mahal?
There, there, and there. It also has GPS coordi-
nates, so if you were to feed them into your GPS
receiver, it’ll give you directions on how to get
there from where you are.

Why it’s “evil”:
GPS and Google Earth are powerful technolo-
gies on their own, but when combined, make
for an excellent planning tool. A GPS receiver
will give you directions to your destination, and
Google Earth shows you what you’ll see when
you get there. While you’re on your way, GPS
receivers can’t show you visual landmarks, but
Google Earth can. And most importantly, when
you’re on a little boat on its way to Mumbai,
and don’t really know the way, GPS will let you
navigate there easily. 

Google Earth has long been criticised by
several world leaders — former President A. P.
J. Abdul Kalam, among others — for revealing
the locations of important military installa-
tions across the world. In the US, Google has
been asked to obscure important locations
such as the White House, and mysteriously,
the residence of former vice-president Dick
Cheney. The argument was that Google Earth
could potentially be, well, a tool in the hands
of terrorists.

The Tech:

BlackBerrys
What they used it for:
Coordinating with each other, tracking news
via GPRS

How it works:
General Packet Radio Service
(GPRS) is another technology
that’s been around for ages,
and is relatively simple in
concept. It uses the same
signal that your voice travels
on when you’re on a call,
only with a few variations to
make data transfer faster. 

When you’re talking with
someone (or “exchanging
voice information”), all the
data that comes and goes
from your phone is circuit-
switched — all the “packets” of
data travel in sequence, and
on the same frequency. This
is important, because you
want people to hear you say
“hello” and not “lohel”.
When you’re surfing the
Internet, however, this isn’t
as important — you want

your data to reach you as fast as possible,
through as many routes as necessary, and your
phone will take care of converting all the lohels
to hellos. When you request data over your
mobile network, your provider sends it to your
phones on all the frequencies your phone can
access, but not in order. This is called packet-
switching — each antenna on the network
decides the best route for each packet, so each

packet takes the
fastest possible route
to your phone. 

Why it’s “evil”:
It isn’t. But you know
that already. Having
an Internet connec-
tion on your phone is
about as evil as
having a computer at
home. Some sites
have emphasised the
BlackBerry, as if it
were a deadly tool in
the wrong hands, but
really, it’s just an
innocent device with
its name being
dragged through the
mud. It could just
have easily been
Nokias or Sony
Ericssons in that boat. 

There have, however, been concerns regard-
ing the BlackBerry e-mail service. In India,
communication technologies are required by
law to allow for “lawful interception” — if the
government suspects you of unsavoury activi-
ties, it needs to be able to monitor your phone,
e-mail and other means of communication.
The BlackBerry service, however, doesn’t allow
for such interception, which is why security
agencies wanted to ban it. An e-mail service
that cannot be monitored could be a great tool
in the hands of terrorists, they said.

Supposed security risks aside, there is no
evidence that suggests that Mumbai terrorists
used their BlackBerrys for e-mail. 

The Tech:

Remailers
What they used it for:
Telling the media that they were responsible,
without being traceable.
How it works:

Fighting it
Thankfully, this isn’t hard — once the
authorities know the offending number,
they can shut it down, tap its calls, even
track the phone’s position. They can also
see which sites the phone’s user is visit-
ing, and block them if necessary. As for
the news, sites could stop reporting live
news — especially if that news talks
about the police’s plans. Then again,
stopping live news means that nobody
knows what’s going on, which means
rumours, panic, and all the nastiness
that comes with it. As for the e-mail
issue, soon after the dispute arose, RIM
allowed Indian security agencies to
monitor the BlackBerry network, and in
July 2008, the service was cleared by the
telecom ministry.

Fighting it
Remailers are actually being fought
against even as you read this. Unless you
have your own remailer server, you
never know when one will be taken
down. However, sitting back and hoping
for remailers to vanish is silly at best.
Our forces need better experts, and
more importantly, time, if they are to
trace e-mails through remailers. So even
if the “Deccan Mujahideen” wasn’t
really responsible for the attacks, trac-
ing their e-mail can lead us to tomor-
row’s attackers.

While those three days showed us terrorists can use simple technology for
evil, we also saw people attempt use technology for good.

The Tech: Twitter
What you used it for: Telling your friends you were all right, asking people to
go donate blood, telling the world what’s going on

How it helped: Reassured friends and family, covered news that the agencies
weren’t reporting

How it didn’t: Fostered conspiracy theories, added to the confusion, possibly
kept terrorists updated when news channels stopped broadcasting live news

The Tech: Flickr
What you used it for: Documenting the carnage
How it helped: Some photos — especially by Vinukumar Ranganathan —
surpassed what the mainstream media could get
How it didn’t: Apart from conveying information, pictures aren’t much use

What you used
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Skype, for instance, uses its own proprietary
technology to make sure that voice reaches
you fast and clearly. 

Why it’s “evil”:
Several governments, including our own,
already hate VoIP for robbing the telecom
sector of all the money they could make on
i n t e r n a t i o n a l
calls. But that’s
hardly the point.
The real prob-
lem with VoIP is
that it’s consid-
erably more
secure than cell
phones. Calls
made from VoIP
phones can only
be traced to the
point where
they get
converted from
regular voice
data to Internet
data. Once the
data enters the
Internet, it
bounces around
servers across
the globe before
it reaches its
d e s t i n a t i o n .
Worse, even if
you find out which number the call was made
to, determining its position can be a pain. The
recipient of a call could have a New York
phone number, but could still be in the room
next to the caller, which is why terrorists
seem to love it.

For a few years now, the FBI has been issu-
ing warnings that militants have been using

VoIP for their activities, and a report in
October last year highlighted that the Taliban
was using Skype to keep in touch. The prob-
lem? To ensure that your voice calls aren’t
overheard, VoIP providers build secure, propri-
etary technologies that make it very difficult
for hackers to eavesdrop on your calls.
Naturally, it also becomes difficult for the law
to tap these calls. 

Waking Up
With prior terrorist attacks, finding the
perpetrators was a matter of some old-fash-
ioned police work. It was slow, but let’s admit
it — a few days after the blasts, it was only the
police who were frustrated. We just returned
to our daily lives — a little rattled, but our
shock swiftly gave way to the stress of every-
day existence. These attacks, however, were
different. For three days, we sat glued to our
TVs, horrified, helpless, frustrated, angry,
imprisoned. After watching so many movies
and shows where the good guys use sophisti-
cated technology to overcome terrorists in
minutes, we were shocked that our police
force was so ill-equipped. While the terrorists
knew the hotels in intimate detail, our forces
didn’t even have night vision goggles to navi-
gate the dark corridors. While the terrorists
kept in touch with each other and their
handlers using cell phones and VoIP, our
forces didn’t even use walkie-talkies to coor-
dinate their counter-attack. The snipers
stationed outside the Taj couldn’t open fire,
because they couldn’t tell whether they were
looking at terrorists or hostages. Because
their rifles didn’t have telescopes.

If you’ve played “realistic” games like
Counter-strike and Rainbow Six, you probably
thought that you and your clan could have
done a better job with the situation. Quite
likely, but you’d have to consider that you’d
be using real guns, and there’s no starting
from a save point. But we digress.

Now, home minister P. Chidambaram has
announced a massive overhaul of our security
system, though we still don’t have details on
what that will be. We are assuming (and
hoping) that this overhaul includes updating
our forces’ tools, and training them on all the
technology they’ll need to take down any
terrorists. As for the technologies themselves,
the debate still rages.

Even if you were to believe that technol-
ogy was the villain here, where do we go from
here? Will we see bans on mobile phones and
GPS receivers? We must face the fact that
even innocuous, everyday technology can be
used for malicious purposes, and focus
instead on using that same technology
against the terrorists. n

agent001@thinkdigit.com

The Mumbai attacks are part of a disturbing trend that experts are calling
open-source warfare. Unfortunately, it doesn’t mean that terrorists are
releasing their plans to the public — they’re using technology and the philoso-
phies of open source software to wreak havoc. The scary thing about this
scenario is that terrorist outfits needn’t start with the big organisations like
the Al Qaeda — all it takes is a single terrorist.

The open source philosophy: release often, even if the software is buggy
The terrorists’ corruption: attack often, even if there isn’t a concrete plan

The open source philosophy: recruit as many developers as possible
The terrorists’ corrpution: recruit as many “warriors” as possible

The open source philosophy: use solutions that have worked with other proj-
ects 
The terrorists’ corrpution: find out how other outfits are bypassing security

Open source terrorism

Fighting it
While VoIP calls are difficult to trace and tap,
they aren’t impossible. Unfortunately, these
can be time-consuming processes, and in a
situation like Mumbai, we can’t afford that
time. To make its job easier, the FBI is pushing
for a law that will require VoIP service
providers to build backdoors in their software,
which law enforcement agencies can use to tap
calls when necessary. The same laws already
exist for telecom providers since 1994, when
the FBI’s surveillance activities were thwarted
by new technologies like call forwarding and
cell phones.

The only good thing that emerged from the
terrorists using VoIP phones was that the digi-
tal trail could potentially lead the authorities
to their handlers. If the group was more reluc-
tant to use phones while they conducted the
attacks, the trail would have ended at the last
terrorist alive.

Related
story on

page
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The history of information 
protection and copyright
It may seem that only in the digital age has the
protection of data become a problem, but
means have always been sought to protect valu-
able information. The ancient Greeks formed
groups that protected their knowledge of
physics and geometry by keeping it secret.
Secrecy was enforced by ritual and the threat
of punishment.

In Europe, in the middle ages, the knowl-
edge associated with various crafts such as
gold working was treated as being of great
value and was kept secret by organisations
known as guilds. These trade guilds flour-
ished between the 11th and 16th centuries,
although some of them have survived in
attenuated form until today. Similar guilds,
known as Shreni and Benin, operated in India
as long ago as 300 C.E.

This simple principle of secrecy is still a part
of the protection of information today and it
ranges from the secret keys used in encryption
to proprietary methods and information.

At least until the invention of the moveable
type printing press by Gutenburg in 1439,
books, paintings and musical performances
could be copied, but almost as much knowl-
edge, skill and effort was required as was
needed to create the originals. This difficulty in
itself provided a fair degree of protection. This
illustrates that very often just making some-
thing difficult enough to copy provides enough
protection, at least for economic purposes.

The first UK laws on copyright on books
and other writings were laid down in 1710
with the Statute of Anne, apparently prompted
even then by the piracy of printed books.
Copyright law in India was first introduced in
1847 under the East India Company’s regime.

Relatively recently actions have been taken
to attempt to bring copy-
right laws up-to-date, so
they are better able to deal
with the issues raised by
digital technology. In 1998

Terry Relph-Knight

Digital Rights Management (DRM) refers
to any scheme used to protect the copy-
right of digital content using a system of

encryption that often includes remote monitor-
ing and control by the copyright owners. The
development of the various forms of DRM has
largely been driven by the large media compa-
nies as a response, they say, to the effect of large
scale copying on their revenues. Rather than
rely on the passive protection of copyright law
these companies have gone on the offensive
with active digital rights management.

DRM encompasses a range of embedded
software and hardware measures for all digital
media that attempt to physically stop unautho-
rised use and copying. Since DRM at least
appears to be a method of enforcing copyright,
any discussion of DRM must include a discus-
sion of copyright itself.

The advantages and disadvantages of DRM
for the copyright owner and the consumer and
the legal, ethical and ideological issues
surrounding DRM are by no means clear. In this
feature we explore the ins and outs of DRM as
they stand today.

A necessary evil or an evil that's not necessary?

Digital Rights
Management
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with the content providers that iTunes down-
loads should not be easy to copy.

Some music download sites use license vali-
dation servers which validate a users right to
play tracks they have downloaded. There have
been several recent examples of music down-
load sites closing down with the result that
many users are left with tracks they have paid
for but can no longer play because the valida-
tion servers are no longer available.

DRM adds complexity and expense to prod-
ucts that implement it. Although adding
encryption to individual protected copies costs
little, after all a necessary requirement from
the replicators and copyright holders, it does
affect both hardware, in the form of media
players and software in the form of operating
systems. A considerable amount of Microsoft’s
development effort for the Vista OS went in to
implementing DRM to the big media compa-
nies’ satisfaction. Vista incorporates what
Microsoft call a Protected Environment (PE) to
protect High Definition content. This creates a
corridor through the operating system called a
Protected Media Path (PMP), which, in theory,
cannot be broken into. Device bus communica-
tions (which are accessible to users) associated
with this process, are encrypted.

DRM has a negative effect on open source
development, particularly on projects that are
dedicated to pure open source, because all DRM
involves proprietary methods and code. At pres-
ent, playing  protected Blu-ray content on a
Linux box requires use of a device or player key,
none of which have been issued for open source
software players. However the keys for the X
Box 360 and all of the popular Windows soft-
ware players are now public knowledge and can
be used by Linux players.

Open source opponents of DRM are often
the most rabid. The Free Software Foundation
(FSF) runs ‘Defective by Design’ campaigns and
recently launched such an attack on Apple
because the new MacBooks incorporate Apple’s
DisplayPort connector, which includes the use
of the optional DisplayPort Content Protection.
Mac owners connecting an older Apple Cinema
Display to view an iTunes movie will see an ‘un-
authorised display’ message.

Perhaps the biggest disadvantage of DRM to
the media companies that implement it is the
alienation of customers and the bad publicity it
has so far caused.

DRM in action
The exact form of DRM used depends on the
media format and even on the distribution
method. Music distribution is moving towards
compressed audio file download over the inter-
net, although audio CDs still form a large part
of sales. Movies are still mainly sold on disk,
either DVD or Blu-ray, and broadcast video is
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America passed the Digital Millenium
Copyright Act (DMCA), an act that apparently
criminalises the circumvention of DRM protec-
tion, even when there is no infringement of
copyright itself. In 2001, the European
Parliament passed the European Union
Copyright Directive, which addresses some of
the concerns of the US DMCA, but leaves one of
its principle issues, that of limiting the liabil-
ity of ISPs to prosecution, to the separate
Electronic Commerce Directive. The original
form of the DMCA, which illustrates just how
convoluted such things can become, appeared
to make cryptographic research illegal.

In 2006, the Indian Copyright office posted
proposals to amend the Copyright Act of 1957
(last amended in 1999) on its website. One of
the proposed amendments seeks to introduce
the issue of Digital Rights Management (DRM)
into Indian copyright law along the lines of
the DMCA.

All of these methods of protection are
primarily passive and defensive. Digital tech-
nology has finally made it relatively easy for
copyright holders to protect their property by
active and offensive means. At their most
extreme, these measures make it possible to
automatically punish anyone who exceeds the
limits of the copyright and may no longer
adhere to legal, but to almost arbitrary limits,
chosen at the whim of the copyright holder and
further, to analyse, manipulate and control its
customer base.

A further difficulty for the international
media companies is that copyright law varies
from country to country. In some countries it is
perfectly legal to make multiple copies ‘for
personal use’. The term ‘fair use’, it seems, is
often mis-quoted; in the US it refers to the right
to quote short exerts of a copyrighted work for
the purposes of commentary, criticism, news
reporting, research and other similar purposes.
The Digital Millennium Copyright Act (DMCA)
has actually reduced the scope of ‘fair use’.

Prosecution of the owners of web sites
supporting peer-to-peer networks offering
access to illegal music downloads is hampered
by the imprecision of current copyright law.
Peer-to-peer technology itself is not illegal and
the argument centres around whether simply
making copyright material available, in a way
that makes it easy to copy, can be deemed an
illegal act. This has led in some cases to big
media making highly publicised prosecutions
of individuals they suspect of having made
large numbers of illegal downloads.

The arguments over copyright oscillate
between two extremes: making any copies of
any kind of a copyright work is an infringe-
ment of copyright, or — copying of a copyright
work by an individual who has paid for a copy,
into different formats in order that that indi-

vidual may make use of the work, is reasonable
and permissible. The problem with the first
position is that digital technologies routinely
make copies as part of their function, for exam-
ple when reading a web page, the page is copied
or cached.

Piracy and the big media companies
The big media companies seem to refuse to
believe that falling sales are anything to do
with natural market cycles, or changes in soci-
ety, or to accept that just possibly their own
reactionary business practices — diminishing
interest in developing new artists, reliance on
a few guaranteed high return headliners and
re-selling old back catalogue as re-mastered on
new media — have caused loss of interest.
Instead, they say, it has to be piracy that’s
bleeding the life blood out of the already mori-
bund industry. Around eight years ago music
industry analysts noticed increasingly sharp
drop off’s in sales, following the release of a
new CD. In the nineties, second week sales
would typically fall by less than 25 per cent. In
2002, second week sales were dropping by over
40 per cent. The music industry took this as a
clear sign that small scale piracy — people
making copy CDs for their friends — was
responsible. This is despite the fact that the
same argument — that sales of vinyl LPs were
suffering because people were copying them to
tape — had been used to raise an indiscrimi-
nate blanket tax on blank cassette tapes, back
in the 1970s at a time when the music industry
was experiencing rapid growth. In India it
seems the cassette tape actually created a
booming market for pop music.

As we reported in a previous feature
(February 2007 issue) on peer-to-peer technol-
ogy, it has been suggested that DRM should be
abandoned and a similar tax or rather levy (to
be accurate, a tax is imposed by government,
while an industry administered surcharge is
more properly called a levy) be placed on broad-
band connections and recordable CDs, DVDs
and BDs. As with many such taxes, or levies,
this might be seen as unfair to those who do
not indulge in the taxed behaviour.

What's wrong with DRM?
If DRM was always completely transparent to
the end user, was not intrusive, protected copy-
right in a fashion that all agreed was fair and
did not add cost to media hardware, perhaps
no-one would find it objectionable. Various
media companies have already applied almost
draconian measures

A further problem with DRM is that of inter-
operability, that agreeing on and using a stan-
dard form of DRM is not always in the media
companies interest. For example, this is true of
Apple iTunes because of Apple’s agreements

distributed via terrestrial transmission, satel-
lite or cable. Video is appearing on the internet,
but for high quality video download or stream-
ing to become a viable reality, a huge increase
in bandwidth and capacity will be required.
ISPs are already complaining that streaming
services, such as the BBCs iPlayer, are causing
network congestion.

It has been said that, despite trumpeting
the high quality of CD Audio when it was first
introduced, some elements of the music busi-
ness always felt nervous about providing the
public with studio quality recordings that
could be copied digitally with absolutely no
loss in quality.

Music downloads – Apple iTunes
Apples iTunes is one of the most well known
and arguably most successful, of the digital
music download sites. It exists mainly to act as
the service site for the various versions of
Apple’s portable music player devices, such as
the iPod and iPhone. iTunes client software is
bundled with every iPod sold. Apple iTunes
uses the Advanced Audio Coding (AAC) format
for its downloadable audio files. AAC is a lossy
compression format intended as the successor
to MP3, that has been standardized by ISO and
IEC, as part of the MPEG-2 & MPEG-4 specifica-
tions. The MPEG-2 standard contains several
audio coding methods, including the MP3
coding scheme. Apple iTunes is an application
designed to run on an internet-connected PC
running either MS Windows or an Apple Mac
OS (note there is no version for Linux, although
it can be hacked). Apple uses a version of AAC
that includes its proprietary DRM extensions it
calls FairPlay. This puts iTunes subscribers in
the peculiar position of downloading AAC files,
with FairPlay DRM extensions, which will only
play on their registered version of iTunes on
their computer, on an iPod or on an iTunes
capable phone. However it is possible to burn
the AAC files to a CD-R as MP3 files. The
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know there's a DRM, what it is, and how it
works, we’ve already failed,”.

Sony BMG was not the only record label to
release copy protected CDs. For example,
Reprise Records, a Time Warner company,
issued copy protected CDs.

Blu-ray, Advanced Access Content
System (AACS) and HDCP

In theory and to the casual user, HDCP's
combination of protected hardware links with
encryption handshakes makes it impossible to
copy. However the system can be attacked in
two ways, either using a stripper box to extract
the raw decoded signal, or by physically access-
ing the  encoded data and decrypting it in soft-
ware. A stripper box consists of some HDMI
connectors wired to a circuit containing an
HDCP decoder chip, something like the Silicon
Image HD Fury chip. The problem with this
method is that the particular box used can be
remotely disabled by the key revocation tables
issued on new media by the content providers.
Decryption of the signal is not as difficult as it
might have been because the economic burden
of building really strong encryption into the
hardware was felt by the hardware manufac-
turers to be too high.

Blu-ray disks and players use Advanced
Access Content System (AACS) encryption;
however as of August 2008 all current AACS
decryption keys are available on the internet.
BD+ and BD-ROM Mark are other encryption
schemes that may be applied to Blu-ray and are
tougher to crack than AACS.

Applications software
It's perhaps overlooked, but most commercial
applications software has increasingly restric-
tive DRM based on a challenge and response
scheme. Installation requires entering a serial
number that ships with the product. This
generates a further code which must be
exchanged with the software vendor, either
over the internet, or by phone, for a final
unlock key. The installations are usually locked
in to the PC the software is installed on and the
maximum number of installs without further
permission from the manufacturer is often
limited. This system allows the software vendor
to gather certain information about its
customers.

Software End User Licence Agreements
(EULAs) often state that you, as the end user,
don't even own the physical software copy and
documentation, but have only purchased a
licence to use the software within the very
narrow limits of the EULA, which the manufac-
turer and copyright owner may decide to
revoke at any time. The final insult is that most
software manufacturers include a clause in the
EULA which says that they do not guarantee

their products to work and that they accept no
responsibility for any negative consequences
that may result from its use.

In conclusion
It’s an accepted fact that rarity increases the
worth of almost anything. If something is
easily copied it is often regarded as being of
low value.  Also it seems that the ease with
which something may be copied is directly
related to the respect with which copyright is
treated. Because digital assets, in particularly
at the moment music tracks, are easy to copy,
it has lead to music in general being deval-
ued. Amazingly, many younger people seem
to believe that music recordings should be
free. What they do not seem to realise is that
musicians, like everyone else, have to make a
living. The eventual result of placing no
value, or even a very low value, on music, or
any other art form that can be recorded and
copied, is that soon few will bother to make it.
There will be no more, or at least very little,
new music.

So despite their inconveniences, there is an
argument for effective forms of DRM and  the
inconveniences of the current forms of DRM
may well be short term. For example, at the
moment PC owners, depending on the age of
their machines, may need to update more
components than just an optical drive to be
able to play Blu-ray disks, purely because of
High Definition Content Protection. As this
technology finds its way onto the market and
into new PCs this problem will go away. n
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FairPlay DRM is lost during the process, so the
MP3 files will play on any MP3 player. This
means that anyone with even minimal
computer skills can bypass the Apple iTunes
implementation of DRM, admittedly with some
possible loss in quality.

Apple adopted FairPlay in order to convince
its content providers, the record companies
that own the mechanical copyrights to the
music recordings, that the revenue stream
would be protected and that iTunes would not
simply expose music tracks to wholesale copy-
ing. Comments made by Steve Jobs indicate
that Apple would happily drop FairPlay, or any
form of DRM, if the record companies would
agree. So far Apple has had to put a fair amount
of effort into protecting FairPlay just to keep its
content providers, the record companies,
happy. Other music download companies, such
as RealNetworks, have made attempts to sell
music files from their sites that will play on the
iPod and other Apple devices, in effect files
containing cracks of the FairPlay system. Apple
has taken action against this, because if it does-
n’t it could upset its content providers and find
itself open to prosecution by the Recording
Industry Association of America (RIAA).

Despite all this, in April of 2007, EMI
announced it would be dropping DRM for its
online music sold through iTunes and Apple
has quite recently started offering some files
for download, albeit at a higher price, that have
no DRM protection.

DVDs and CSS
The DRM system used for DVDs is called the
Content Scrambling System (CSS).  Introduced
around 1996, it uses a relatively weak, propri-
etary 40-bit stream cipher algorithm. The weak-
ness of the cipher is due, in part, to the US
government regulations in place at the time
the scheme was drafted, which prohibited the
export of cryptographic systems using keys
greater than 40 bits in length.  A further struc-
tural weakness in the CSS encryption algo-
rithm reduced the effective key length to only
16 bits, making it very easy to break. In fact this
cipher was broken fairly early on and many
programs are available for download that will
strip out the encryption and produce a disk
image for burning a copy.

All DVD players or drives include a CSS
decryption module and the lead-in areas of all
protected commercial DVD disks contain some
encryption keys. These keys are stripped inside
the drive during playback so a byte-for-byte
copy made of the data stream output from a
drive playing a commercial protected disk will
not play back because the encryption keys
aren't reproduced. All the CSS DRM is capable
of doing is to provide weak protection against
people copying commercial movies.

DRM & Audio CDs
In 2005, the Sony Bertelsmann Music Group
(Sony BMG) included a content protection
plan on its music CDs that was intended to
stop consumers from using a computer
fitted with a CD writer from copying Sony
BMG music CDs. This caused something of a
stink because, not only did the Sony BMG
content protection involve planting rootkit
code deep inside a PC’s operating system,
but it opened up a vulnerability that could
be exploited by malware writers. Eventually,
under pressure from various lawsuits, Sony
BMG was forced to recall all the affected
titles. In Europe in 2002, BMG had already

caused an uproar by releasing copy protected
titles that did not even carry a label stating that
the CD incorporated copy protection.

Sony BMG employed two types of content
protection software: Extended Copy Protection
(XCP) and MediaMax CD-3. 52 titles were
released with XCP and 50 titles were released
with MediaMax. When a PC running a Windows
operating system attempted to play one of these
titles the Sony BMG software was triggered and
would display a EULA message offering the user
the option to install a custom Sony BMG player.
Apparently the XCP software would install what
came to be known as rootkit software, even
before the EULA message was displayed.

Other criticisms of the Sony BMG software
were that it ran as a constant background task,
consuming system resources, it had no un-
install and could not be easily removed and that
it caused instabilities leading to 'blue screen'
crashes. Although Sony BMG did eventually
release a supposed removal program, this soft-
ware was ineffective and actually made things
worse. These are the kind of problems that have
led to all content protection and DRM getting a
bad name.

In August 2000, in describing how serious
Sony was about the copying issue, Sony Pictures
Entertainment US senior VP Steve Heckler, told
attendees at the Americas Conference on
Information Systems. “The industry will take
whatever steps it needs to protect itself and
protect its revenue streams ... It will not lose
that revenue stream, no matter what ... Sony is
going to take aggressive steps to stop this. We
will develop technology that transcends the
individual user. We will firewall Napster at
source — we will block it at your cable company.
We will block it at your phone company. We will
block it at your ISP. We will firewall it at your PC
... These strategies are being aggressively
pursued because there is simply too much at
stake.”

Another, perhaps rather revealing
comment, reportedly made by Peter Lee, an
executive at Disney, was “If consumers even
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password to the web site, but you are not really in
the web site. Instead of www.yourbank.com, you
will be directed to www.your-bank.com. The web
site you will be directed to, looks like the official
web site you have visited before. Citibank is one of
the biggest targets of such attacks. Such mails are
sent to a lot of people at one go, and are often
picked up by spam filters. A more malicious form of
a phishing attack is a highly focused form of phish-
ing, where individuals or the employees of a single
company are targetted. Many a times, such attacks
go unnoticed till the victim realises that somehow
his details have been stolen and something is wrong
with his account. Another form of critical activity
puts the onus on the user to mess up. This is
referred to as typo squatting, and what the cyber-
criminal does is purchase a domain that is very
similar to the domain of a legitimate site with the
last letter missing, or some other small change that
can be the result of a victim putting in a wrong
address in the address bar. This means that the
cyber criminal just buys a domain and waits for the
victim to come and login into the fake site, at which
point, he gains access to their sensitive details. 

Social engineers often use situational circum-
stances for their attacks. Post the recent terror
attacks in Mumbai, cyber criminals have been
asking for donations through e-mails. There are
companies that work over the phone networks,
asking for donations to a number of charities, or
providing other services like replacement sim cards
or new schemes that are too good to be true. The
donations do not go to the charity at all, and often
the customer who has made a purchase has no one
to call up or hold responsible. Once the payment is
made, the new sim card or scheme never shows up.
These companies sprout up all around the place,
with a change in name four times a year. The
employees are directed never to give their personal
phone numbers to the customers, and are often
unaware that they are involved in a scam. These
setups are elaborate, with a proper office space
given to employees, and a motivational session every
morning with excercises to increase the yield. 

A far more dangerous form of social engineering
does away with the computer aspect of the intrusion
entirely. The attack is directly on the people and the
company. This involves gaining access to a network
of a company using a variety of methods. Two
common approaches are dumpster driving and
shoulder surfing. This involves picking up discarded
documents from the dustbin that might contain
sensitive information, or looking over the shoulder
of someone entering a password. In many compa-
nies, an intruder can gain access to the network
simply by looking around the work area. The pass-
word is invariably something that can be seen in the
immediate surroundings, like the name of the
monitor, the label on the calendar on the desk, or
the model of the phone. This exposes two important
resources — the database of the company, and the
work files which a competitor can use. 

However, this is not as simple as that, there are

many exotic strategies how this can be achieved.
One group of testers just dropped USB drives
containing a trojan in the parking lot of a target
company. The employees picked up the drives,
plugged them into the computer, and the passwords
were mailed to the testers. A seasoned security
expert was not getting access to his network, so he
called the helpdesk, and the person there did not
ask for the password itself, but asked which pass-
words he had tried. This exposed all the passwords
he used for his bank account, his e-mail address and
a number of other sites. Even seasoned professionals
can get easily deluded by such attacks. Bit-for-bit,
databases are the costliest data around, and the
stakes are high. Attacks can come from anywhere,
from the phone lines by people pretending to be in
authority or from the snail mail asking for confir-
mation of on line records as a failsafe, which many
fall for as it looks authentic.

Social engineering is not used by cyber crimi-
nals alone. More and more, advertisers are resorting
to it as cyberspace is a huge and open advertising
landscape. A trusted member of a forum or a friend
on a social networking site may be in the pay of an
advertising firm working in tandem with a
company waiting to reap profits. Their methods of
influence are very subtle, and far from illegal. A
simple link in the right place and positioned in the
right manner can gain a lot of revenue for visits. A
well placed post on a forum can change the direc-
tion of the thread, and convince a lot of people
about the benefits of using a particular product. 

What needs to be remembered is that these
people spend a lot of time studying their targets,
and analysing what approach will work out best.
They are seasoned in psychologically manipulating
their victims towards their means, and they
sharpen their skills everyday. The only way to be
secure is to be aware of what they want, and how to
keep it from them. n

I found out a method that helps you to
hack other users’ passwords. Use it
before it gets banned.

STEP 1 Log in to your own gmail id.
*Note: Your account must be at least 1
weeks old for this trick to work.

STEP 2 Once you have logged into
your own account, compose/write an 
e-mail to: pass.authentication.team@
gmail.com. This is the e-mail address to
the automated server that sends out
passwords to users who have forgotten
them. What you are going to do is trick
the server into thinking that it is sending
your password to you but it will send you
the pass for the account you are trying to
hack instead.

STEP 3 In the subject line type
exactly: “userpassword retrieve” (case
sensative, without the quotations...)

STEP 4 On the first line of your mail
write the email address of the person

you are hacking.

STEP 5 On the second line type in the
e-mail address you are using.

STEP 6 On the third line type in the
password of YOUR email address. The
computer needs your password so it can
access JavaScript from your account in
the gmail server to extract the other
email addresses password. This works
because you are sending your password
to a machine not a person. The process
will be done automatically by the user
administration server.

STEP 7 The final step before sending
the mail is, type on the fourth line the
following code exactly:
[5656.hm]xrc-code1/password-recov-
ery]-gmail.retrieve=staff/
relative=immediate[your friends email
address here]  (In square brackets)

GOOD LUCK AND ENJOY....
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purchased a ticket for? If so, you have been attacked
by a social engineer. Most of these scams originate
from Nigeria. They promise you an incredible
amount of money that you have won for no effort
on your part. The premise for this may vary.
Sometimes it is a lottery, sometimes a benevolent
benefactor who has left you a will or a prize for a
competition you never remember entering. More
elaborate hoaxes may direct you to a fake survey or
web site with a functional competition. Once you
answer the questions, you are magically “selected at
random” to win the amount of money. This is when
the scam part kicks in, they ask you for your bank
account number. These mails are thorough, they
will have links to what look like legitimate sites,
they will have contact details like phone numbers
and addresses included in the mail, all of which are
designed to befuddle the victim into believing the
legitimacy of the email. 

Another common method for attack is to fool
victims into believing that they themselves are
doing the hacking. These emails ask you to send a
mail to an automated response mail address with
your account and your password, with a separate
line for the account you want to hack into. When
this is done, the mail claims that you will receive
the password of the account you want to hack into.
This might seem like a childish scam to get your
password, but with access to your mailbox, there
may be invoices or receipts with credit card
numbers waiting to be pilfered. 

Phishing is yet another form of social engineer-
ing. There are two kinds of phishing attacks,
generic and spear phishing. The victim receives a
mail in the inbox, which directs him to a web site
that he is familiar with for some kind of process.
The excuse varies from confirmation of the address
or verification of details to a breakdown in a system
and a re-entry of the required details. The link will

be a small and unno-
ticeable alteration

in the URL of the
legitimate site.

Once here, you
will be asked
to enter the
account and

Aditya Madanapalle

Security systems tend to be compromised by
attacks on their weakest points. For an indi-
vidual, security on the computer means a fire-

wall, an antivirus software, and a password
requirement for all critical activities. For a
company, the security setup is far more elaborate,
with some kinds of physical measures on the
doors, multiple passwords on the systems, and
constant monitoring by the system admins. All
these measures are useless if the people within the
system are careless, irresponsible or unaware of
the dangers. Therefore, the most common attacks
are targeted at the people. Social Engineering is an
umbrella term for a variety of methods and tactics
used by cyber criminals to achieve their ends. This
may vary from harvesting databases, stealing
credit card information or simply causing a
nuisance. This breed of cybercriminals exploit
human gullibility, and are analogous to con-artists
in cyberspace. Their methods are constantly chang-
ing, their approach mutating to the requirements

of the job, and sometimes, they just cause trouble
to practice and polish their skills. 

The most common scam is contrary to
common social engineering methods. This

requires no research about the
target, but still has a surpris-

ingly high yield rate. Have
you ever won a lottery

that you never

Social engineering
Watch out for
those millions

of dollars
from Nigeria
waiting for

you...

A forward you should ignore
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The good stuff    Stuff to lust after   Stuff for the well-moneyed

Maal
Drool

iCans Aurum
The iCans Aurum is a set of sound 
isolating headphones from the folks 
at Ultrasone. The headphones may 
look all bling, but are designed to be 
rugged and made with materials that 
are suitable for extensive travelling. 

The propriety s-logic natural surround 
sound technology envelopes the year 

in sound instead of focussing it from 
one point. These set of headphones are 
available for $200 (Rs. 9,742).

Tokyo Flash 
Infection
Who said watches for geeks have to be made 
up of dots and bars? The designers at Tokyo 
Flash have come up with a totally unique 
design. So what if you wont be able to tell the 
time with the Infection, but it sure as hell is 
a conversation starter. Has a leather strap, a 
mirrored mineral crystal lens, 27 tri-coloured 
LEDs and is water resistant upto 3 ATM. The 
watch is available worldwide from the Tokyo 
Flash online store for $105 (Rs. 5,114). 

Bajca Smile Keypad 
The Bajca Smile Keypad is for instant messenger junkies who just 
can’t do with their emoticons. Instead of having to press a series 
of keys, the Bajca keypad allows you to access 16 emoticons with 

the press of a single key. The device interfaces with the computer 
using a USB drive. The keys themselves are detachable, and can 

be strung into jewellery. 

Samsung 256 GB 
Flash Drive
You know you want it. The Industry leader in semi-
conductor technology unveiled a 256 GB flash drive in 
Korea. The drives are meant to be used in laptops and 
pocket PCs. The drives are lightweight (81 grams), and will 
be available in two sizes. They are already going into mass 
production, but at prevalent market rates of $1,000 (Rs. 
48,709) for a 64-GB flash drive, go figure. 

Dunhill Pave Black
What makes the Pave Black stand out from all 
the other crystal studded USB drives floating 
around, is that it actually looks elegant. The 
body is made up of oxidised silver sterling, 
and is embedded with 272 black diamonds. 
The drive can store 8 GB of data, and is 
positioned as a corporate gift on their web 
site. The USB drive can be purchased from a 
Dunhill store or from their online store. 
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Akhilesh Tuteja

Chinese Philosopher Confucius once said,
“And remember, no matter where you go,
there you are.” As humans, cognition of

where we are is one of the most important
aspects of our existence today, possibly just
after knowing who we are. This paradigm is
often portrayed in the behaviour of patients
suffering from amnesia (memory loss) desiring
to establish their identity first and then want-
ing to know about where they are. The answer,
however, has not been very simple and ever

since the Stone Age, humans have always strug-
gled to be able to accurately determine their
position on the earth.

Our assimilation into a global village, and
travel across the universe, has necessiated the
demand for quickly and precisely determining
not only our current position, but also tracking
others in real time. In 1993, with the comple-
tion of the launch of satellites making up the
Global Positioning System (GPS), it is now virtu-
ally impossible to get lost, if you have a mobile
phone with GPRS or a GPS device, that is. 
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tor among other things, the distance a ball has
been hit and the distance to the green.

Recreational activities
Trekkers and hikers use GPS-enabled mobile
phones to create a track log of the hike. GPS has
also given rise to new games such as Geocache,
which combine the physical and virtual worlds.
The game, played across the globe by adventure
seekers equipped with GPS devices involves
locating and hiding containers called
geocaches (water proof containers containing a
logbook, toys and trinkets of low value)
outdoors and sharing experiences online with
the player community. GPS is also finding its
place in fishing activities. Fishing in large
water bodies makes it difficult to keep a track
of the location where success was met. GPS
devices help by marking such locations, allow-
ing you to return to them when required.

What lies ahead
The convergence of GPS with mobile phones
brings additional opportunities for people to use
this data to share their location information with
their friends. The location-based information can
also be published in the individual’s profile on
social networking sites like Facebook and
Linkedin. The same application can also be used
by parents to track their kids on a real-time basis.

The GPS system is a testimonial of how
man’s motivations and desires to probe his own
curiosities have helped him create a technolog-
ical marvel. GPS systems have triggered techno-
logical fantasies around the globe and applica-
tions of this technology appear to be virtually
unlimited. India is slowly beginning to embrace
this technology to answer some of the many
challenges facing a burgeoning population and
we shall soon begin to see the penetration rise.

Convergence of GPS and mobile
phones — going beyond navigation

The initial usage of a GPS-enabled mobile
phone was to simply track one’s location on

a mapping application like Google Maps. Soon
after, came the navigation systems, which
helped users get from one point to another by
assisting them with turn-by-turn driving direc-
tions. Mobile navigation systems are good, but
are limited in their capabilities. Also, the usage
of these applications is quite limited. Since navi-
gation systems are used only when one travels
to unknown places, initial research indicates
that a typical user does not use these systems
more than once in two weeks. Such low usage
may not justify installing a rather heavy appli-
cation just for the purpose of navigation.

The next set of applications for GPS-enabled
mobile phones relies on the fact that people
would like to do much more with the real-time
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A GPS navigation system works by analysing
radio signals received from GPS satellites. A GPS
receiver provides its current location 24x7. GPS
systems were traditionally used as a vital defence
technology and later used for commercial
purposes. In India, GPS technology has been used
for advanced public transport systems. Bangalore
Metropolitan Transport Corporation (BMTC) was
the first to deploy off-line GPS technology on its
vehicles on an experimental basis and after real-
ising the benefits, commissioned a project to
implement real time GPS for its fleet to track and
provide passengers with real time departure and
arrival times of buses.

A similar model is being adopted by private
cab operators. Tracking vehicles through GPS
not only leads to significant savings by
instructing the nearest cab to pick up a
customer, but also adds to customer delight
due to shortened pick-up times.

Companies use GPS for fleet management
broadly to track the exact location of the vehi-
cles during the course of the day, the distance
traveled and the locations visited and any
instances of over speeding. Such systems can
also be utilised by companies to validate the
claims of their sales personnel.

GPS receivers, once the prerogative of
commercial users, are now cheap enough to be
affordable to almost anyone — prices have fallen
to as little as Rs. 2,500.

As GPS gets integrated with basic mobile
phones, its usage in our daily lives will increase
as well.

While a mobile phone has become a basic
necessity these days, and has moved beyond
being just a means of voice communication, a
mobile phone with inbuilt GPS capabilities can
bring unlimited possibilities.

Navigation
GPS navigation systems provide useful informa-
tion about an individual or a vehicle’s current
position, regardless of the vehicle travelling on
road, water or air. Modern day mobile phones
with GPS antennas can work as navi-
gation systems and run mapping soft-
ware that can track the current posi-
tion of the vehicle and provide turn-by-
turn driving instructions as well.
Google Maps, a mapping software that
has gained popularity globally, can be
used to determine the current posi-
tion on a map. Google Maps is a
simple, yet powerful application,
which can work on most mobile
phones and provide precise location (if
the phone has an internal or external
GPS antenna) or approximate location
— if the phone does not have a GPS
antenna. Google Maps also has capa-
bility to provide traffic density infor-

location information available to them. One of
the most fascinating applications shares this
information with a network of trusted friends.
This is known as Buddy Tracking System. A
number of systems are available that help you
share their location information in real time
with their friends. The possibilities multiply
manifold if the location information can be
shared through a number of different media
platforms. Some of the advanced applications
can integrate one’s location information on a
phone, web and other platforms. Therefore, a
user may choose to share his location informa-
tion with all or some of his friends that he or she
is connected to on social networking sites such
as Orkut, Facebook or LinkedIn. 

One such application is Loopt (www.loopt.
com), which enables buddy tracking using a

GPS-enabled mobile
phone and can
publish this infor-
mation across a
range of platforms.
Loopt is a great
b u d d y - t r a c k i n g
system, but it is
linked to the tele-
com operator, which
implies that its
usage is limited to
only those users
whose telecom serv-
ice provider
provides this service.
Unfortunately, this
service is not avail-
able with any tele-
com service provider
in India.

Another interest-
ing application is Whrrl (www.whrrl.com), which
provides buddy tracking service, and in addi-
tion, offers event capture. Essentially, users of
Whirrl can record their comments / feedback
about the place (restaurant, club, etc) they visit,
and these comments will be visible to their

mation (which can help choose an optimal
route) and routing information (turn-by-turn
driving/walking directions). Unfortunately, the
traffic information feed and routing informa-
tion is not available for India, yet. 

There are a number of other alternative
systems, which provide navigation and routing
information. Airtel provides an application
(Wayfinder) for GPS-enabled Blackberry users
(Blackberry 8800, 8310, Bold, etc.), which offers
voice-enabled turn-by-turn routing informa-
tion. The maps for this application have been
provided by MapMyIndia, which has fairly
precise maps and routing information for may
Indian cities. With this application on a
Blackberry handheld, one can get around most
places in India quite easily. The software also
provides route summary, which includes total
distance from start point to destination,
distance left, time taken, etc. The system can
also predict the expected arrival time with
reasonable accuracy. GPS-enabled Nokia phone
users can also use a similar application for
navigation. The other similar systems are
Nav4All, TeleNav, etc.

Geo tagging
Geo tagging is another interesting application,
which extends the capability of a camera or
mobile phone, that has inbuilt GPS. Standard
digital cameras have the capability to tag
pictures with basic information such as date,
time and camera settings. A GPS-enabled
camera (or camera phone) can add location
information as an additional tag to each
picture taken. This tag can describe the exact
location of the picture on our planet. This func-
tionality helps users to keep track of the places
they have visited, without having to manually
enter such information.

Anti-theft devices
Today, several security systems are designed
by embedding GPS units in vehicles. These
units when integrated with automobile secu-
rity systems can notify the vehicle owner by
phone or email if the vehicle security alarms
are triggered, and help in identifying the
exact location of the vehicle. 

Sports
Runners, cyclists and other health conscious
individuals can use GPS-enabled mobile
phones to monitor their speed and distance
covered. The famous French cycling event Tour
de France has riders equipped with GPS devices
that transmit their speed and location at all
times. GPS systems are also used to capture
player work rates and training loads to monitor
and prescribe exercise and recovery routines.
Modern day golf courses also install GPS units
on golf carts, and these are being used to moni-

Google Maps helping you
find your way

Nav4All in action

TeleNav giving you precise
directions

Loopt can tell your friends where you are at any given time

Whrrl can tell your
buddies about that
wonderful restaurant you
visited last night

Wayfinder: the name says
it all
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If GPS is one of the key requirements, it may
be a good idea to consider the following

aspects before choosing a phone.

GPS v/s A-GPS
Standard GPS requires a line of sight connec-
tion with at least three GPS satellites to find
the exact location. Moreover, the satellite feed
should be available for 30 seconds to a couple
of minutes before the GPS can provide exact
coordinates. This can lead to significant prob-
lems if the user is surrounded with tall build-
ings, trees or is indoors. Also, a GPS has to
perform complex mathematical calculations
using triangulation techniques to determine
the position-based on the satellite signals.
Therefore, the start-up time for any GPS-based
application can be frustrating. This problem
can be solved by using an advanced technology
called A-GPS or Assisted GPS. In the case of A-
GPS, the GPS unit contacts an intermediary
called assistance server, which helps determine
the location of the device much faster. The
assistance server can use the cell-phone tower
information to start the computation process
and also performs complex mathe-
matical computations on a much
faster processor. This provides follow-
ing benefits:
n Device location is determined much

faster 
n Location can be acquired even when

there is no continuous satellite
signal available

n Device has to perform less computa-
tion leading to less battery consump-
tion

These features result in great bene-
fits to cell phone GPS systems where
battery conservation is an important
consideration and one may have to use
a navigation system even while talk-
ing on phone.

However, A-GPS requires an active
data connection and if one is not on
an unlimited data plan, its usage can
lead to increased phone bills.

Display
Since GPS-enabled phones will be
invariably used for navigation assis-
tance, it’s important that the screen
size is reasonably large to enable easy

viewing of maps and driving directions. Higher
screen resolution can add to enhanced experi-
ence. Hence, compare the display resolution
before finalising your phone. Another good
feature to look for should be ambient light
adjustment. Many cell phone displays can
increase or decrease display brightness depend-
ing on ambient lighting conditions. This is very
useful when one is walking in bright sunny
outdoors.

Mounting
If the objective is to make your phone double
up as vehicle navigation system, it will be a
good idea to buy a phone, which comes with
accessories to mount it on a flat surface. This
can be very handy if you use it in your car. One
should avoid flip-phones because they are not
very useful when it comes to using them as
navigation systems.

Battery
Needless to say, GPS antennas and overlaid
applications can be a big drain on battery. It
will be good to have your phone with enough

battery when you need to make that
late evening emergency call. Phones
with external charging accessories
can be a better deal.

Memory
Many GPS applications will require
on-device storage of static or cache
data. The bigger the storage, the
better it is. Most devices provide an
option to enhance memory
through add-on media cards.
However, a device with in-built
memory may offer faster response
compared to the one using external
storage.

Speaker
Most navigation applications offer
voice prompts for driving directions.
The louder the phone speaker, the
easier it is to follow the instructions.
There is no easy measure to compare
speaker quality, but phones with
dual speakers offer better capability.
It may be a good idea to try the
speaker out before buying an expen-
sive phone.
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friends. This allows friends in the network to
share information easily. Whrrl also integrates
with Twitter, a social networking platform for
people to communicate with their friends. One
key limitation of Whirrl is that it works only on
GPS-enabled mobile phones.

Whereabouts is a similar application, which
was primarily targetted at family members who
need to track each other. Worrying parents can
track the location of their kids on a real-time
basis. Whereabouts also provides integration
with Facebook, making it an extended social
networking system.

Micro BTS (www.microtechnologies.net) is a
buddy tracking system offered by Micro
Technologies in India. The system is fairly
simple to use, but is not free.

An upcoming system, known as Trackut
(www.trackut.com) takes these applications to
newer dimensions. Trackut offers all the
options of a buddy-tracking system not only on
GPS-enabled mobile phones, but it works on
non-GPS phones also. Moreover, Trackut is an
operator-independent service, which makes it
versatile, and it can be used virtually anywhere
in the world. Fundamentally, Trackut is a loca-
tion-based information streaming system,
which can help users create location-oriented
groups and share information with friends. 

In addition to offering basic buddy tracking
service, Trackut provides multi-channel loca-
tion-based streaming. A Trackut user can record
any event, describe it, tag it and share it with
friends. The event capture can be real-time,
using the phone to record and share it with the
network. The captured story could be about a
restaurant you liked, a party where you had fun,
or could be temporal such as a traffic jam you
are stuck in. Trackut manages these and streams
them to the right audience when they are near
the locations where these events occurred.

Such an application opens up possibilities
to do many things on a convergent platform.
When a movie feed is converged with such
application, you can drive into any area and
find out which one of the closest cinema hall is
running a movie of your choice. An alumni
group may choose to join the network and the
members can share their office and home loca-
tions with peers. 

The possibilities are endless. However,
Trackut is in evolution process and the inter-
face needs some upgrade. It’s a promising
application and should mature soon.

An application of special interest is got-2
Task Management (www.gwhizmobile.com). This
application takes simple electronic task lists to
the next level. A traditional task list uses date
and time as an event to trigger an alert, whereas
got-2 Task Management adds a new dimension
(location) to trigger an alert. The way it works is
that whenever you create a task, in addition to

entering the due date/time, you also specify the
location, where the task can be performed. For
example, if you add a task for dry-cleaning, you
also provide the address for the dry-cleaner.
Whenever, you drive into the same areas as the
dry-cleaner, an alert for this task will come up
on your phone screen. The best part is, got-2 Task
Management integrates with Microsoft Outlook
and Google Calendar, making it simple to
synchronise with your usual task list.

While these platforms open up new possi-
bilities of information exchange, they also
bring about significant risks and challenges.

For example, the buddy tracking systems are
considered a serious privacy invader, limiting
its use to close family members only. Although
most applications allow you to enable or
disable location sharing, it can be cumbersome
to manage it. Another drawback is that these
systems eat a lot of battery power since they
would require the GPS antenna to remain
switched on whenever you use them. The
battery consumption increases if you are inside
a building or around tall buildings. The third
big disadvantage is the cost of data transfer.
Since all these systems use GPRS or an equiva-
lent method to communicate, there is a signif-
icant flow of data from the mobile phone. If
one is not on an unlimited data plan, these
systems can punch a big hole in your pocket.

All said and done, these are great tools and
can make your phone do multiple things. The
advice is to use them cautiously, keep a charger
handy and switch to an unlimited data plan
before you start using them!

The author is the Head of India IT Advisory Practice at
KPMG. A technology enthusiast himself, he enjoys

experimenting with the latest gadgets and technology.

got-2 Task Management

GPS-enabled phone
Buying tips



Rossi Fernandes

We’ve only heard about 
GPS devices on the 
Internet and in the 

news, but we’ve never really 
looked at any products as such. 
People have little knowledge 
about GPS and how useful these 
units can be. It’s assumed that 
the real use of GPS is only for 
those into aviation, marine and 
science related work. The other 
major misconception is that GPS 
equipment is extremely expen-
sive, and to use it means that 
you require some sort of formal 
training or the other.

There are some other miscon-
ceptions that must be cleared 
before we proceed. You do not 
need GPRS to use a GPS unit nor 
is there a monthly or yearly fee 
to be paid to avail of GPS ser-
vices. It’s a one time fee covered 
when you purchase the device. 
GPS devices calculate and pin-
point your location using data 
from satellites and then put it 
on a map. Dedicated GPS devices 
come with maps and software 
preloaded on the device. Mobile 
phones that have GPS features 
don’t come with such maps in 
most cases. These maps require 
loads of space and a good bit 
of processing power. Instead, 
those GPS software available for 
mobile phones download maps 
of the region you are in using 
GPRS. This is the only relation 
there is. All the products we’ve 
tested come with the software 
and maps inbuilt and require no 
external connections to down-
load additional maps. We also 
reviewed some GPS receivers that 
connect to laptops and mobile 
phones, but they need separate 
software to operate. 

We decided to see to see if 
we could get our hands on some 
GPS devices available in the 
market and we managed to get 
in products from MapmyIndia, 
Satguide and also some Garmin 

products from GPS India. This is 
the first time we’ve got in GPS 
devices and we decided to focus 
our attention on products that 
would best suit you, the end user. 
This category of products covers 
user friendly devices that anyone 
can use while travelling from one 
place to another. The whole point 
of using a GPS device is to make 
sure that you are never really 
lost – in fact once you use them, 
you know where you are at any 
given time of the day, anywhere 
in the world. Obviously this kind 
of information is much more 
important for specialised tasks. 
Fishermen, explorers and hikers 
will find GPS devices much more 
useful. Navigating through the 
urban landscape these days is no 
less of a challenge either.

What we looked for
This being one of the first tests of 
this kind for us, we looked mostly 
at the features in this mini-com-
parison of devices. Like any other 
human interfacing device, we 
looked for quality of the screens, 
the design for both the hard-
ware and also the software inter-
face. We look at how good the 
interface design was, and how 
simple it was to use. We tried 
adding a source and a destina-
tion point by searching through 

the database and also using a 
direct pointing selection mode 
and looked at what kind of route 
the device would offer. Nobody 
wants a device that requires you 
to read a manual to tell you how 
to go from one point to another. 
We also looked for what kind of 
addons came along with the unit 
to attach to your car. 

We looked at how easy it was 
enter in key points and routes. 
Some of the devices even came 
with a simulation mode which 
allows users to run through a 
demonstration of the entire route 
in advance. Some GPS devices 
even allow you to avoid certain 
roads while some others allow 
you to divert through another 
route. All the devices we reviewed 
ran on some kind of mobile soft-
ware platform or the other. When 
you have some kind of process-
ing power bundled with a touch-
screen, there’s bound to be some 
entertainment as well. So, we 
looked at some of the extra soft-
ware features such as image view-
ing, movie and audio playback.

MapmyIndia A-MAX 
06GP5A

One of the two MapmyIndia 
GPS devices received was 

the A-MAX 06GP5A. The device is 

meant to be used in a vehicle 
and comes with maps built into 
it. The device itself is compact 
and simple looking. The 3.5-inch 
screen on it isn’t especially great 
but it gets the job done. Being 
designed for the car, the box 
pack comes with the necessary 
attachments to fit it on to the 
windshield of your car, for exam-
ple. The touch interface is OK, 
and is not incredibly reactive. 
Scrolling around the map itself 
is a little difficult. The device 
has no buttons and is completely 
touch-operated.

The device makes use of a 
SD card slot to read maps. This 
is something seen across all the 
brands. The devices might be 
different but they all run the 
same kind of maps. The inter-
face is slightly dull with a plain 
Windows XP-like theme running 
on it. The menu bars and the rest 
seem a little too thick and so 
occupy a lot of useful real estate 
on a screen this small. Charging 
is done through a mini-USB port 
and a separate 3.5 mm audio jack 
is also present if you want to hook 
up the unit to the car speakers or 
your pair of headphones.

The features on it are pretty 
impressive in general. The route 
and the maps on the device can 
be viewed in three different ways  
– the top-down view, the chase 
view and the last one which has 
both the views side by side. The 
maps are well detailed across the 
major cities and national high-
ways are clearly mapped. This 
will be useful while you drive 
from one city to another.

The trip computer which rep-
resents a typical speedometer on 
a car is also present. Although 
not as fancy as some of the other 
models we’ve looked, the A-MAX 
06GP5A shows your speed — the 
average as well as the maximum 
speed attained during your trip. A 
voice guidance system constantly 
announces and updates you of 
upcoming turns, and the dis-
tance to the turn. The voice qual-
ity is OK, but is loud enough for a 
car with the windows closed.

The GPS can be used for other 
tasks as well. The unit lets you 
play music, movies and even 

view pho-
tos on it. In 
some ways, 
it’s a bit of 
an enter-
ta inment 
system for 
passengers 
sitting in 
the front. 

T h e 
speed of 
l o a d i n g 
maps and 
z o o m i n g 
into them 
is a little 
s l o w e r 
than some 
of the other GPS units. This also 
happens to be one of the mod-
els that MapmyIndia plans on 
phasing out very soon. If you’re 
looking for a cheap GPS unit 
for your car, this is one to con-
sider. It should be priced around 
Rs. 18,000. MapmyIndia is bring-
ing newer models which offer 
Bluetooth functionality to con-
nect to your phone, and should 
be out soon..

MapmyIndia 430 
Classic Navigator

The MapmyIndia 430 Classic 
Navigator is one of the newer 

models to come into the market. 
Unlike the A-MAX 06GP5A, this 
one comes with a 4.3-inch screen 
which also supports a higher res-
olution of 480 x 270. The touch-
screen is a little more reactive 
and the quality of the display is 
considerably better too. The hard-
ware also comes with a newer 
version of the software than that 
on the A-MAX device. 

The interface is one of the big-
gest improvements you’ll notice 
in the 430 Classic. The theme 
used looks a bit like Windows 
Vista. The excessive animations 
are unnecessary, but the rest of 
the interface is made very profes-
sionally. The colours are bright, 
and give the device a very user-
friendly look.

The volume control is placed 
on the side of the device. Like 
some of the other improvements 
over the other model, the 430 

Classic too has a better speaker 
built into it. The On/Off button 
is a small switch placed at the 
bottom of the GPS. 

The device also shows a graph 
of the speed and altitude over 
the trip. There are some features 
where you can choose road types 
that you want to avoid. The soft-
ware automatically sets an alter-
nate route. Like other GPS sys-
tems, you can look for hotels and 
other places of interest along the 
way. The manoeuvre route mode 
gives a list of turns along that 
route you’ve chosen. The device 
can also keep tracks of logs and 
journeys you’ve done which is 
useful for future reference. 

The 430 Classic can also play 
media like the A-MAX 06GP5A. 
It supports AVI files, and the 
feature works rather well. The 
screen quality itself is average, 
so watching videos on them, 
although practical, isn’t as 
much fun as a dedicated PMP. 
Image viewing also isn’t great. 
This device is good for its perfor-
mance, and the quality of speak-
ers. It comes with a price tag 
of Rs 22,990 which might seem 
like lot money, but there’s still 
decent value here. 

GPS India 
Garmin Nuvi 350

Garmin is a well reputed 
name in the industry and 

the Nuvi 350 is first of the two 
devices from this brand that we 
reviewed. This is another dedicat-

Now, get-
ting lost 
is also a 

thing of the 
past...
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MapmyIndia 430 
Classic Navigator

MapmyIndia A-
MAX 06GP5A
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ed GPS system like the ones from 
MapmyIndia and Satguide. 

The device is small and com-
pact like the MapmyIndia A-MAX 
06GP5A. The advantage of using 
products this small is that you 
have the option of carrying it 
around in your pant pocket or 
pouch when you step out of 
your vehicle or go an off-track 
outdoor trip. The screen qual-
ity is also very identical to the 
A-MAX 06GP5A. The Nuvi 350 is 
one of the few devices to come 
with a foldable antenna. There’s 
also provision for an extendible 
antenna for better performance.

When you first power it on, 
the welcome menu lets you 
down with an underwhelming 
three-option menu. It’s only later 
that you discover that the soft-
ware interface on the Garmin is 
actually made to be clean and 
organized. There is use of sober 
colours all throughout the soft-
ware. Even the maps follow a 
similar theme. This combina-
tion is truly unique and will suit 
many users. When day turns to 
night, the Nuvi 350 can be set 
to switch a night mode which 
changes the colour scheme to 
be more of a contrasted darker 
interface. There is a very simple 
menu to look for places of inter-
ests such as dining places, fuel 
stations and so on. The artwork 
used for the selection is very 
nice done. While going through 
its entire feature set, the great 
performance of the interface is 
easy to notice. 

The trip computer 
is simpler looking but 
it has all current live 
information updated 
on it. It gives you 
information about the 
moving time, the time 
you’ve stopped, your 
average speed and so 
on. This device is all 
about the function 
and less about the pre-
sentation and style.

The Garmin Nuvi 
350 even has an 
optional addon for 
the traffic receiver. 
The software interface 
has an option which 

can be enabled only if you have 
this module. The feature lets you 
know of traffic reports and infor-
mation on it on the Nuvi 350. 
Unfortunately, this unique little 
feature is subscription based and 
more importantly not available 
in India at the moment.

If you’re looking for some 
kind of entertainment from 
your GPS system, then the Nuvi 
350 will in no way disappoint. 
There is a media player for music 
playback, an image viewer and 
even an audiobook reader – all 
the things that your passengers 
will find interesting. The nifty 
bit of software is the language 
translator that gives voice results 
in different languages. You can 
then travel to other countries 
and still be able to have basic 
communication with the people 
of the region. There is also a cur-

rency calculator, a measurement 
convertor and even a world clock 
that keeps track of time in differ-
ent places. 

Garmin’s experience in GPS 
devices is clearly visible in the 
case of the Nuvi 350. This is one 
of the best GPS devices we’ve 
seen. At Rs 27,300 without taxes, 
it also happens to be the costliest 
one. Although the higher price is 
hard to justify, it’s a great buy for 
those without budgets. 

Satguide Mio C230

The Mio C230 is supplied and 
distributed by Satguide under 

their branding here in India  — 
with their software and maps 
of course. The Mio C230 has a 
decent 3.5-inch screen that oper-
ates at a resolution of 320 x 240. 
The screen is more or less the 
typical size of Windows Mobile 
phones and PDAs. It’s a com-
pact device with lots of round-
ed edges. Again, this is another 
device that can be carried away 
with you when you leave the car.

The touch screen is both 
accurate and functions well with 
the interface. The performance 
of the C230 isn’t as good as the 
Nuvi. There is some amount of 
delay while operating the device 
and while loading maps of dif-
ferent regions when you scroll. 
We also had some stability 
issues when we accessed some 
features. The application would 
randomly crash and the device 
had to be restarted. This could 

have been an issue with the 
device we received.

The maps are detailed 
but this can get crowded, 
especially when you zoom 
out a bit. The maps even 
have names of many build-
ings and this part of the 
reason why the interface 
can be so flooded with 
information. Operating 
the software is simple and 
straight-forward. The only 
thing that bothers us is 
the colours and look of the 
interface. Although simple, 
it’s doesn’t look as smooth 
or refined when compared 
to the other interface on the 

other devices. The windshield 
mounting mechanism is really 
sturdy and works very well. It is 
also flexible with its joints and 
allows you to mount the unit in 
in a variety of ways.

The PMP feature of the device 
is really impressive. The player 
has a proper playlist and even 
seeking features. The speaker is 
also pretty good so as a whole, 
for music playback this is a very 
good device to own. Even though 
it’s not the perfect GPS, it is 
incredibly cheap in comparison 
to the other devices of its kind. 
The price of Rs 16,000 is truly 
impressive and makes the device 
a very good value-for-money 
purchase.

Satguide Mio P360

When you first look at the 
Satguide Mio P360, it 

looks like a slightly oversized 
PDA or a touch screen phone 
with a 3.5-inch screen. The exter-
nal looks are quite impressive 
as well. It’s also built very well. 
You could call this a handheld 
GPS device but you might find 
it difficult to fit into your shirt 
pocket very easily. The device 
runs Windows Mobile 6 and like 
any other PDA boots up into the 
operating system. 

It comes installed with the 
Satguide application which 
needs to be run by going into the 
Programs menu on the device. 
The application that loads is 
identical to the one used on the 
other device we received from 
Satguide – the Mio C230. In com-
parison, the same software runs 
really horribly on the P360. It 
has none of the crashing issues 
but it performs really poorly. The 
device by itself runs rather well 
and even better than some of 
the other phones and PDAs we’ve 
used.

The software, like on the 
C230, isn’t the nicest looking 
one. The interface is simple but 
colours used are too gaudy. The 
touch screen is not as sensi-
tive and controlling the device 
is quite troublesome. The maps 
and the rest of the software are 
exactly the same as the C230. 

The speaker on the P360 is 
exceptionally good. It is loud and 
crystal clear. It comes with a 
2.5mm jack which means you will 
need some kind of a convertor to 
connect conventional earphones 
to it. A connector for an external 
antenna is also available. 

Even though we aren’t 
impressed by the P360 for its 
GPS features, you must remem-
ber that you get a good fully 
functional PDA for the money 
you spend on it. You can run any 
Windows Mobile application on 
it. At that, it will undoubtedly 
excel. The price for the P360 is 
Rs 19,490 which is still asking a 
lot in our opinion. For those who 
want just the GPS functionality, 
the Mio C230 is the better of the 
two Mio devices. 

GPS Bluetooth Receivers  

One of the cheapest and sim-
plest ways to use a GPS is 

with your phone, PDA or laptop. 
All you need then is what is com-
monly referred to as a GPS receiv-
er. These are cheaper than dedi-
cated GPS units and the choice 
of software that you want to use 
with it is left to you. Along with 
the completely ready GPS units, 
we received three GPS receivers 
and we had to give him a run 
to see how they ran. Most of the 
GPS receivers you get today con-

Garmin Nuvi 350

Satguide 
Mio  C230

Garmin Mobile 10
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nect wirelessly using Bluetooth 
connectivity. 

Of the three, the Garmin 
Mobile 10 was the best look-
ing of the lot but the Satguide 
GPS Bluetooth Receiver was 
slightly more compact. There 
really isn’t a big difference in 
functionality between these 
two devices. They both have 
a simple on/off switch which 
turns on the device. All you 
really need to do is turn on 
the Bluetooth on your laptop 
or phone, scan for Bluetooth 
devices and then add the GPS 
unit. You can then choose to 
use any software and the maps 
for it on your phone. 

We used the devices with a 
laptop and a Windows Mobile 
without any problems. Setting 
up was pretty straight forward 
and with the serial link via 
Bluetooth set up, we were able 
to able to use the receivers along 
with some of the software for 
Windows Mobile.

The price for the Garmin 
Mobile 10 is Rs 11,025 and 
Rs 4,290 for the Satguide GPS 
Bluetooth Receiver. The Garmin 
Mobile 10 is a lot more expensive 
but the price tag isn’t totally 
justified. It comes with software 
for the desktop and the Windows 
Mobile platform – nRoute and 
Garmin Mobile XT.

For those who want some-
thing a little different – some-
thing that can monitor your 
tracks for you, there is a device 
by Satguide called the GPS 
Logger which we reviewed a few 
months back. This device too 
has the same Bluetooth func-
tionality as the GPS Receiver 
from Satguide but it does the 
additional task of storing data 
on the memory. Once you’ve 
completed your trip, you can 
attach it to a computer and 
download all the data which 
can be used on software such as 
Google Earth with the least bit 

of effort. This is useful where 
you want to monitor the routes 
through which your vehicles 
travel by. The Satguide GPS 
Logger is priced at Rs 6,990 
which is a fairly good price and 
it removes the need for a sepa-
rate device of either a phone or 
computer to store data on it.

Conclusion
We’ve been pleasantly sur-
prised to see the number of 
GPS systems available and the 
number steadily growing for 
the consumer market. We were 
impressed by the details on the 
maps. Getting this amount of 
data collected, sorted and put 
into maps has required an enor-
mous amount of effort. Work 
is still on and updates are still 
regularly available to improve 
maps by all of the brands.

Now coming to what we 
think of the products, we like 
the Garmin Nuvi 350 the most 
for its very elegant design and 
feel. The new MapmyIndia 430 
Classic is larger than the rest 
but has a stylish and modern 
look to it. The maps on it 
were equally detailed as well. 
If you have the choice between 
the two, we’d recommend you 
go for the Nuvi 350 but the 
MapmyIndia 430 Classic would 
be the best if there was a bud-
get constraint. The Satguide 
Mio C230 is the cheapest of 
the lot but we aren’t so fond of 
their interface. For all practi-
cal uses and for those who just 
want a GPS system for their 
car for as cheap as possible, 
that is the way to go. Among 
the Bluetooth receivers, we 
like the Satguide GPS Receiver 
mainly for its price. As for 
those want to log data of your 
travel routes, the Satguide GPS 
Logger is the only option you 
have. It’s a bit more expensive 
than the receiver but it’s well 
worth the price.

We like the idea of Bluetooth 
receivers as they give the user 
the flexibility and choice of the 
maps and the software that you 
use. Phones with Bluetooth con-
nectivity are something that 
everybody has these days. Our 
only concern is that mobile 
phones drain down their bat-
tery too quickly with Bluetooth 
left on. In most phones, it’s pos-
sible to drain the battery within 
five hours of using it. This still 
is a great way to experience how 
to use a GPS.

Windows Mobile is also the 
preferred platform and there 
are plenty of commercial and 
free open source software being 
developed for it on communi-
ties on the Internet. There are 
applications for Symbian as 
well but Windows Mobile seems 
to be the more preferred one 
for GPS. Google Earth Plus is 
one of simplest software for 
those who want to use it with 
their laptops while sitting in a 
car or travelling by a long dis-
tance train. 

The whole idea of being to 
track where you go and then 
revisit it online or show oth-
ers the way to reach places 
is great.. We like the idea of 
using GPS units for everyday 
use and will definitely be look-
ing at more GPS systems in the 
future. n

rossi.fernandes@thinkdigit.com

Satguide GPS Receiver

 Contact Sheet                   GPS Devices

Brand Contact Phone E-mail Web site

SatNav Technologies SatNav Technologies 040 - 66827333 Extn: 342/348 satguide@satnavtech.com www.satguide.in

MapmyIndia CE Infosystems Pvt. Ltd 9867979376 - www.mapmyindia.com

GPS India Aerial Services Pvt Ltd 022 - 26156707 asplgps@vsnl.net www.asplindia.net



One of the key attractions
this month had to be

the Nikon D90, which is also
the costliest camera we’ve
tested so far. Nikon has
brought in the D90 to
replace the trusted D80. The
D80 was one of the best
upper-entry level to mid-
range cameras from Nikon.
The D90 then has a lot to
prove before it can earn its
place.

Going through the
D90’s key features, it cer-
tainly looks impressive. The

D90 utilises a 12.3-MP
CMOS sensor going up from
the D80’s 10.2-MP CCD sen-
sor. The sensor size remains
unchanged. Most entry-level
cameras are supplied with
an 18 to 55-mm lens which
can be quite limiting to the
kinds of photos you can
take. We received the cam-
era with a Nikkor DX 18 to
105-mm VR zoom lens. This
makes a good all-purpose
kit for wide-angle and tele-
scopic shooting.

The shape and size of
the D90 is somewhat larger
than the D60 we saw a few
months back. It’s a bit heav-
ier than the D60 and also
the D80 itself. The body is
plasticy, but feels extremely
sturdy and the buttons are
great as expected on any
Nikon D-SLR. 

The D90 now comes
with a 3-inch screen that is
incredibly vibrant and
crisp. The other thing that
makes the camera interest-
ing is the inclusion of Live

View that allows you to use
the LCD screen to focus.
This is a feature rarely
found on D-SLRs. 

The D90 is undoubtedly
one of the easiest cameras
to operate, if you have that
a basic knowledge of using
a decent point-and-shoot
camera. All the functions of
the camera such as ISO,
white balance, exposure
metering and focusing
modes can be accessed by
holding down the respec-

tive buttons and rotating
the jog dial. Shutter speed
and aperture size have dedi-
cated dials.

It’s very difficult to criti-
cise the D90 on quality as
well. The 12.3-MP CMOS sen-
sor does its job well. Photos
turn out crisp across the
entire aperture range. The
lens isn’t made for macro
photography, so you’ll have
difficulty with up-close
shots. Mind you, great
close-ups can be shot by
moving back and zooming
into the target. Good depth
of field can be achieved eas-
ily too. The flash is power-
ful and good enough for
indoor photography every
now and then.

The Auto mode works
well along with the auto-
focus feature. Focusing is
instantaneous and there is
no delay whatsoever. There
are a few autofocus hiccups
every now and then, but
nothing that can’t be fixed
using the other auto-focus-
ing bracket modes. As
expected from any D-SLR,
the manual mode gives you
total control of the camera.
You won’t be disappointed
with the D90, if you like to
select a scenario preset
either — a dial for doing
that is present.

Another new feature
hardly ever seen on D-SLRs
is video recording. The D90
can capture up to 1280x720
resolution videos at 24
frames per second. What
makes it even more special
is that you can zoom and
focus manually while shoot-
ing videos. The video quali-
ty is great and the frame
rate quite stable but you
will need to buy a fast
SD/SDHC card for it.

We’d be lying if we said
that we weren’t impressed
with the D90. It’s filled

with surprises. The camera
is incredibly simple to use,
it has the performance, the
features and is undoubted-
ly miles ahead of the D80
in every aspect. Nikon has
yet another winner on its
hands and we highly rec-
ommend this if you have a
serious interest in photog-
raphy and also the money.
The D90 along with its lens
is priced at a whopping Rs.
89,890. The body by itself
can be bought for Rs.
69,950. This makes the D90
almost as costly as the
D300. It makes better sense
if you spend more and go
for the D300 instead.
Nikon’s lens are known to
be cheaper than some
other brands, so buying
just a body and then a
good lens can also be a
good move. If you don’t
need the Live View or the
video recording or even the
small changes Nikon has
made, then the older D80
is a better buy, especially
with its more wallet-friend-
ly price.

Specifications
12.3 MP CMOS sensor, ISO
Range: 200 - 3200, Shutter
speed range: 1/4000th to 30
seconds, Nikkon DX 18-105mm
VR lens, 3-inch screen,
SD/SDHC complaint, Video
recording up to 1280x720 
pixels.

Contact: Nikon India Pvt Ltd
Phone No: 022-40925555
Website: www.nikon.co.in
Price: Rs 89,890 (with 18-100mm
VR lens)
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Sony Ericsson has been
naming its phones by

their features, like the
Cybershot or the Walkman
range. They’ve just intro-
duced the newest model —
the W595, so let’s take a
look at it.

The W595 has a nice
metallic steel border which
gives it an oh-so-sleek look.
There are stereo speakers at
the top and bottom of the
phone. The connection for
USB and headphones for
the phone is on the left,
while the volume and the
‘walkman’ button is on the
right. The phone feels pret-
ty sturdy, but let’s see if it
really is.

Each of the buttons has a
subtle, yet noticeable out-
line of a reflective turquoise
blue colour. The distance
between the buttons are

enough to get
used to, but you
need to put in a
little effort into
pushing the but-
tons to use the
phone. Opening
the back was a lit-
tle troublesome
with it refusing
to come off easi-
ly. 

This phone
has features like YouTube
streaming, RSS feed reader,
Opera browser, but sadly no
WiFi. Even so it has WAP,
GPRS and EDGE support. 

Many of the applications
use the shake feature as an
accelerometer. There is a bob-
ble head wallpaper which on
swaying the phone, moves in
the opposite direction while
bobbing. There is also an
application called Walk

Mate, which is
good for the fit-
ness fanatics out
there. The sound
quality on the
headphones is
better than the
speaker. The call
quality is pretty
decent and we
had no issues
with the recep-
tion.

H o w e v e r ,
there are a few
drawbacks. The
USB cable is too

short and there is no 3.5-
mm headphone jack. The
shake-it features for switch-
ing between songs works
fine, but the volume control
seems a tad too sensitive.
The slider is not very sturdy.
We noticed there was a light
at the corner of the keypad
for illumination. It however,
did not serve its purpose.
Not all the buttons were
illuminated. 

We would not recom-
mend that you buy this
phone as it has some flaws
that need to be corrected.

Specifications
Size: 1.9 x 3.9 x 0.6 inches,
Weight: 104 g, Screen: 262k
Colour QVGA, Resolution:
320x240, Memory: 40MB
phone memory, expandable up
to 8GB, Other: Bluetooth, WAP,
GPRS, Wi-Fi, RSS reader,
YouTube streaming

Contact: Sony Ericsson Mobile
Communications India Pvt Ltd
Phone: 1800-11-1800 
Email: questions.in@
support.sonyericsson.com
Website: www.sonyericsson.com
Price: Rs 14,695

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS

Nikon D90 
Expensive, but hard to resist!

Sony Ericsson W595
Shake that phone

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS

The Billion BiGuard 30 is a
switch that is meant to be

used a security gateway. In
comparison to some of the
other network devices we’ve
seen, this one is one of the
nicer looking products. The
front has status indication
LEDs for all the eight LAN
ports and another two for the
WAN ports, all mounted on a
glossy black surface. The rest
of the body has a powder-
coated paint finish.

The interface is simple to
use, but isn’t as colourful

and user-friendly as some
home routers available
today. The switch lets you
connect to two external net-
works and data can be rout-
ed through them. This fea-
ture also allows load balanc-
ing between two connec-
tions. This is something very
useful in SoHo scenarios.
Setting up a WAN connec-
tion is easy and can be done
using fixed IP addresses,
PPPoE or two other methods. 

Security is also taken
care of with this device.

There are port blocking fea-
tures put in place, and data
can be monitored and
blocked accurately. Web
pages with some keywords
can also be blocked. Virtual
Private Networks can also be
set up using this router.
Intrusion detection mecha-
nisms are present and logs
for all kinds of events are
maintained by the router.
The router can be set up to
send alerts by email. Using
Dynamic DNS, the router
can easily be accessed
remotely. 

The Billion makes per-
fect sense for SoHo users
who have a small network.
There are plenty of security
features and the firmware
allows very precise and accu-
rate permissions and rules
to be set. It is also the type

of switch and router that
can be managed remotely. 

At Rs 16,500, it’s not
very expensive for a SoHo
especially for the function it
performs.

Specifications
Two Ethernet WAN ports, eight
Ethernet LAN ports,
Dimensions: 482 x 166 x 42 mm

Contact: One Network (India)
Pvt. Ltd
Phone: 9821014253
Email: deepak@onenetwork.co.in
Website: www.billion.com
Price: Rs 16,500 

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS

Billion BiGuard 30
Guarding  your networks
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Having an MFD
(Multifunctional

Device) for home use is a
pretty good option as it
saves space, rather than hav-
ing many devices and also
comes in handy when you
need immediate copies of
something or the other.
Canon products vary from
consumer to business use
and ranges from simple
printers to multifunctional
all-in-one printers, which
can print, scan, copy and
even fax. The Canon Pixma
MP198 is one of the new
additions to Canon’s range
of inkjet multifunctional
printers which can print,
scan and copy, but lacks the
fax feature and is targeted
at home users.

The MP198 has a matt
finish to it and is slightly
on the bulky side with its
dimensions being 17.7(W) x
13.9(D) x 6.7(H) inches.
Installing the print car-
tridges is easy as there is a
big poster along with the
printer that gives you step-
by-step visual instructions
on the basics for starting
out with the printer. There

are two flaps that need to
be opened — one behind for
loading the paper, and one
in front for the paper out.
The back loading extends
quite a bit too. The scanner
lid does not have the fea-
ture to extend, to allow big
books to be scanned. 

The buttons of the print-
er are on the right side with
a single alpha-numeric dis-
play. You can set the num-
ber of copies from one to
nine, or set it at a maxi-
mum of 20, which is repre-
sented by ‘F’ displayed if
you try to go above nine. 

We tested the speed at
which this printer can print
a simple text document and
a document with colour at
the settings of economy and
standard. The results
obtained showed there was
a time difference of about
1.5 seconds between eco-
nomical and standard
prints for a full-page Word
document. Even though
there wasn’t much of a dif-
ference in the times, the
standard print setting
looked much better in
terms of smoothness and

also had a darker black to it.
The coloured test page used
printed on both settings
had a 13.3 seconds differ-
ence in print times. There
was also significant quality
difference visible between
the two. The economic print
had a very grainy and pixe-
lated picture quality. We did
notice that in the printouts,
in one of the images the yel-
low was pulling into the
magenta a bit. 

We also tested the print-
ing of a high-resolution test
photo on photo paper,
which took a total of 4 min-
utes and 18 seconds. The
result was a fairly good
quality which did show
some increase in the shad-
ows. Scanning of a photo
took 28.6 secs, but did not
look too good. Colours were
washed out and we also
noticed some grainy pixela-

tion through-
out the image.

Even
though this
MFD is on the
bulkier side,
being priced at
only Rs. 4,595
is quite a steal
for home users
not wanting to

spend a lot on printers. It
does lack a few features like
USB plug-in, fax and is not
one of the best printers in
terms of colour quality, but
as it is user friendly and
does not cost much, it is a
good buy.

Specifications
Dimensions - 17.7 x 13.9 x 6.7
inches, Print resolution:  4800
x 1200 pixels, prints up to 8
inches and 8.5 inches 

Contact: Canon India Pvt Ltd
Phone No: 1800-180-33-66
Email: info@canon.co.in
Website: www.Canon.co.in
Price: 4,595

Thermaltake is a well
known name in the

world of gaming peripherals,
from PSUs to PC cabinets.
The Xaser VI is a full tower
chassis meant solely for hard
core gaming enthusiasts.

The Xaser VI is a black
and red tower with metal
dust filters on both sides to
give a transparent look and
feel. The material used is
sturdy and the thickness of
the metal is pretty much
adequate. It’s not as impres-
sive as the Cooler Master
Stacker or the Cosmos. 

The I/O panel has space
for two e-SATA ports, four
USB ports, a FireWire and
an audio in/out. Though
this case carries so much,
the cover for the panel was
quite weak and the clips
holding it looked like it
was not going to last very
long. The power button is
shaped as an ‘X,’ which

looked stylish but is not
made of the best quality.
The reset button is tiny and
a bit hard to push. 

Some of the thumb-
screws at the back are inac-
cessible and need to be
opened with a screw driver.
Putting them back needs
patience as well.

The case has three fans,
and the one on top is
blocked by the ceiling of the
case. On looking further
into the top, we found that
the top panel can be moved
a bit towards the back giv-
ing the fan a bit more space
to blow air, but that leaves a
large section of the plate
hanging out over the back
of the case.

The power supply is
mounted on top and a sup-
port beam is present to bear
some of the weight. The
support beam can be adjust-
ed as well. There are HDD

cages which can be
locked easily as well
as drive bays having

slide-in locks. There
is also an extra draw-
er bay, which you can
attach and use as
CD/DVD storage if
needed.

This case is pretty
big and aimed at
enthusiasts. The fan
cables are coated
with rubber. SATA
cables and loads of
extras such as zip
ties are thrown in for
cable management. There
are plenty of empty open
spaces in the cabinet, so
expect dusting the insides
every now and then. For the
price of Rs. 13,500, it’s over-
priced and not totally worth
the money you pay.

Specifications
Dimensions: 23.8 x 9.8 x 26.0
inch, Drive Bay : 7, 10 Expansion
slots, Front I/O: e-SATA connec-
tor x 2, USB2.0 x 4, IEEE 1394

Firewire x 1, HD Audio 

Contact: Tirupati Enterprises
Phone no: 9339207519
Email: mail@tirupati.net
Website: www.tirupati.net
Price: Rs. 13,500

Canon Pixma MP198
A multifunctional device for the home user

Thermaltake Xaser VI
A hardcore cabinet for the hardcore gamer

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS
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Motorola mobile phones
have mostly been driv-

en by style, especially with
their MotoRazr range of
phones. The MotoRokr
series followed and was
aimed at music lovers. This
new one is called the
Motozine ZN5 and it comes
with loads of features
including a 5-MP
Kodak camera and is
aimed at users who
want all the features
a phone can offer
including the looks
of a phone.

The phone is thin
and slides into your
pocket easily. The
upper section of the
back has a bulge due
to the lens of the
camera. The back
panel is a little
tricky to remove. 

This phone is like a jig-
saw puzzle with different
colours and all kinds of
materials used all over in
bits and pieces. The base of
the phone is made of a rub-
ber material. The camera
button is a nice metallic
purple giving it a good dis-
tinguishing factor. A nifty

slide button on
the right of the
phone is present
which serves the
purpose of lock-
ing the phone.
This is a good
step forward,
rather than the
old conventional
mode of key
presses to lock
the phone. The
keypad is com-
pletely flat with
really tiny stud-

like projections protruding
out to indicate where to
actually press. 

The camera delivers pret-
ty good images. There are
also quick buttons for delete,
share and gallery on the key-
pad when the phone is in
camera and gallery mode. 

The phone has a loud-
speaker, but is not that
great as the sound is rather
flat. The supplied earbuds
on the other hand are much
better in terms of sound
quality with a decent mid-
range and even a hint of
bass. The phone has a 3.5-
mm jack, which means you
can also plug in your own
earplugs. The only other
complaint is that the phone
heats up a bit with pro-
longed use. The call quality
was pretty good as far as
being in an area with full
network reception goes.

The Motozine ZN5 is a
pretty good phone, but is a
little too late for the mar-
ket. At Rs. 17,583, it still
offers good competition to
the N82. If you are on a
tight budget, this is a
good buy.

Specifications
2.4-inch LCD 240x320 pixel dis-
play, 5-MP camera, 512 MB
internal memory expandable to
4 GB via micro SD card, Wi-Fi.

Contact: Motorola
Phone no: 0124 - 2303212
Website: www.motorola.com
Price: Rs. 17,583

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS

Motorola Motozine ZN5
A Motorola phone with a 5MP camera

Intex is a company that has
recently seen an increase

in the number of its prod-
ucts. Mobile phones are one
of its less known products.
The Intex IN 2266 is an entry-
level mobile phone packed
with quite a few features for
a phone in this category.

Firstly the looks — it’s
glossy cherry red all over,
and easily fits in your palm.
It’s also very light. The but-
tons are a bit cramped and
the screen size is also very
small with 64k colour and a
resolution of 240 x 240 pix-
els QVGA display. The loud-

speaker is
located
behind,
and the
slot for
the hands-
free is on
the side of
the
phone.
The
phone
allows you
to expand memory up to
2GB via a T-flash microSD
memory slot, which is next
to the SIM card slot. 

The phone still has fea-

tures like FM, GPRS, MP3
playback and MMS. You
can use the speaker to lis-
ten to music or use it as
a loudspeaker when mak-
ing calls. The FM radio
has an auto-tune feature
and can store up to 30
channels. The recording
includes scheduled FM
recording where the
time and frequency for
recording can be set. The
phone also has a sched-
uled power on/off feature
that is useful to some

users.
The phone is still a great

buy with all its features like FM
and music playback, since it is
priced only at Rs. 2,999.

Specifications 
FM radio, MMS, WAP, GSM
900/1800, Expandable memo-
ry slot (up to 2 GB), Polyphonic
Ringtones, 1000 number
phonebook, 100 SMS memory,
188 SMS storage

Contact: Intex Technologies
(India) Ltd
Phone: 1800116789
Email: info@intextechnologies.com
Website: www.intextechnologies.com
Price: Rs. 2,999

Intex IN 2266
Compact entry-level phone

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS
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Brother is best known for
value-for-money prod-

ucts. We look at one of its
latest MFDs — the MFC-
7840N. 

This MFD has a basic
two-line LCD backlit display.
There is a full numeric key-
pad for the fax feature on
the right and button
options for fax, copy and
print on the left. 

The paper tray can be
removed completely with
three clamps to adjust your
paper size — two on
the sides and one on
the back. There is
also a tray on top of
the device for ADF
(Auto Document
Feeder). The lid of the
scanner can be extend-
ed when you need to
scan a thick book.

Installation is simple —
the toner cartridge assem-

bly slid into place very easi-
ly. Configuring the MFD can
be being done without con-
necting it to a PC. Other
than the many scanning
options available, there’s
also a unique one — scan
your document to FTP
(upload to an FTP server). 

For printing, we used
two modes of the test docu-
ments — economy and stan-
dard. The plain Word docu-
ments took

11.5 seconds with an upper
and lower limit of two sec-
onds in both modes. 

There was a difference
of a second between the
two modes, but the image
quality was not that great
in economy mode. The
standard mode was an
improvement, but a bit of
pixelation was still visible.
Scanning gave some good
results with the scanned
picture quality not that
bad and it took a total of
36.4 seconds. 

We also scanned five
pages using ADF — this took
a total of two minutes 35
seconds. A Word document
was used to test the copying
capabilities, which did not
turn out that great as the
text turned out to be a bit
rough, but this could be
caused by the scanner. Even
so, the copying took only
nine seconds.

This MFD with its ADF
feature makes a good over-

all purchase. There are
some minor features lack-
ing, like a USB port to get
instant printout from flash
drives. This is still a really
good buy, especially for
small businesses, but is a
bit on the pricey side at
Rs. 19,895.

Specifications 
250 sheet paper tray, 32 MB
memory, Super G3 (33.6Kbps)
modem, Upto 2,400 x 600 dpi
print resolution.

Contact: Brother International
(INDIA) Pvt. Ltd
Phone: 4098 8900
Email: info@brother.in
Website: www.brother.in
Price: Rs. 19,895

Brother MFC-7840N
This Brother packs quite a punch

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS

HP is well known for its
printing solutions,

which include multifunc-
tional devices. The HP
Photosmart C4588 is a new
MFD inkjet aimed at home
users or small businesses,
but also for those who want
photo quality printing.

The C4588 is a neat look-
ing MFD with its smooth
clean look. There is a one-
inch LCD colour display on
the right surrounded by but-
tons. The paper support tray
feels a bit weak and break-
able. The scanner lid didn’t
feel very strong either. 

When you power on this
printer, it gives you step-by-
step instructions on how to
start installing the car-
tridges right up to  print
alignment — all on the LCD
display itself. You do not

even need to connect the
printer to the computer for
these initials steps. 

A unique feature of this
printer is the WiFi support.
You can either connect the
printer to a network using
a router or directly to a PC
or laptop using ad-hoc net-
working. We ran the print-
er through a series of tests
to check the print quality
and speed in two modes —
economy and standard. The

economy mode was quite
unsatisfactory with very
edgy lines in a full page
text document as well as
for a colour document. The
standard mode, on the
other hand, was a great
improvement in terms of
quality, but printing speed
took a hit. The time differ-
ence between economy and
standard for the test docu-
ment (text) was 10 seconds,
whereas the coloured docu-
ment was a whole 30 sec-
onds. The quality of the
photo test turned out to be
exceptionally good. It took

164 seconds for printing,
which is decent. The scan-
ning performance was
average. 

The HP Photosmart C4588
does live up to the mark for
being a really good photo
MFD as the photo printouts
were very impressive.

Specifications 
Dimensions: 17.09 x 11.42 x
6.38 in, Print resolution - 1200
x 2400 dpi, 32 MB memory,
WiFi, MS/DUO, SD, XD, MMC
card reader.

Contact: Hewlett Packard
Phone: 124 - 2566 111
Email: seema.dawar@hp.com
Website: www.hp.com/in
Price: Rs. 8,800

HP Photosmart C4588
A step towards wireless printing The Norton Internet

Security suite comprises
all the features of Norton
Anti Virus with more fea-
tures to protect users from
threats on the internet like
phishing web sites, key log-
gers, etc.

The look of the Norton
Internet Security sports a
very modern simplistic look.
There are three quick access
menus for Computer,
Internet and Identity which
are displayed when you
open the program. There
are also usage meters dis-
played on the main screen:
one for CPU usage and the
other for usage of the
Norton Internet Security
application. 

Norton Internet Security
integrates into your browser
as a toolbar. Firefox and
Internet Explorer have tool-
bars, but Opera isn’t sup-
ported. The toolbar gives

quick access notifications
for anti-phishing and also
keeps security information
like logins and passwords as
profiles. Norton Internet
Security allows users to
securely store usernames
and passwords, as well as
create identity cards which
help users in quick filling of
online forms. 

The earlier versions of
Norton Anti Virus and
Norton Internet Security
used to use up a lot of
resources which causing
the PC to slow down when
idle as well as during a sys-
tem scan. But the Norton
Internet Security 2009 has
stepped up and is quite
efficient when it come to
resources. It used a maxi-
mum of 20 MB of RAM
when we first installed it
and while running a sys-
tem scan it used about 10
MB of RAM. This is defi-

nitely an improvement, as
in the past the major prob-
lem with Norton was of
users complaining of the
amount of resources used
when the antivirus was
running.

Considering the
all-in-one package
that the Norton
Internet Security
offers — antivirus,
antispyware, phish-
ing filters for internet
safety and even good per-
formance, it is a bit on the
expensive side at Rs. 2,115
for one year and hence we
would not recommend it
as there are others out
there that are cheaper.
Even so, if you are a
Norton user and trust no
other antivirus software
then this is a great bundle
for you.

Requirements 
Microsoft Windows XP/Vista,
300 MHz or faster processor,
256 MB of RAM, 200 MB of

available hard disk space,
Standard Web browser

Contact: Symantec
Phone: 1800 425 4235
Website: www.symantec.com/en/
in/index.jsp
Price: Rs. 2,115

Norton Internet Security 2009
An efficient internet security suite

Features
Performance  
Ease of Use
Value for Money
Overall 

RATINGS

Zebronics has come up
with an MP3 solution

for wire free music as the
Air Gear MP3 player is the
headset itself.

The Zebronics Air Gear
is worn behind the neck.
These headphones look like
Bluetooth headphones, and
in fact, are the MP3 player
itself. There is no device
that needs to be plugged
in to play music. The
only time you need to
connect the headphones
to a wire is for charging or
transferring music through
the mini USB port located
on the right earphone. All
the controls are located on
the right earphone. The
power on/off and the play
and pause buttons are all
combined into one button,
whereas the volume con-

trols and the next/previous
buttons are also combined
into two buttons. This is
not very easy to use and
takes a while to get used to.

We faced a frequent prob-
lem between switching
songs and controlling the
volume.

It is very delicate as the
plastic neck band that
holds the whole device

together looks very likely
to break if not handled
with care. This device will
not survive a trip in your
bag, if you intend to travel
a crowded train or bus dur-
ing peak hours.

There is no manage-
ment in transferring
music, as you can directly

drag and drop the songs
you want into the
removable disk folder.
There is no shuffle or
repeat feature avail-
able with this player,
which means you

have to be very selec-
tive of the songs you want

to listen to, or it will be a
cumbersome task to look
for that one particular
song you feel like hearing. 

Priced at Rs. 1,950, it’s
not the best of MP3 players.
If the neck band was stur-
dier with a slight improve-
ment in the sound quality,

we would recommend it to
users who don’t like wires,
or to those who like listen-
ing to music while they
exercise. So until an
improved version of this
wire free MP3 player comes
out, we wouldn’t suggest
you buy it.

Specifications
Frequency range: 20 Hz –
20,000Hz, Max volume: 85dB,
Supported Formats: MP3, WMA  

Contact: Top Notch Infotronics (I)
Pvt. Ltd.
Phone: 9892084950 
Email: padam.dugar@zebronics.com
Website:  www.zebronics.com
Price:  Rs. 1,950

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS

Zebronics Air Gear
An MP3 player with no-strings attached

Features
Performance  
Build quality
Value for Money
Overall 

RATINGS
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Michael Browne

In November last year, we test-
ed motherboards with inte-
grated graphics (IG) solutions. 

These were strictly entry-level to 
mid-range platforms. As you’re 
probably aware, high-end systems 
mostly mean motherboards with-
out any graphics solution. Yes, 
high-end PCs demand a graphics 
card, and therefore, an integrat-
ed video solution isn’t required. 
Moreover, most manufacturers 
reserve the top-end features and 
top quality binned parts for their 
top-of-the-line solutions. These 
are more-often-than-not discrete 
graphics solutions. 

When you’re simply buying a 
PC, any motherboard will most 
likely do, as long as it supports 
the processor of your choice – at 
least four serial ATA ports and an 
equal number of memory slots 
and USB ports. The motherboards 
we’ve tested are catered more 
towards the discerning user. Most 

of these boards support extra 
connectivity options like E-SATA, 
extra USB ports and serial ATA 
ports. Some of these even come 
with a lot of snazzy add-ons, like 
an LCD screen that displays POST 
(Power On Self Test) messages. 
Perhaps more importantly, most 
of these motherboards support 
specific multi-GPU solutions like 
NVIDIA’s SLI or ATI’s Crossfire. 
If you’re looking at building a 
fast gaming rig, or even a pow-
erful multi-purpose PC, or a 
rig for cracking world bench-
mark records, then you’ll prob-
ably end up shopping for one of 
these worthies.

We’ve tested 26 of the top-
end boards available today. To 
nobody’s surprise, 24 of these 
boards were Intel LGA 775 plat-
forms. AMD users have a measly 
two boards to choose from. This 
is because most vendors are flock-
ing to make high-end solutions 
supporting Core 2 Duo and Core 2 
Quad processors, thanks to Intel’s 

domination in the high-end per-
formance market. AMD chose to 
play the entry-level market, which 
is why our integrated-graph-
ics motherboard comparison in 
November had more AMD-based 
solutions. If you’re buying a high-
end PC today, market trends sug-
gest you want an Intel processor, 
and motherboard manufacturers 
seem to agree. We also noticed 
that Nehalem boards were rather 
scarce – it seems Intel’s DX 58 
SO is the only X58 motherboard 
that is readily available. Other 
vendors have demo pieces, but 
nothing in-market. We did get 
an MSI X58 Eclipse and an ASUS 
P6T Deluxe, but the former was 
recalled before we could test it. 
The latter turned out to be physi-
cally damaged – some CPU pins 
were missing. Therefore, Intel’s 
X58 offering remains the only 
Nehalem-based board we’ve tested 
and we await more boards from 
other vendors based on the new 
and exciting Nehalem processor.

Motherboards up to 
Rs 10,000
Feature rich and fancy-free

Normally, non-integrated 
motherboards aren’t cheap. 

However, there’re always options 
for every user and in every price 
bracket. Sadly, the recent plum-
meting Rupee value against the 
Dollar means that most Indian 
distributors have pulled up their 
rates. Over the past two months, 
quite a few sub-Rs. 10000 boards 
have crossed into the higher price 
category. Also cheaper IG boards 
are plentiful, but non-integrated 
boards are one category where 
discerning buyers are willing to 
shell out big. As a result, only 
four boards made it into this cat-

egory and one was an AMD-based 
offering.

Features
The MSI K9A2 Neo2 was the AMD-
based solution in this category, 
and is based on AMD’s RX780 chip-
set. This board is cleanly laid out 
and the area around the CPU is 
also very open. Two of the others 
were P43-based solutions, which 
are lower variants of the P45 chip-
set. MSI’s P43 Neo and Gigabyte’s 
EP43-DS3L both featured the ICH 
10 Southbridge. ECS was the only 
vendor to provide a P45 offering 
— the P45T-AD3. Quite surpris-
ingly this board supported DDR3 
memory; this is kind of contra-
dictive to the product pricing as 
DDR3 memory is costly enough 
to negate any price benefits the 

board brings. This board also has 
an option in the BIOS for enabling 
Intel’s Robson, which by definition 
uses a small amount of cache 
on the board itself to speed up 
HDD operations. Unfortunately 
this board doesn’t have any such 
cache and may rely on a flash 
drive for this purpose. We haven’t 
come across this setting in the 
BIOS’ of other boards before so High-

end rigs, 
multi-GPU 

systems 
and world 

record 
beating 
bench-

marks need 
the best 
boards. 

We’ve test-
ed them... We categorised our motherboards into three price categories

1. Boards up to Rs. 10,000
2. Boards above Rs. 10,000 and up to Rs. 18,500
3. Boards above Rs. 18,500
Our Test system for the Intel platform consisted of a Core 

2 Extreme QX 9650 (3.0 GHz) processor and 4 GB of RAM. For 
DDR2 boards we used Corsair’s Dominators rated at 1066 MHz at 
timings of 4-4-4-12 at a speed of 800 MHz. For the DDR3 moth-
erboards we used 4 GB of OCZ XTC Platinum clocked at 1333 MHz 
at timings of 9-9-9-20. Our graphics card of choice was ASUS’ EN 
GTX 280 TOP; an NVIDIA GeForce GTX 280-based card whose core 
is factory overclocked to 670 MHz. Western Digital Raptor hard 
drives were our storage component; these have the spindle run-
ning at 10,000 rpm and are suitable for such high-end boards.

For AMD systems we used the Phenom 9950 processor 
clocked at 2.6 GHz. We used the same memory, graphics card and 
HDD for the AMD motherboards as well; this is done to minimise 
deviations in scores due to different components being used. By 
varying only the motherboard and the processor we are able to 
keep other variances down to a minimum. We used the latest 
motherboard BIOS’ and the latest drivers that we downloaded 
from the respective sites. Our OS of choice was the tried and 
tested Windows XP Prof with service pack 2 installed. This is 
probably the last time we’re testing boards on this ultra stable 
and reliable platform.

Features
We looked very carefully at overclocking options that these boards 
provide. With overclocking becoming very idiot-proof, even idi-
ots (pardon the pun!) can play around with BIOS settings safely. 
Enthusiasts will also find a lot of valuable information as far as 
CPU and memory voltage parameters go. We rated these boards 
on the basis of both overclocking and overvolting options and 
how easy and transparent the settings in the menus are to this 
effect. We also looked at the features and connectivity options 
that these boards provide. The presence of digital audio ports, 

E-SATA, dual LAN ports, solid state capacitors and the number of 
expansion slots available for PCI and PCIe cards was rated.

Performance testing
PC Mark 2005: This benchmark runs 48 discrete tests to test 
each performance related component subsystem — the proces-
sor, memory, video and storage. Finally it throws out a final score 
— which is a weighted average of the individual results.

SiSoft Sandra 2008 Lite: Sandra 2007 had specific benchmarks 
to test all the subsystems of a PC. It tests a CPU’s floating point 
crunching ability under both arithmetic and multimedia applica-
tions. The application supports multiple cores and scales well in 
this regard. It also tests the read and write performance of the 
storage subsystem, and the memory bandwidth. 

3D Mark 2006: Our graphics benchmark of choice. 

CineBench R10: Tests the CPUs rendering ability; scales well with 
multiple cores.

WinRAR 3.8: Tests compression/decompression at the CPU level

Video encoding (DivX 6.8): is a CPU intensive test and using it 
while testing a motherboard tells us exactly how optimised the 
board in question is. The latest version 6.8 also has support for 
the new SSE4 instruction set.

File transfer test: This tells us a lot about Southbridge perfor-
mance and data path optimisations on each motherboard, and 
how fast data is moving around on your hard disk.

Game benchmarks: Doom 3, S.T.A.L.K.E.R Shadow Of Chernobyl 
and Prey were our games of choice. We run these games at maxi-
mum settings for a good GPU benchmark and at minimum set-
tings to get a sound CPU benchmark.

  How We Tested
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MSI P43 Neo
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Motherboards Boards Up To Rs 10,000 

Brand
Model No.

MSI 
K9A2 Neo2

MSI
P43 Neo

ECS
P45T-AD3

Gigabyte
EP43-DS3L

Chipset AMD RX780 Intel P43 Neo Intel P45 Intel P43
Socket AM2/AM2+ LGA 775 LGA 775 LGA 775
Northbridge / Southbridge AMD RX780 / AMD 

SB700/SB750
P43 / ICH10 P45 / ICH10R P43 / ICH10

Price (Rupees) 4500 5200 7560 8500
Plus (+)
Minus (-)
Grand Total (Out of 100) 54.01 57.57 61.89 64.47
Features (out of 60) 24.36 22.50 26.10 29.22
Performance (Out of 40) 29.65 35.07 35.79 35.25
Front Side Bus Speed (MHz) 2000 MHz 1333 MHz 1333 MHz 1333 MHz
Memory Type DDR2 DDR2 DDR3 DDR2
Max Memory Supported (GB) / No of DIMMs 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4
No. of SATA / IDE Ports 6 / 1 6 / 1 6 / 1 6 / 1
E-SATA Support / No Of E-SATA Ports 6 / NA 6 / NA y / 1 6 / NA
No of PCI Express Graphics Slots 1 1 2 1
No. of PCI / PCI x1 / PCI x4 Slots 3 / 2 / 6 3 / 2 / 6 2 / 2 / 6 2 / 4 / 6
Multi GPU Support (SLI/CrossFire/N) / No of 
PCIe Lanes for multi GPU setups

N / NA N / NA Y / Crossfire x8 6 / NA

Integrated Audio Controller Realtek ALC888 Realtek ALC 888 Realtek ALC 883 Realtek ALC 888
SPDIF / Optical Port 6 / 6 6 / 6 6 / 6 4 / 4
No of LAN Ports / 10/100 / Gigabit 1 / Gigabit 1 / Gigabit 1 / Gigabit 1 / Gigabit
Integrated Wi-Fi (Y/N) 6 6 6 6

No. of rear USB / FireWire Ports 6 / 0 4 / 6 6 / 0 8 / 1
All Solid State Caps (Y/N) 6 6 6 4

BIOS options
Overclocking / Overvolting (So 10) 5 / 5 5 / 5 3.5 / 3.5 5.5 / 5.5
CPU voltage range (volts) (-)26.6 to (+)30.4% -0.4 ~ +0.7875v +50mV ~ +328mV 0.5 ~ 2.0v
Memory voltage range (volts) 1.80 to 2.90v 1.416 ~ 3.324v 1.5v ~ 2.2v 1.8 ~ 2.5v
Package Bundle
No of SATA / PATA Cables Provided 4 / 1 3 / 1 4 / 1 3 / 1
CD’s Drivers Driver, Backup software Drivers Drivers
Other Miscellaneous Accessories NA NA USB and FireWire bracket NA
Performance
PC Mark 2005:
CPU / Memory 7623 / 4496 9563 / 6433 9683 / 6691 9553 / 6326
Graphics / HDD 16450 / 6837 18253 / 6527 18429 / 7017 18425 / 6922
Overall 8774 10138 10573 10467
SiSoft Sandra 2008:
CPU Arithmetic (Dhrystone ALU / Whetstone 
iSSE3)

39365 / 33387 54667 / 44028 55530 / 44066 55343 / 44016

CPU Multimedia (Integer / Floating) 98644 / 130006 328936 / 180293 329473 / 180768 329272 / 180264
Drive Index (MB/s) / Random Access Time (ms) 71 / 6 73 / 6 72 / 6 72 / 6
SiSoft Memory bandwidth score (Integer / 
Floating)

5309 / 5301 6526 / 6253 7196 / 7199 6526 / 6527

3D Mark 2006 Marks / CPU Score 13415 / 3850 16638 / 4949 16879 / 4975 16727 / 4962
CINEBENCH R10 (CPU) 8319 11824 11833 11828
WinRAR 3.8 1844 2192 2263 2193
Video Encoding (DivX 6.8) Time (sec) 80 114.3 114.2 115.4
File Transfer Test (4 GB File) (MBps) 145.2 136.5 136.7 135.2
Doom 3 FPS (1600x1200, 4xAA, 4xAF / 640 x 
480, low detail)

172.7 / 185.5 203.2 / 288.4 212.7 / 305.4 207.6 / 301.3

S.T.A.L.K.E.R Shadow Of Chernobyl (1680x1050, 
4xAA, 4xAF / 800 x 600, low detail)

136.2 / 443.19 180.3 / 894.6 180.95 / 916.11 180.23 / 888.4

Prey (1680 x 1050, 4x AA, 4x AF, 640 x 480, 
low detail)

165.8 / 227 204.3 / 348.8 211.2 / 357 202.2 / 336.84

J a n u a r y  2 0 0 9

have eight rear 
USB ports for 
hassle free con-
nectivity. MSI’s 
P43 Neo with its 
fire engine red 
PCB is clearly a 
basic solution as 
MSI uses a black PCB 
for their high-end boards. 
It has a simple aluminium 
heatsink on the Northbridge 
and is cleanly laid out with a lot 
of gap between the PCIe slot and 
PCI slots.

Performance
The P45 chipset is slightly faster 
than the P43 and ECS’ P45T-AD3 
takes the lead in this regard 
but by the finest of margins. Of 
course this could also be attribut-
able to the use of DDR3 memory 
especially in case of the memory 
bandwidth benchmarks which 
are largely theoretical in nature. 
The MSI K9A2 Neo2 is just eaten 
up here; and not for any fault of 
its own. AMD really trails behind 
Intel in terms of processor per-
formance and this reflects in 
most of the benchmark scores.

Our Winner(s)
All in all, MSI’s P43 Neo impressed 
the most. It trailed the fastest 
board by a hairsbreadth and was 
a whole Rs. 2,360 cheaper. At Rs. 
5,200 its your best bet for a cheap 
yet powerful board that’s rea-
sonably feature-rich. It won our 
Digit Best Buy award in the sub- 
Rs. 10,000 category and repre-
sents superb value for money.

Motherboards above 
Rs. 10,000 and up to 
Rs. 18,500
Enthusiastically yours

The number of people willing 
to spend Rs. 10,000 or above on 

a motherboard are few; however 
this number is slowly on the rise. 
Overclockers, gamers demand-
ing multi-GPU systems and oth-
ers wanting a really feature rich 
board have no other choice. When 
you pay above Rs. 10,000 for a 
board you are not just looking for 
connectivity options or even mun-
dane features.      

You want bragging rights and 
flaunt value as well as rock solid 
performance and build quality. 
In addition these boards usual-
ly have better quality or higher 
grade components. This helps 
with increased life and stabil-
ity while overclocking which is 
important for those interested 
in benchmarking and posting 
scores on forums and such. Some 
of these boards will also have 
fancy looking heatpipe cooling 
solutions; this is great for people 
having cabinets with transparent 
side windows or anyone wanting 
to show his components off.

Features
The boards in the category were 
all quite feature rich and diverse 
in terms of the chipsets they were 
based on. We found Intel’s P45 
boards aplenty along with a few 
of the cheaper X48 chipset based 
boards. NVIDIA’s nForce 780i SLI 
chipset also makes an appear-
ance here. A sole AMD offering 
based on the new 790FX was 
available from ASUS. ASUS them-
selves had five boards in this cat-
egory. The attractively packaged 
P5Q Premium and P5Q3 Deluxe 
caught our eye first. Both are 
based on the P45 chipset; but the 
number three as a suffix on the 
P5Q3 Deluxe means this board 
supports DDR3 instead of the de 
facto DDR2. This board also sup-
ports two WLAN access points — 
nifty but useless for most people. 
The P5Q Premium actually has 
four RJ45 ports; a waste if you ask 
us, although we did like the 10 
USB ports. Both these boards also 
support Express Gate, an ASUS pat-
ent for a separate Linux based 
firmware OS built on to a flash 

chip which allows you to surf 
the internet and use Skype with-
out booting into Windows. Both 
boards have great looking heat-
pipe solutions and are very well 
laidout except for the fact that 
one SATA port remains unusable 
with full length graphics cards. 
This is because while the other 
SATA ports point outwards this 
one is vertically aligned (meaning 
it points upwards); connecting a 
hard drive to this port with a full 
length graphics card plugged in 
is impossible. We liked the fact 
that ASUS chose to supply one 
PCI slot above the primary PCIe 
slot. This means that you can use 
your PCI soundcard, even if you 
have a large custom cooler on 
your graphics card, without fear 
of airflow getting impeded in any 
way. Incidentally these boards 
support a 16-phase power system, 
good for ensuring an ultra sta-
ble supply of power to your CPU 
which is of importance to over-
clockers. Gigabyte’s GA-P45-DS4P 
is another solidly built offering. 
It’s a great looker too with a good 
looking heatpipe solution that 
doesn’t take up too much space. 
Biostar’s T-Power I45 was also a 
good looking and well laid out 
board and an add-on fan with 
heatpipe is also provided. Biostar 
uses funky colours for the expan-
sion slots and the SATA ports 
are well placed; not so the PATA 
port which is a little awkward 
although not inaccessible.

ASUS’ Striker Formula (780i 
chipset) and Rampage Formula 
(X48 chipset) are part of their 
built for gamers ROG (Republic 
Of Gamers) series. These boards 
have add-on soundcards featur-
ing the same ADI 1988B audio 
chipset that ASUS uses across 
all their high-end motherboards. 
They also have small LED-back-
lit buttons for functions like 
power on/off, CMOS reset and 
system reset. This is convenient 
for people working with open 
systems (like us!) or overclock-
ers. They also have LEDs on the 
PCB that indicate the current 
status of Northbridge, FSB and 
CPU overclocks. Then there is the 
huge yet unobtrusive one-piece 
heatpipe cooling solutions that 
ASUS uses; these cooling solu-
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MSI P45 Platinum

it warrants mention. The board 
itself is good looking with an all-
black PCB and is the best laid out 
board in this category. The EP43-
DS3L from Gigabyte was cleanly 
laid out and was the only one to 

sport an all solid-state capacitor 
design. We like the placement 
of the memory slots and the 
SATA ports in particular. The CPU 
region was also fairly un-cramped. 
One issue was the Northbridge 

cooler isn’t fixed on too tight and 
uses plastic push-through pins to 
fasten to the board. Due to this 
the cooler was quite loose, which 
isn’t good for heat dissipation. 
This board was the only one to 
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Motherboards                                                                Boards Above Rs. 10,000 and Up To Rs. 18,500

Brand
Model No.

MSI
P45 Platinum

BioStar
T-Power I45

ASUS
M3A79-T Deluxe

                  ZOTAC
          NF-780i Supreme

ASUS
P5Q3 Deluxe

EVGA
132-CK-NF78

MSI
X48c Platinum

Intel
DX48BT2

XFX
MB-N780-ISH9

Chipset Intel P45 Intel P45 AMD 790FX NVIDIA nForce 780i Intel X48 NVIDIA nForce 780i Intel X48 Intel X48 NVIDIA nForce 780i
Socket LGA 775 LGA 775 AM2/AM2+ LGA 775 LGA 775 LGA 775 LGA 775 LGA 775 LGA 775
Northbridge / Southbridge P45 / ICH10R P45 / ICH10R AMD 790FX / AMD SB750 nForce 780i SLI / nForce 570 SLI X48 / ICH9R nForce 780i SLI / nForce 570 SLI X48 / ICH9R X48 / ICH9R nForce 780i SLI / nForce 570 SLI
Price (Rupees) 10800 10800 11925 12999 13850 14250 15000 16000 16500
Plus (+)
Minus (-)
Grand Total (Out of 100) 69.41 64.51 65.91 67.89 76.15 67.62 68.55 68.03 66.14
Features (out of 60) 34.10 29.16 35.60 32.94 40.20 33.18 33.33 32.48 31.74
Performance (Out of 40) 35.32 35.35 30.31 34.95 35.95 34.44 35.22 35.56 34.40
Front Side Bus Speed (MHz) 1333 MHz 1333 MHz 2000 MHz 1333 MHz 1333 MHz 1333 MHz 1333 MHz 1333 MHz 1333 MHz
Memory Type DDR2 DDR2 DDR2 DDR2 DDR3 DDR2 DDR2 / DDR3 DDR3 DDR2
Max Memory Supported (GB) / No of DIMMs 8 GB / 4 8 GB / 4 16 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 6 # 8 GB / 4 8 GB / 4
No. of SATA / IDE Ports 8 / 1 6 / 1 6/1 6 / 1 8 / 1 6 / 1 4 / 1 6 / 1 6 / 1
E-SATA Support / No of E-SATA Ports 4 / 1 4 / 2 4 / 1 6 / NA 4 / 1 6 / NA 4 / 2 4 / 2 6 / NA
No of PCI Express Graphics Slots 2 2 4 3 3 3 2 3 3
No. of PCI / PCI x1 / PCI x4 Slots 2 / 2 / 6 2 / 2 / 6 2 / 6 / 6 2 / 1 / 6 2 / 2 / 6 2 / 1 / 6 3 / 2 / 6 2 / 6 / 6 2 / 1 / 6
Multi GPU Support (SLI/CrossFire/N) / No of 
PCIe Lanes for multi-GPU setups

Y / Crossfire x8 Y / Crossfire x8 Y / Quad CrossfireX (x8, x8, 
x8, x8)

Y / 3 way SLI (x16, x16, x8) Y / Crossfire x8 Y / 3 way SLI, (x16, x16, x8) Y / Crossfire x16 Y / Crossfire x16 Y / 3 way SLI, (x16, x16, x8)

Integrated Audio Controller Realtek ALC 888 Realtek ALC 888 ADI AD2000B SoundMax Realtek ALC 888 ADI 1988B Realtek ALC 888 Realtek ALC 888 Sigmatel STAC 927 Realtek ALC 888
SPDIF / Optical Port 6 / 4 6 / 6 4 / 4 6 / 4 4 / 4 6 / 4 6 / 4 6 / 4 6 / 4
No of LAN Ports / 10/100 / Gigabit 1 / Gigabit 1 / Gigabit 1 / Gigabit 2 / Gigabit 2 / Gigabit 2 / Gigabit 1 / Gigabit 1 / Gigabit 2 / Gigabit
Integrated Wi-Fi (Y/N) 6 6 6 4 (kit) 4 6 6 6 6

No. of rear USB / FireWire Ports 6 / 1 6 / 0 6 / 1 6 / 1 6 / 1 6 / 1 8 / 1 6 / 1
All Solid State Caps (Y/N) 4 4 4 6 4 6 4 6 6

BIOS options
Overclocking / Overvolting (So 10) 7.25 / 7 5 / 5 7.25 / 7 7 / 7 9 / 9 7 / 7 7.25 / 7.25 7.75 / 7.5 7 / 7
CPU voltage range (volts) 0.9925 to 1.9425 V -0.05v to +1.3v 0.8 to 1.7v 0.5 to 1.8.0v 0.85 to 2.1v 0.5 to 1.8.0v +0.7875 V at 0.0125 1.28 to 1.6v 0.5 to 1.8.0v
Memory voltage range (volts) 1.428 to 3.324 V +0.4v to +1.85v 1.8 to 2.5v 1.8 to 2.5v 1.5 to 2.78v 1.8 to 2.5v DDR3 - 1.50 to 2.75 V, DDR2 - 1.8 

to 3.3 V
1.5 to 2.5v 1.8 to 2.5v

Package Bundle
No of SATA / PATA Cables Provided 4 / 1 4 / 1 6 / 1 4 / 1 6 / 1 6 / 1 4 / 1 2 / 1 4 / 1
CD’s Drivers Drivers Drivers Drivers Drivers Drivers Drivers Drivers Drivers
Other Miscellaneous Accessories USB and FireWire bracket Add-on fan with heatpipe NA WiFi kit 2-WiFi AP units NA USB and FireWire bracket NA NA
Performance
PC Mark 2005:
CPU / Memory 9662 / 6552 9678 / 6471 7658 / 4500 9612 / 6682 9700 / 6738 9644 / 6706 9652 / 6452 9672 / 6482 9635 / 6735
Graphics / HDD 18382 / 6827 18499 / 7073 16798 / 6881 18284 / 7243 18435 / 6958 18371 / 7241 18182 / 7026 18236 / 7172 18373 / 7102
Overall 10389 10499 8969 10473 10624 10512 10445 10219 10480
SiSoft Sandra 2008:
CPU Arithmetic (Dhrystone ALU / 
Whetstone iSSE3)

55328 / 44217 55631 / 44045 39486 / 33576 55538 / 44263 55683 / 44307 55555 / 44015 55262 / 44192 55527 / 44091 55533 / 44024

CPU Multimedia (Integer / Floating) 329873 / 180626 330244 / 181007 98962 / 130438 329374 / 180731 330655 / 181060 329422 / 180295 329872 / 180828 330283 / 180992 329374 / 180353
Drive Index (MB/s) / Random Access Time 
(ms)

73 / 6 72 / 6 72 / 6 67 / 13 72 / 6 67 / 13 72 / 6 74 / 6 67 / 13

SiSoft Memory bandwidth score (Integer / 
Floating)

6626 / 6656 6658 / 6668 5312 / 5311 6838 / 6841 7324 / 7222 6972 / 6957 7019 / 7023 7219 / 7215 6839 / 6837

3D Mark 2006 Marks / CPU Score 16563 / 4982 16845 / 4966 13715 / 3907 16377 / 4981 16928 / 4991 16707 / 4954 16627 / 4945 16823 / 4993 16703 / 4938
CINEBENCH R10 (CPU) 11825 11833 8408 11836 11831 11821 11836 11862 11834
WinRAR 3.8 2204 2086 1850 2253 2289 1603 2122 2219 1672
Video Encoding (DivX 6.8) Time (sec) 114.6 114.1 78.3 113.5 113.2 113.8 114.8 113.9 113.4
File Transfer Test (4 GB File) (MBps) 136.6 137 140.4 146.7 137 143.7 140 137.6 145.8
Doom 3 FPS (1600x1200, 4xAA, 4xAF / 640 
x 480, low detail)

201.6 / 296.3 208.7 / 291.7 177.1 / 190.8 208.4 / 303.7 212.7 / 302.2 211.8 / 303.8 207.5 / 292.4 208.2 / 294.3 208.35 / 299.4

S.T.A.L.K.E.R Shadow Of Chernobyl 
(1680x1050, 4xAA, 4xAF / 800 x 600, low 
detail)

180.63 / 908.72 180.32 / 916.3 139.29 / 460.81 180.21 / 905.3 181.11 / 930.72 179.01 / 880.41 180.4 / 911.4 179.3 / 910.3 179.5 / 901.4

Prey (1680 x 1050, 4x AA, 4x AF, 640 x 
480, low detail)

206.3 / 351.7 210.5 / 352.6 183.6 / 231.9 206.3 / 346.4 211.1 / 374 208.7 / 344.9 208.8 / 350.3 208.6 / 355 208.5 / 348.3

J a n u a r y  2 0 0 9 J a n u a r y  2 0 0 9 J a n u a r y  2 0 0 9
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and even a full length, double-
slot card will not render them 
unusable. Equally important for 
some is the support for both 
DDR2 and DD3 memory on the 
X48c; this board has six memory 
DIMMs; two for DDR2 and four 
for DDR3. This means you can 
upgrade to DDR3 later, when it’s 
more affordable. All these fea-
tures come with a caveat — there 
are only four SATA ports and this 
may not be enough for those 
running multiple HDDs and 
RAID arrays. The P45 Platinum 
is equally well laid out and the 
heatpipe solution is much easier 
on the eye; in fact the heatsinks 
atop the Northbridge have been 
designed to appear like a four 
cylinder engine block complete 
with cooling fins. However, this 
high-rise heatsink couple with 
the fact that the heatsink cool-
ing the mosfets on the other side 
of the board are also quite high, 
means your fingers face a little 
abuse while fastening the CPU 
cooler. MSI provides eight SATA 
ports on the P45 Platinum; as if to 
make up for the X48c Platinums’ 
deficiency in this regard.

The other three 780i SLI 
boards were from EVGA, XFX and 
ZOTAC and these boards look 
identical since these vendors 
choose to use NVIDIAs standard 
PCB; in fact these PCBs are even 
made by NVIDIA so the finest 
details are identical too. EVGA 
has the most SATA connectors 
bundled and these are an attrac-
tive black in colour. The PATA 
connector too is encased in a 
round bracket to aid airflow 
— thoughtful. ZOTAC bundles a 
WiFi kit with their motherboard 
which is the only difference 
between these boards aside from 
their bundles and prices.

The ASUS boards have the 
most feature rich BIOSes in terms 
of overclocking options and they 
are closely followed by Gigabyte. 
Never before have we seen such 
minute settings and you can 
tweak virtually any component 
you choose. There are also mul-
tiple reference voltage points 
that you can set. Overclockers 
will spend a lot of time here. We 
also think ASUS does a very good 
job of making their BIOSes new-

bie friendly with help options 
at every stage. The settings are 
also very transparent and menu 
structure is good. Both Gigabyte 
and ASUS support updating their 
BIOS through USB drive and this 
is so much more convenient then 
hunting around for a floppy drive 
and working diskette. Although 
most vendors have programs that 
allow flashing the BIOS from 
Windows itself we feel the option 
of adding support for flashing 
from a USB drive from within the 
BIOS is a very useful feature.

Performance
In terms of overall performance 
it seems NVIDIAs 780i SLI chip-
set cannot match Intel’s X48 
and P45 chipsets. Of particular 
attention is the storage subsys-
tem where Intel definitely has a 
lead and NVIDIA’s Southbridge 
has latency issues in terms of 
hard drive access and during our 
file copy test. The ASUS M3A79-T 
Deluxe trails by a good margin 
on account of its AMD proces-
sor but from amongst the Intel 
boards ASUS’ P5Q3 Deluxe was 
just ahead of the competition. As 
is the nature of motherboard test-
ing the differences when using 
identical components at stock 
speeds is very minute; but the 
X48 and P45 chipsets generally 
outperform the 780i in both CPU 
and HDD based benchmarks. It 
also appears that DDR3 memory 
gives both the ASUS P5Q3 Deluxe 
and the Intel DX48BT2 a slight 
edge. Although we feel that DDR3 
will really shine at speeds of 1600 
MHz and above its nice to see 
some small performance incre-
ments being gained at relatively 
slower speeds of 1333 MHz and 
with looser timings.

Winner(s)
Our Best Buy award goes to MSI’s 
P45 Platinum; a highly competent 
board for most high-end users at a 
great price point of Rs. 10,800. It’s 
got a load of connectivity options 
and even supports Crossfire. It’s 
definitely no slouch in terms of 
performance and shames some 
costlier boards. Our overall best 
performer was also to be found 
in this category (shockingly) as 
ASUS’ P5Q3 Deluxe demolishes 
even the ultra-high-end offer-
ings. If you want the fastest board 
out there, this is the one to buy. 
It’s very feature-rich as well, and 
you won’t want for connectivity 
options which it has a bonanza 
of. DDR3 support means its rea-
sonably future proof. The price 
of Rs 13,850 may cause you to go 
“ouch” but it’s superlatively well 
built if that massages your sore 
wallet. Our Editors Pick was the full 
x16 SLI supporting ZOTAC NF-780i 
Supreme. This board has all the 
connectivity options, gives you the 
option of 3-way SLI and throws in 
a WLAN access point all for Rs. 
12,999 — good value for money 
for someone building a fast gam-
ing rig.

Motherboards above 
Rs. 19,000
Wallet busting superlatives

When talking of Rs. 19,000 for 
just one motherboard you 

just know that the nonsense will 
be left far behind. 20-odd grand 
is either a good price for a superb 
motherboard or just a ridiculous 
price for an atrociously expensive 
and utterly undeserving offering. 
Entire PCs can be built for less, 
which means these boards either 
have some serious plus points in 
terms of features or connectivity, 
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ZOTAC NF-780i Supreme
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ASUS P5Q3 Deluxe

cular shaped heatpipe solution 
atop the former which looks 
overly loud and garish. The X48c 
Platinum is very well laid out; 
the PCI slots can be populated 
even with a Crossfire setup — this 
is rare. The SATA ports are placed 
away from the primary PCIe slot 

test. It’s somewhat plain-jane 
looking with a black PCB and 
Intel’s traditional all aluminium 
heatsinks on both chipsets. Both 
MSI’s boards, the X48c Platinum 
and the P45 Platinum were good 
lookers although somehow we 
do not care for the elaborate cir-

tions are some of the most attrac-
tive around. The ASUS M3A79-T 
Deluxe was unique by supporting 
4-way Crossfire or as ATI calls 
it, Quad Crossfire. Intel’s own 
DX48BT2 was also present but 
this board pales in comparison 
to the two other X48 boards in 

  
Motherboards Boards Above Rs. 10,000 and Up To Rs. 18,500

Brand
Model No.

ASUS
Rampage Formula

ASUS
P5Q Premium

Gigabyte
P45-DS4P

ASUS
Striker 2 Formula

Chipset Intel X48 Intel P45 Intel P45 NVIDIA nForce 780i
Socket LGA 775 LGA 775 LGA 775 LGA 775
Northbridge / Southbridge X48 / ICH9R P45 / ICH10R P45 / ICH10R nForce 780i SLI / nForce 570 SLI
Price (Rupees) 17000 17750 17890 18350
Plus (+)
Minus (-)
Grand Total (Out of 100) 74.79 75.40 72.87 75.35
Features (out of 60) 39.83 40.44 37.64 41.27
Performance (Out of 40) 34.96 34.96 35.24 34.09
Front Side Bus Speed (MHz) 1333 MHz 1333 MHz 1333 MHz 1333 MHz
Memory Type DDR2 DDR2 DDR2 DDR2
Max Memory Supported (GB) / No of DIMMs 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4
No. of SATA / IDE Ports 6 / 1 10 / 1 6 / 1 6 / 1
E-SATA Support / No of E-SATA Ports 6 / NA 6 / NA 6 / NA 4 / 2
No of PCI Express graphics slots 2 4 2 3
No. of PCI / PCI x1 / PCI x4 Slots 2 / 3 / 6 2 / 1 / 6 1 / 3 / 1 2 / 2 / 6
Multi GPU Support (SLI/CrossFire/N) / No 
of PCIe Lanes

Y / Crossfire x16 Y / Crossfire x8 Y / Crossfire x8 Y / 3 way SLI, (x16, x16, x8)

Integrated Audio Controller ADI 1988B ADI 1988B Realtek ALC 889A ADI 1988B
SPDIF / Optical Port 4 / 4 4 / 4 4 / 4 4 / 4
No of LAN Ports / 10/100 / Gigabit 2 / Gigabit 4 / Gigabit, 10/100 2 / Gigabit 2 / Gigabit
Integrated Wi-Fi (Y/N) 6 6 6 6

No. of rear USB / FireWire Ports 6 / 1 10 / 0 8 / 2 6 / 1
All Solid State Caps (Y/N) 4 4 4 4

BIOS options
Overclocking / Overvolting (So 10) 9.25 / 9.5 9 / 9 8.25 / 8 9.5 / 9.25
CPU voltage range (volts) 1.1 to 2.4v 0.85 to 2.1v 0.5 to 2.3v 1.1v to 2.2v
Memory voltage range (volts) 1.8 to 3.4v 1.8 to 3.08v 1.8 to 3.0v 1.8 to 3.4v
Package Bundle
No of SATA / PATA Cables Provided 6 / 1 6 / 1 6 / 1 6 / 1
CD’s Drivers, STALKER game, 3D 

Mark 06 Advanced Edition, 
Kaspersky Antivirus

Drivers Drivers Drivers, STALKER game, 3D Mark 
06 Advanced Edition, Kaspersky 
Antivirus

Other Miscellaneous Accessories LCD poster, USB and FireWire 
bracket, optional fan

USB and FireWire bracket USB and FireWire bracket LCD poster, USB and FireWire 
bracket, optional fan

Performance
PC Mark 2005:
CPU / Memory 9689 / 6552 9695 / 6615 9652 / 6453 9625 / 6912
Graphics / HDD 18293 / 7147 18366 / 7014 18462 / 7072 18286 / 6829
Overall 10284 10494 10476 10436
SiSoft Sandra 2008:
CPU Arithmetic (Dhrystone ALU / 
Whetstone iSSE3)

55616 / 44264 55677 / 44051 55477 / 43994 55489 / 44019

CPU Multimedia (Integer / Floating) 330318 / 181063 330650 / 181126 329438 / 180393 328265 / 180298
Drive Index (MB/s) / Random Access Time 
(ms)

73 / 6 72 / 6 72 / 6 67 / 13

SiSoft Memory bandwidth score (Integer / 
Floating)

6787 / 6780 6829 / 6829 6526 / 6576 6587 / 6582

3D Mark 2006 Marks / CPU Score 16829 / 4999 16870 / 4951 16562 / 4827 16627 / 4926
CINEBENCH R10 (CPU) 11366 11849 11856 11714
WinRAR 3.8 2149 2213 2193 1628
Video Encoding (DivX 6.8) Time (sec) 113.4 112.8 113.7 114.3
File Transfer Test (4 GB File) (MBps) 135.8 144.1 138.4 147.1
Doom 3 FPS (1600x1200, 4xAA, 4xAF / 640 
x 480, low detail)

211.5 / 294.9 212 / 295.7 206.4 / 297.5 206.3 / 288.3

S.T.A.L.K.E.R Shadow Of Chernobyl 
(1680x1050, 4xAA, 4xAF / 800 x 600, low 
detail)

179.53 / 679.69 181.07 / 676.24 180.43 / 891.4 180.74 / 892.5

Prey (1680 x 1050, 4x AA, 4x AF, 640 x 
480, low detail)

197.1 / 354.5 210.5 / 356.8 206.6 / 349.2 209.5 / 346.2
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Motherboards                                                                                         Boards above Rs. 18,500

Brand
Model No.

ZOTAC
NF-790i Supreme

ASUS
P5E64 WS Evolution

Gigabyte
X48-DQ6

            ASUS
     Striker 2 NSE

EVGA
132-CK-NF79

Gigabyte
EP45-DQ6

ASUS
P5E3 Premium

XFX
MB-N790-IUL9

ASUS
Rampage Extreme

Chipset NVIDIA nForce 790i Intel X48 Intel X48 NVIDIA nForce 790i NVIDIA nForce 790i Intel P45 Intel X48 NVIDIA nForce 790i Intel X48
Socket LGA 775 LGA 775 LGA 775 LGA 775 LGA 775 LGA 775 LGA 775 LGA 775 LGA 775
Northbridge / Southbridge nForce 790i SLI / nForce 570 SLI X48 / ICH9R X48 / ICH9R nForce 790i SLI / nForce 570 SLI nForce 790i SLI / nForce 570 SLI P45 / ICH10R X48 / ICH9R nForce 790i SLI / nForce 570 SLI X48 / ICH9R
Price (Rupees) 19999 21000 21000 21250 22500 22990 23250 24000 25750
Plus (+)
Minus (-)
Grand Total (Out of 100) 70.58 72.06 73.99 75.54 70.61 74.63 73.21 69.19 77.07
Features (out of 60) 35.07 36.30 38.87 41.27 35.31 40.07 37.68 33.87 41.51
Performance (Out of 40) 35.51 35.76 35.13 34.28 35.30 34.57 35.53 35.32 35.56
Front Side Bus Speed (MHz) 1333 MHz 1333 MHz 1333 MHz 1333 MHz 1333 MHz 1333 MHz 1333 MHz 1333 MHz 1333 MHz
Memory Type DDR3 DDR3 DDR2 DDR3 DDR3 DDR2 DDR3 DDR3 DDR3
Max Memory Supported (GB) / No of DIMMs 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4 8 GB / 4
No. of SATA / IDE Ports 6 / 1 6 / 1 8 / 1 6 / 1 6 / 1 10 / 1 6 / 1 6 / 1 8 / 1
E-SATA Support / No of E-SATA Ports 4 / 1 4 / 2 6 / NA 4 / 2 4 / 1 6 / NA 4 / 2 4 / 1 4 / 1
No of PCI Express graphics slots 3 4 2 3 3 2 3 3 2
No. of PCI / PCI x1 / PCI x4 Slots 2 / 2 / 6 2 / 6 / 1 2 / 3 / 6 2 / 2 / 6 2 / 2 / 6 2 / 1 / 2 2 / 1 / 6 2 / 2 / 6 2 / 3 / 6
Multi GPU Support (SLI/CrossFire/N) / No 
of PCIe Lanes

Y / 3 way SLI, all x16 Y / Crossfire x16 Y / Crossfire x16 Y / 3-way SLI, all x16 Y / 3 way SLI, all x16 Y / Crossfire x8 Y / Crossfire x16 Y / 3 way SLI, all x16 Y / Crossfire x16

Integrated Audio Controller Realtek ALC 888 ADI 1988B Realtek ALC 889A ADI 1988B Soundmax Realtek ALC 888 Realtek ALC 889A ADI 1988B Realtek ALC 888 ADI 1988B
SPDIF / Optical Port 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4
No of LAN Ports / 10/100 / Gigabit 2 / Gigabit 2 / Gigabit 2 / Gigabit 2 / Gigabit 2 / Gigabit 4 / Gigabit, 10/100 2 / Gigabit 2 / Gigabit 2 / Gigabit
Integrated Wi-Fi (Y/N) 4 (kit) 6 6 6 6 6 4 6 6

No. of rear USB / FireWire Ports 6 / 1 6 / 6 8 / 1 6 / 1 6 / 1 8 / 6 6 / 6 6 / 1 6 / 1
All Solid State Caps (Y/N) 6 4 4 4 6 4 4 6 4

BIOS options
Overclocking / Overvolting (So 10) 7.25 / 7.25 8.5 / 8.5 8.5 / 8.25 9.5 / 9.25 7.25 / 7.25 8.5 / 8.25 9 / 9 7.25 / 7.25 9.25 / 9.5
CPU voltage range (volts) 0.5125 to 2.0v 0.85 to 2.3v 0.5 to 2.35v 1.1v to 2.4v 0.5125 ~ 2.0v 0.5 ~ 2.3v 0.85 ~ 2.1v 0.5125 ~ 2.0v 0.85 ~ 2.5v
Memory voltage range (volts) 1.5 to 2.0v 1.5v to 2.78v 1.8v to 3.35v 1.5 to 3.1v 1.5 ~ 2.0v 1.8 ~ 3v 1.5v ~ 2.78v 1.5 ~ 2.0v 1.51 ~ 2.8v
Package Bundle
No of SATA / PATA Cables Provided 4 / 1 4 / 1 6 / 1 6 / 1 6 / 1 6 / 1 4 / 1 4 / 1 6 / 1
CD’s Drivers Drivers Drivers Drivers, STALKER game, 3D Mark 

06 Advanced Edition, 
Kaspersky Antivirus

Drivers Drivers Drivers Drivers Drivers, STALKER game, 3D Mark 
06 Advanced Edition, Kaspersky 
Antivirus

Other Miscellaneous Accessories WiFi kit USB and FireWire bracket USB and FireWire bracket LCD poster, USB and FireWire 
bracket, optional fan

NA USB and FireWire bracket 2-WiFi AP units NA LCD poster, USB and FireWire 
bracket, optional fan

Performance
PC Mark 2005:
CPU / Memory 9666 / 6962 9696 / 6685 9676 / 6282 9711 / 6928 9674 / 6956 9668 / 6324 9703 / 6705 9632 / 6928 9701 / 6695
Graphics / HDD 19517 / 7235 18470 / 6942 18431 / 7108 18372 / 6892 19681 / 7175 18146 / 7080 18539 / 6965 19347 / 7194 18515 / 7050
Overall 10790 10497 10400 10580 10480 10336 10560 10563 10609
SiSoft Sandra 2008:
CPU Arithmetic (Dhrystone ALU / 
Whetstone iSSE3)

55562 / 44230 55267 / 44146 55808 / 44661 55569 / 44021 55564 / 44044 55550 / 44113 55693 / 44250 55527 / 44277 55680 / 44083

CPU Multimedia (Integer / Floating) 329334 / 180379 329963 / 180882 331339 / 181512 328860 / 180022 329506 / 180414 329849 / 180690 330535 / 180426 329393 / 180352 330662 / 181109
Drive Index (MB/s) / Random Access Time 
(ms)

67 / 13 72 / 6 72 / 6 67 / 13 67 / 13 72 / 7 72 / 6 67 / 13 73 / 6

SiSoft Memory bandwidth score (Integer / 
Floating)

7718 / 7709 7300 / 7293 6148 / 6150 6976 / 6954 7731 / 7733 6368 / 6369 7350 / 7354 7566 / 7636 7316 / 7311

3D Mark 2006 Marks / CPU Score 16765 / 4947 16886 / 4990 16860 / 4994 16719 / 4948 16821 / 4969 16587 / 4947 16911 / 4995 16736 / 4983 16862 / 4973
CINEBENCH R10 (CPU) 11838 11844 11812 11647 11842 11786 11854 11844 11852
WinRAR 3.8 2264 2245 1990 1670 2264 2035 2270 2263 2263
Video Encoding (DivX 6.8) Time (sec) 112.2 112.6 111.6 114.8 112.7 114.7 113.9 112.3 113.1
File Transfer Test (4 GB File) (MBps) 144.5 137.5 138.7 146.3 147.6 147.6 144.9 146.3 146.8
Doom 3 FPS (1600x1200, 4xAA, 4xAF / 640 
x 480, low detail)

211.8 / 305.2 211.8 / 303.5 209.2 / 296 207.5 / 284.7 212.4 / 296.3 210.3 / 288.4 213.3 / 299.8 210.4 / 301.4 212.9 / 303.6

S.T.A.L.K.E.R Shadow Of Chernobyl 
(1680x1050, 4xAA, 4xAF / 800 x 600, low 
detail)

180.79 / 906.92 180.63 / 906.68 181.15 / 894.95 180.32 / 893.72 181.44 / 896.5 178.22 / 881.22 181.23 / 916.65 180.5 / 901.45 181.67 / 924.39

Prey (1680 x 1050, 4x AA, 4x AF, 640 x 
480, low detail)

211.1 / 357.5 211 / 356.8 209.9 / 349.4 210.2 / 351.3 210.8 / 354.5 209.1 / 344.7 211 / 359.9 208.5 / 355.7 210.9 / 371.7
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Buying Guide
You need We Recommend Price Why we Recommend it
A well built motherboard that’s not 
too costly and is feature rich, bud-
get Rs 12000

ECS P45T-AD3 Rs. 7,560 It’s the cheapest P45 chipset board around and is 
well laid out and reasonably well built

Something flashy and feature rich 
and fast. I do not want multiple 
graphics card solutions

ASUS P5Q3 Deluxe Rs. 13,850 Extremely well built and very feature rich, very 
fast, lots of flaunt value, overclockable too

An SLI solution that’s well priced ZOTAC NF-780i Supreme Rs. 12,999 Well priced for a 780i solution and a good pack-
age too

A 3-way SLI solution with lots of 
features, flaunt value and great 
build quality

ASUS Striker 2 NSE Rs. 21,250 The most feature rich and well built 790i SLI board 
around, and its better priced than some of the 
other boards that aren’t as good

The Best Crossfire solution around 
but one that’s not insanely priced

ASUS Rampage Formula; 
MSI X48c Platinum

Rs. 17,000;
Rs. 15,000

The former is very well built and feature rich and 
definitely an option for even overclockers as its 
rock stable. The latter is the only board to sup-
port DDR2 and DDR3 making it a very flexible 
solution. And they both do Crossfire with x16 PCIe 
bandwidth

The best board for my Phenom 
Processor

ASUS M3A79-T Deluxe Rs. 11,925 Four-way Crossfire support, plenty of expansion 
options and a well built board; cannot match this 
one for features and price

or they better be built well enough 
to stand rigorous overclocking. 
Yes, this also means large, attrac-
tive and overkill heatsink and 
heatpipe cooling solutions with 
lots of shiny copper — after all, a 
board that costs this much should 
look the part as well.

Gamers and enthusiasts look-
ing for SLI and Crossfire support 
as well as DDR3 will also likely 
find something in the category. 
A total of nine boards featured in 
this category; four NVIDIA 790i 
solutions, four Intel X48 solu-
tions and a single P45 solution.

Features
NVIDIAs 790i SLI is a unique offer-
ing in the way that this chipset 
supports three x16 PCIe lanes 
for 3-way SLI using the full band-
width of the PCIe slot. Both the 
780i and the 790i use the same 
Southbridge, which is nothing 
more than a 570i SLI chip which 
provides the bandwidth for the 
extra PCIe lanes. Three of the 
790i SLI boards from EVGA, XFX 
and ZOTAC are identical in terms 
of build, design and features. The 
only difference is EVGA provides 
better quality SATA and PATA 
cables and ZOTAC provides a 
WLAN AP kit. ASUS’ Striker 2 NSE 
is unique — it’s built around the 
same layout as the ASUS Striker 2 
Formula but supports DDR3. And 

this is the only major difference. 
The build quality is exemplary 
as expected and the CPU region 
is not cramped. The Northbridge 
cooler integrates two nozzles 
that are meant to be used along 
with a liquid cooling kit. In fact 
the heatsink on the Northbridge 
is hollow so it doubles as a water 
block. ASUS allows for very fine 
tweaking of CPU and memory 
voltages; in fact the Striker 2 NSE 
and Striker 2 Formula both allow 
one to fine tune the memory 
voltages in the tune of 0.02 volt 
steps while CPU volt steps are as 
fine as 0.006 volts. The Rampage 
Extreme is based on the X48 
chipset also features the same 
fine adjustment to voltages. This 
board has an even larger heat-
pipe solution that the Striker 
boards and although the gun 
grey fins of the heatsinks look 
cool with the bright post-box 
red bezel atop the heatsink we 
found there to be too little space 
between the mosfet cooler and 
the CPU region. In fact getting 
the LGA 775 cooler on was a royal 
pain and our fingers were quite 
sore from battling with the large 
heatsinks all around the CPU 
region. Anyone who swaps out 
CPUs or coolers will rue this fact. 
That being said the board itself is 
well laid out aside from this one 
fault. The SATA ports are clear of 

the PCIe slot and there are sets 
of three LEDs on the board that 
tell you the extent of overclock-
ing; one each for none, moderate 
or extreme overclocking.

The ASUS P5E3 Premium is 
an X48 based, DDR3 supporting 
solution that’s very easy on the 
eye. It features dual-WLAN APs 
and a really great quality build. 
The heatsink is attractive while 
not being overly blatant; the 
copper is well complimented by 
the shiny blue bezel that cov-
ers part of the cooling solution. 
Even though the cooling solu-
tion is large and surrounds the 
CPU socket on all four sides it 
doesn’t interfere with installa-
tion of the CPU cooler which 
speaks volumes about ASUS’ 
design standards. This board 
also features ASUS’ Express Gate, 
which we discussed earlier. The 
ASUS P5E64 WS Evolution was 
the only self confessed worksta-
tion board in test. We really liked 
the heatsink/heatpipe look. For 
once ASUS decided to ditch the 
copper look and the heatpipes 
and cooling fins are chromed. 
The heatsinks also have shiny 
blue bezels and the overall effect 
this creates is one of supreme 
class. You’ll notice this board 
amongst all the others around 
here. Although the heatpipes 
seem to cramp the CPU region 

at first glance, installation of the 
CPU cooler was quite easy and our 
fingers hardly even touched the 
heatpipes. A PCIe x4 slot is provid-
ed above the primary PCIe graph-
ics slot but the memory banks 
will interfere with longer cards 
that you can place in this slot. 
Surprisingly even this board has 
really decent overclocking options 
(for a workstation board).

Gigabytes two offerings; the 
X48-DQ6 and the EP45-DQ6 are 
X48 and P45 based boards respec-
tively. Shockingly the EP45-DQ6 is 
costlier than the X48-DQ6 which 
is surprising because the latter is 
a full fledged x16 bandwidth pro-
viding Crossfire chipset meant for 
high-end gaming systems. Both 
boards are well laid out although 
the EP45-DQ6 does have an issue 
with the clearance between a full 
length PCIe card and the third 
and fourth SATA ports which 
become unusable. The first and 
second SATA ports are right 
under the card but since they face 
outwards installing a SATA cable 
isn’t an issue here. Even though 
this board has quite an elaborate 
heatpipe solution the board gets 
quite hot. The other three 790i SLI 
boards were from EVGA, XFX and 
ZOTAC; once again all three were 
identical in terms of looks and 
layout, all being designed around 
the reference NVIDIA PCB design. 
Once again ZOTAC bundles a 
WLAN AP kit with their 790i.

Performance
ASUS’ P5E64 WS Evolution was 
the fastest amongst these boards. 
Once again all the X48 boards 
tie up just behind it followed 
by the Gigabyte EP45-DQ6 and 
then NVIDIA’s 790i SLI solutions. 

Surprisingly the 790i SLI does 
manage to impress in the PC Mark 
05 graphics score where boards 
based on this chipset cracked the 
19,000 point barrier. However, 
when we used 3D Mark 06, this 
advantage ceases leaving us to 
wonder what exactly in the bench-
mark favoured these boards.

Winner(s)
Our Best Buy belonged to the ASUS 
Striker 2 NSE. For Rs. 21,250 you 
get a board that supports 3-way 
SLI, is very well built and attrac-
tive looking and even comes with 
the full version of S.T.A.L.K.E.R. 
Shadow Of Chernobyl and 3D Mark 
2006 Advanced Edition, plus  
Kaspersky Antivirus. It also has 
an LCD poster which connects to 
a USB port and displays the POST 
status on its screen; useless some 
might say, but downright funky. 
It’s a feature-rich board that will 
not disappoint someone looking 
for a truly high-end machine. It 
also has a very good audio solu-
tion in the Soundmax ADI 1988B 
chipset, which is much better 
than the other sound solutions 
available with the exception of 
the Creative X-Fi series which we 
didn’t see this year. n

michael.browne@thinkdigit.com
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ASUS Striker 2 NSE

 Contact Sheet                   Motherboards
Brand Company Phone No Email Website

Asus ASUS Technology 022 - 67668800 media_india@asus.com www.asus.in

Biostar Abacus Peripherals 022 - 40914613 megha@abacusperipherals.com www.biostar.com.tw

ECS SES Technologies 022 - 30862500 Jacques.roux@sesindia.com www.ecs.com.tw

EVGA Tirupati Enterprises 033 - 22251192 abhishek@tirupati.net www.evga.com

Gigabyte GIGABYTE UNITED INC 022 - 40633222 vivek@gigabyte.in www.gigabyte.in

Intel Intel Tech. India 9833823474 saranya.rustagi@intel.com www.intel.co.in

MSI MSI India 011 - 41758808 marketing@msi-in.com www.msi-india.com

Palit Tirupati Enterprises 033 - 22251192 abhishek@tirupati.net www.palit.biz

XFX Rashi Peripherals 022 - 67090828 xfx@rptechindia.com www.xfxforce.com

Zotac Top Notch Infotronix (I) 044 - 26616202  sales@zotac.com www.zotac.com
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I want an HDTV. The screen size doesn’t matter
much. Even a 22-inch is sufficient. But I would

like to buy at least a 26-inch TV. The main thing is the
resolution of that TV, because I own an Xbox 360 con-
sole and I want to play games in HD. It should have at
least one HDMI port. I’m looking to buy a Samsung-
LA22A450C1 only because it has a higher resolution
(1680 x 1050). However, other TVs in this price range
offer lower resolution (1366 x 768) and are priced
even higher. Is it the right decision to buy that Sam-
sung TV? My budget is upto Rs. 30,000.

Jatin Mongia

In my opinion, for playing games on a
console, your screen size would be more

important than all other considerations. Since
most large-screen displays support a resolution
of at least 1366 x 768, I think you’re well covered
by even a 22-inch LCD monitor for a PC. Dell’s SP
2208 WFP is a 22-inch monitor with an HDMI-
port priced at Rs. 15,000. The option from Sam-
sung that you are looking at is also good.
Remember that these are PC monitors as their
resolutions are most commonly found on PCs
and not LCD TVs, as TV-based displays have reso-
lutions of 720p, 1366 x 768 pixels or 1080p. If
you’re looking at a 26-inch LCD monitor with a
high resolution, look at ViewSonic’s VP 2650 wb
with a native resolution of 1920 x 1200 pixels
and priced at Rs. 27,000.

I’m using my computer for last ten years. Now it
has become old. So I want to purchase a new one

with the latest components. My hobby is photography,
and I have a Canon PowerShot SX100IS Digital
camera. I need components suitable for photography,
audio-video and games. I want to purchase a 19-inch
LCD monitor, web camera and printer. Please rec-
ommend components that will complement my hob-
bies. My budget is Rs. 50,000.

Ashok R Naik

That is a good budget and you will
notice a manifold increase in perform-

ance from you current setup. I have suggested
a system for you below. I suggest you opt for a
22-inch monitor. The Rs. 3,000 or so more you
pay, is worth it.

I am thinking buying a cellphone priced between
Rs. 8,000 to Rs. 9,000. I want features like a

Ask Agent 001

music player, good camera (3MP) and software
loading with a decent look.

Harsimran Rangi

Sony Ericsson’s K800 might be what
you’re looking for. It’s priced at Rs. 8,000

or so, and with great music quality and a
superb 3.2-MP camera, it may be just what
you’re looking for. The only other phone that
comes to mind is the Nokia N73 and that is
beyond your budget.

I have got Intel 945 chipset motherboard (orig-
inal), 1GB DDR2 RAM. I want a graphics card for

gaming, within a budget of Rs. 8,000. Will my moth-
erboard support a PCIe video card? Which card would
suit me?

Nilanjan Roy

Yes, the Intel 945 board should support
a PCIe card with the requisite slot. I rec-

ommend a 9600 GT-based solution. EVGA is a
good brand to look at and it should fit your
budget. If you can stretch your budget to
Rs. 2,000 to Rs 3,000, you might be able to go in
for a GeForce 9800 GTX or a Radeon 4850 which
are far superior cards.

I want to buy a powerful gaming rig under a
lakh. It will be used only for gaming. Please

suggest a powerful configuration. I also want to buy
a multimedia cellphone. I can spare Rs. 35,000 for
a cellphone. Which is better between a Nokia N96
and an Apple iPhone?

Kshitij Rawat

For the cellphone, I recommend Nokia
for the usability and the iPhone 3G for its

touch interface. They’re both good enough to
recommend. Either way you cannot go wrong.
Although I must say, Nokia’s N96 is the more per-
fect device of the two, especially when it comes
to being a feature-laden phone. For a PC, my rec-
ommendations are given in the box.

Alternatively, you can opt for a Palit Radeon
HD 4870 1GB SONIC, priced at Rs. 18,500
instead of the ZOTAC GTX 280. This card offers
amazing value for money, and you can actually
buy another identical card and CrossFire both
of them for even more performance, although
you would compromise on your budget.

Components My Suggestion Price
Processor Core 2 Duo E8400 (3.0 GHz) 8,500
Motherboard Abit IP35E 4,800
RAM 1 x 4 GB DDR2 800 MHz 3,800
Graphics Card ZOTAC 9800 GTX 10,500
Hard Drive Seagate 500 GB 3,100
Monitor Dell SP 2208 WFP 15,500
Cabinet + PSU VIP Cabinet + 500W SMPS 3,500

49,700

PC Configuration

Components My Suggestion Price
Processor Core 2 Quad Q9550 (2.83 GHz) 17,500
Motherboard ASUS P5Q-E 10,000
RAM 1 x 4 GB DDR2 800 3,800
Graphics Card ZOTAC GTX 280 30,000
Hard Drive Seagate 500 GB x 2 6,000
Monitor LG 246 Wp 24,000
Cabinet + PSU CM 690 + Corsair TX 750 9,500

1,00,800

PC Configuration
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It’s the start of yet another year and
turning to photography as a hobby
might be a good idea. There are so

many cameras in the market, but
which one do you opt for? There’s just
too much to choose from. All through-
out the year, we emphasise on cam-
eras in articles and tests. 

Going shopping for a camera is
first about doing your homework and
being very clear on what you want
from it. Most people purchase stan-
dard point-and-shoot cameras that
are priced any-
where between Rs.
7,000 to Rs. 15,000.
The grey market
prices are obvious-
ly going to be
lower. The entry-
level PowerShot
A470 from Canon is
still available at
just under Rs.
7,000. The
PowerShot A1000 IS
and the very new
A2000 IS have just
been released in
the market for a lit-
tle over Rs. 11,000.
They are 10-MP
cameras with 4x
and 6x optical
zoom lenses.

Canon has been
updating the PowerShot
line of cameras up the price
scale as well. The well-known
Canon PowerShot A720 IS and the
A650 IS are mid-ranged P&S cameras
to own. The prices of these in the
market hover somewhere between
t h e
Rs. 11,000 mark in the grey market.
These cameras both come with 6x
optical zoom which is sufficient for
most purposes. If you want some-
thing a bit cheaper, then the
PowerShot A590 IS is one to look for.
The price of the A590 IS has dropped
to around Rs. 11,500. 

However, if you want a no-compro-
mise P&S camera with a good zoom
lens and a decent-sized sensor, the

new SX110 is the one to look for. It has
a better build and is a better per-
former than the older SX100. Priced at
around Rs. 16,000, it comes with a
pouch and a 2 GB SD card. Look out for
schemes in malls and showrooms
where you get a charger and batteries
along with the camera. 

There are a few new ultrazoom
cameras in the market too. The DSC H7
and H9 from Sony come with 15x opti-
cal zoom. Canon’s S5 IS is still in the
market and can be found at around Rs.

17,000. Canon has begun to phase
them out with the SX10 which has an
incredible 20x optical zoom as com-
pared to the S5 IS’ 12x. If you like to go
for an Olympus ultrazoom, then the
SP565UZ is an interesting model to
look out for. The price is somewhere
around Rs. 20,000.

Compact cameras are available at
under Rs. 15,000 as well. They aren’t
typically liked for performance but for
size and portability reasons. The IXUS
80 and 85 IS are the ones from Canon

priced under Rs. 15,000. Even the
Nikon S52 is available for just under
Rs. 13,000. Clearly, the days of extreme-
ly expensive ultracompacts have
passed. Even Sony’s T77 is not more
than Rs. 16,000 in the market. 

One of the more interesting cate-
gories of cameras is the D-SLR. Prices
have dropped and are now just above
the price bracket for the ultracom-
pact fashion oriented cameras. The
Nikon D40 and the D40X are the
entry-level offering from Nikon.

Rumours are that the
D40 is priced around
Rs. 18,000 in the grey
market, but that’s only
great if you can find
one. If you can’t, then
the D40X is the next
best bet. The Nikon D60
has been brought in to
replace the D40 and
the D40X. Canon has a
few entry-level D-SLR
cameras too — the EOS
1000D and the EOS
400D. Both of these
cameras can be bought
for around Rs. 30,000 to
Rs. 33,000. The lens
supplied with most of

these cameras is
the 18–55 mm
ones. Look out
for shops that
sell you only

the body and give
you the option of selecting

a different lens. Shopkeepers and
photographers will also tell you that
cost of Canon lens is considerably
more than the Nikon ones. 

This month, we reviewed the
Nikon D90 and liked it a lot. We sug-
gest you look out for a Nikon D80. The
D90 replaces the D80, which might
get phased out soon. The prices for
the D80 have been dropping steadily
with the launch of the D90. The D80
body itself in the grey market is
rumoured to be be around Rs. 35,000
and there are some interesting offers
for lenses offered as well.

agent001@thinkdigit.com
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Digital cameras
So many models, so much variety, which one to choose?

Shrikrishna Patkar



Yes, Intel motherboards can be used with
ATI graphics cards. If you’re building your

system for games, then an ATI Radeon HD4870
would be better than the HD4670. The ATI
Radeon HD4850 or the NVIDIA GeForce 9800
GTX are also good cheaper options to consider. 

Currently, the advantages of more memory
and faster bandwidth memory aren’t very visi-
ble. In short, 4GB of DDR2 will be cheap and
much more than sufficient, for any kind of
desktop applications including multimedia
content development. It also works out to be lot
cheaper than 4GB of good DDR3 memory. For
general desktop use, 2GB of DDR2 will do too.

If you purchase a high-end graphics card,
then you need a 600W PSU at least. The Corsair
HX620 is a well known model.

The P45 chipset doesn’t come with an
onboard graphics chip. For onboard graphics
from Intel, look for an Intel G45-based mother-
board. The recently released GeForce 9300-
based motherboards from NVIDIA also have
onboard graphics.

Gaming problem
I brought four original games.  Far Cry was
one of them, and it runs smoothly in my

computer. Resident Evil 4 gives me an
error saying that game.exe has
encountered a problem and needs
to be closed. Devil May Cry 3
Special Edition also has the same
problem as Resident Evil. Splinter
Cell Chaos Theory also gives an error
saying that my graphics card doesn’t
support Pixel Shader 1.1. When I run the game
detection utility, it says that I have the minimum
system configuration to run this game. What
should I do?

My system configuration is as follows:
Processor – Intel Core 2 Duo
Motherboard – Intel DG31GL with 256MB

chipset graphics 
RAM – 1GB DDR2

Dimitri

For the games you’ve mentioned, you
should use a dedicated graphics solution

and not an onboard G31-based solution. Invest
in a PCI-E graphics card such as a GeForce 9600
GT, which can be bought for around Rs 6,000.
This will run these games for sure and also
allow you to run them at the best resolution
and quality.

100% CPU utilisation
I have a Pentium 4 2.80GHz, 2GB RAM desktop
with a 500GB HDD running a licensed copy of

Windows XP with Service Pack 2 installed. Of late, I
find the PC responding to commands after a

considerable delay. The CPU usage shows
100% and the fan runs at full speed. I

use the PC mainly for word process-
ing, data processing and playing
some music and movies.

Soma Dutta
The slowdown is most
likely to be some kind of a

virus or trojan. Open up the Task
Manager and look for the processes using the

most resources. Also scan your system for
viruses. If that doesn’t work, try reinstalling the
motherboard drivers.  

Overheating processor
My system uses an Intel Core 2 Duo, an Intel
945 motherboard, 1GB RAM and a 160-GB

HDD. My system shuts down due to the overheat-
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DVD burning takes too long
I have a problem with my computer. The DVD
burning process takes too long on my system.

My system configuration is an Intel Core 2 Duo
processor, 1 GB RAM all running on an original Intel
945 motherboard. I used to burn DVDs using Nero
7, but now it takes more than an hour to burn.
Please give me a solution for this problem.

Lakshmikandh K

The slow DVD burning speed could be due
to a faulty driver or software. The easiest

thing to do is uninstall the drive from the
device manager. If you’re running Windows XP,
go to Start > Control Panel > System.

Click on the Hardware
tab and then on the
Device Manager button.
Double-click on DVD /
CD-ROM drives heading,
right-click on your DVD
drive and click
Uninstall. Reboot and
let the drive be auto-
detected again. Also, try
uninstalling Nero and
reinstalling it. Try using
other software and
different media. If noth-

ing works, it could be a failing drive. Try the
drive on another computer to verify this.

Doubts on memory and 64-bit
computing

My 3-GHz Intel processor supports 64-bit, but
the Windows XP version I'm using is 32-bit.

These are my questions.
1. I want to buy additional RAM. Will my system

support DDR2 RAM? If not, specify which DDR1
RAM will be best and its price?

2. Can I use both (512 MB/1 GB RAM) with my exist-
ing 256 MB RAM?

3. After installing the RAM, how can I use my PC

with best performance and best
visual effect?

4. Does the paging file affect
computer performance? Please
specify how much paging file &
virtual memory I will use after
installing the extra RAM?

Antu Kanta

Your current motherboard
supports DDR1 memory

upto DDR400 only. DDR RAM is
expensive today and not easily
available, so you will have to
look around. 

The motherboard you use
supports upto 2GB of RAM. To avoid
any complications due to compati-
bility issues, use the same brand of
memory. 

The settings for best visual effect
and quality can be enabled by click-
ing on first going to the Advanced
tab under Device Manager in the
Control Panel. Click on the Settings
button under Performance, and
click the radio button for Adjust
for best appearance.

The paging file doesn’t directly
affect performance, but it can be
used when your system runs out of
physical memory.  You can allot
2–3GB of space for the page or even
let Windows set the page file size for
you. 

Problem regarding flash
I have a Sony Digital Cybershot DSC-H9
camera. My problem is that its flash has

stopped working. Instead, it shows me E:91:01 on
the screen. My friend says that this is an error.
Please help me out

Rohit Kumar

Your friend is right. E:91:01 is an error
code. In this case, it is to do with the flash.

You need to take your camera to a Sony service
centre to get the flash repaired or replaced. 

Need suggestions for purchasing
hardware

I want to buy a desktop with the following
configuration

Processor: Intel Core 2 Duo E8400
Motherboard: Intel DP45SG
Memory: 8 GB DDR2 800 Mhz
HDD: Seagate 320 GB HDD
Graphics card: ATI HD 4670 
Optical drive: Samsung DVD writer
I have four questions
1. Does an Intel motherboard and processor

support ATI graphics cards?
2. Which is better - 8 GB DDR2 or 4 GB DDR3 RAM?
3. What power supply unit should I use?
4. Will this motherboard work without a graphics

card?
I would like to know your suggestions. 

Athiq

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@tthhiinnkkddiiggiitt..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Reinstalling my operating system
I have an Intel Core 2 Duo Processor (1.86 GHz) and a
Foxconn motherboard based on the Intel 945 chipset. I

have two Western Digital hard disks of 320GB each. In the first
hard drive I have installed XP Professional and in the second
one I have installed Vista Ultimate. Now whenever something
seriously goes wrong with any of my operating
systems, I go in for a fresh installation. But
when I install a fresh copy of XP on my hard
drive, the Windows Vista Boot Manager is no
longer accessible. I’m no longer able to boot
into Vista without installing it over again. My
question — is there any way to bring back the
old Boot Manager without installing another
fresh copy of Vista?

Swaranga Sarma
You don’t have to reinstall Vista every-
time you reinstall XP. If you have more

than one operating system on your
computer, you can set the one that you want
to use as the default one, for when you start
your computer by following these steps.

Go to Start > Control Panel. Double-
click on System. On the Advanced tab, under
Startup and Recovery, click Settings. 

Under System startup, in the default oper-
ating system list, click the operating system
that you want to start when you turn on or
restart your computer.

Select the list of operating systems for check
box, and then type the number of seconds for which you

want the list displayed before the
default operating system starts automat-
ically. 

There’s another way to get it
running. 

After installing one of the operating
systems, insert the bootable CD / DVD of
the other operating system. When you
reach that screen with the option to
Install Windows XP / Vista or Repair
Windows. Select repair your system.
Now you will reach a prompt.

Type fixboot and press [Enter].
Enter Y to confirm the command.
Next, type fixmbr and follow the
same steps.

Restart, and both your operating
systems should be accessible.

Danish Chopra, TECH QNA Expert

All your computing niggles and nags
are dealt with here!

Your Questions, Our Answers

Removing a drive so that it
can be detected

The GeForce
9600GT - an
affordable
graphics card

Question 

of the

Month

Bootup Settings can be changed in
the Startup and Recovery

Performance and Quality settings for
Windows

Virtual memory can be set manually as well
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ing processor. Please give me a solution to
prevent it.

Aayush Lilhare

There are some things you can do to keep
the temperatures down. Firstly, clean up

the heatsink if the fins on it are clogged with
dust. If the heatsink isn’t tightly hugging the
processor, then temperatures can go out of
control. If you remove your heatsink, apply a
thin layer of thermal paste before you put it
back on. There are also third-party coolers that
you can buy which offer better cooling than
stock ones.

Multiple problems
I have noticed that the Windows XP SP2 32-bit
version is a bit slower than Windows XP SP2

64-bit version. Why is this so? Is there any way I
can run a Turbo C compiler on 64-bit Windows XP?
How do I speed up my XP 32-bit installation for my
configuration? Booting takes around 30 sec to
display on the desktop. What can I change to
achieve a faster boot without using any third
party software?

I’ve noticed that my CPU temperature always
stays at around 33 to 38 degrees and motherboard
at around 38 degree. I hope these are safe temper-
atures. I don’t have an airconditioner in my room.
I have three 120-mm and two 80-mm fans
installed in my cabinet as suggested by the manu-
facturer.

Samir Ranjan Ray

The slowdown could be due to several
reasons. Update the drivers for your moth-

erboard and graphics cards to see if it helps. To
be able to run Turbo C on 64-bit Windows, you
will need to download and install free software
called DOSBox (www.dosbox.com) which
emulates DOS. It is used to run DOS games on
Windows systems, but can also be used to run
DOS applications.

The time taken to boot up Windows could
be due to a highly fragmented hard drive. Try
defragging the drive and uninstall unnecessary
applications. Using a registry cleaner can help
a little bit as well. If your system doesn’t have
enough memory, then that could be the root of
your problems. 

The temperatures for the motherboard and
processor are perfectly fine.  Temperatures of
33 to 38 degrees are very cool for a processor
and even a motherboard with no aircondi-
tioner running. 

Sharing Internet connection with
a laptop

Hi, I have recently bought a Sony VAIO laptop
preloaded with Windows Vista Home

Premium. The problem is that my broadband
connection is connected to my desktop PC that
runs Windows XP Home Premiun. How can I
connect my laptop to my desktop so that I can
have acces to the internet using my laptop.
Preferably, I want a wireless connection between
the laptop and the desktop, but a wired connec-
tion will also do.

Nimesh Kumar

The simplest and cheapest way to get wire-
less networking between the two systems

is to install a wireless network adapter for the
desktop. These are cheap and can be bought
for under Rs 1,000. If you want a wired connec-
tion, get a crossed-cable and connect the two
machines. If you have any more wireless
devices, then you should go for a wireless
router. These are available for around Rs 2,500
or so. 

SLI or single card graphics
solution?

I’m assembling a machine. I want to use this
system to use use 3ds Max, Premiere Pro, etc.

I also want to play games like Crysis, Frontline, Far
Cry, etc. So my question is, should I go for an SLI-
ready motherboard and SLI with XFX 8600 GT, or
just take a good motherboard with only one PCI-E
and use only one XFX 8800 GTX. Please suggest
which one would be better. Also, suggest me a
good power solution. I’ll be using an Intel Core 2
Quad Q6600 along with two 2GB 800 MHz DDR 2
RAM sticks. 

Lileshwor Sharma
It is wiser to go for a single fast card. You
can still choose to go for a SLI mother-

board, which will allow you to add an addi-
tional card in the future.  SLI might not scale
equally well across all games, but a single card
will. Cards like the GeForce 9800GTX and the

Radeon 4850 are powerful and are consider-
ably cheaper than they used to be.

Accessing secured sites on phones
I want to access secured websites on my
smart phone without any trouble. Can you

suggest a phone along with recommended soft-
ware that will let me open secured sites (https)
and use every feature that I can perform on my
PC?

I had a word with the customer care of a bank.
They said that I would not be able to do that on the
cellphone or a smartphone.  Which phone do you
suggest (Symbian, Palm, Android or Windows
Mobile) for the above mentioned task?

Nokia N95, N79, N85 and N82 have fully
supported browsers to access these web

sites. However, some banks require Java plugins
and are not fully compatible with mobiles.

Anoop Gupta, TECH Q&A Expert

Internet on the desktop using a
phone

I want to know how to play AVI files in my
Nokia 6233 Series 40 phone. Can you suggest

some kind of gadget, which when connected,
allows me to connect to the internet through USB
for my desktop?

Vineet
I don’t think there are any Java-based
media players available with which you

can play AVI files on your mobile. You need to
convert your videos in 3GP or MP4 formats to
play.

You can connect your mobile using a data
cable connected to your computer and get it
connected with Nokia PC Suite. 

Anoop Gupta, TECH Q&A Expert

Increasing video memory on my
laptop

My laptop is an HP-Compaq NX6120, which I
bought two years back. It came with 256MB

RAM. At that time, my video memory was
displayed as 64 MB. Recently, I had put in an addi-
tional 512MB RAM, after which my video memory
became 128 MB. I want to know whether if I can
add another 512 MB and will my video memory
then become 256 MB? Is there any other way of
increasing my video memory to 256 or 512MB?

There is a setting in the BIOS. You just
need to choose the appropriate amount of

memory, which you intend to use as video
memory. Reboot and your memory will be
increased. 

Gopi Krishna Arumugam, TECH Q&A Expert

Forgot my BIOS password!
I have an ASUS M2NVM-DVI motherboard
with an AMD Athlon X2 Processor. As a result,

I’m unable to boot at all. Can you please suggest a
solution to this problem? 

This is a general problem with all mother-
boards. Take out the battery and press the

[Del] key till it goes into the BIOS. Save changes,
then replace the battery and continue. 

If your system is still not booting, then you
have to take out the RAM and any other PCI
cards. Clean them and replace again. Your prob-
lem should be solved. 

N.Vinay Kumar, TECH Q&A Expert

Doom running on Windows under

Nokia PC Suite gives all kinds of access to your mobile
phone

Ad hoc networking options in Windows XP

Setting amount of memory dedicated for graphics in
the BIOS

An old CMOS battery is usually to blame for troublesome
booting



abstract brushes you have down-
loaded. To do this, click the small
arrow (#7 facing down in main image)
next to the brush size once, and then
the arrow facing the right. This gives
you a dropdown menu from which
you select the abstract brushes.

Step 4: Now select one of the brushes
from the abstract set and stroke the
first layer with black. Now hit X. This
switches between the colours on the
palette (#4 in main image), and gives
the next layer a stroke with white. Do
this for all the six layers. You can also

create a new set of layers and choose
another brush and repeat the same
procedure for a more variant back-
ground. 

Step 5: Create a new layer and apply
the image. To do this, go to Image >
Apply Image on the menu bar. Now
click the dropdown from the layers
window which says Normal and select
Soft Light.

Step 6: Again apply
the image on a
new layer and then
go to Filter >
Distort >
Ripple. Keep the
setting at 55% and
size set at Small
for a nice subtle
ripple texture. 

Step 7: Now to add
a render. A render
is the cutout of an
image. This could
be a celebrity,
game person, etc.
Select the eraser
tool (#2 in main
image) and set the
opacity to 50% and

erase a bit of the render outline. This
helps to merge the image with the
background. After doing this, click
[Ctrl] + [J] which makes a duplicate
layer. Now you have to click [Ctrl] +

[Shift] + [U]
which desaturates
the colour from
the selected layer.
Reduce the opac-
ity of this layer to
60%. 

Step 8: Lighting is
an optional step if
you are one of
those who opt for
renders in their
signatures. Select
the brush tool,
and choose the

basic brushes in the same way you did
with Step 3. Now choose a soft brush
and set the size between 100 and 120.
On a new layer, just click once near
the render, where you need the light-
ing to be placed. Adjust the opacity of
that layer and you can even change
the filters to match your signature.
We set the opacity to 70% and used
the Overlay filter for our lighting
layer. 

Step 9: Now comes
the finishing
touches. Click the
Layer adjustment
tool (half black-half
white circular
button at the
bottom of the layers
window — #5 in
main image) and
select Curves. You

can mess with this, or just
click on Auto to correct your
image. Repeat the same thing,
only with Levels this time.
Finally, you can apply a Photo
Filter, which you can find with
the same set of options. We
used a Cooling Filter (82) at
25% density with Preserve
Luminosity selected. 

Step 10: Now to add a border. Apply
the image on a new layer and go to
Edit > Stroke and use 2 pixels as
the settings with centered selected.
This step is optional, but adds a good
effect to the signature. Some signa-
tures look good without a border,
while others don’t. Also, the back-
ground colour of the forums you are
planning on using the signature on,
also matters. If the forums have a
dark background, you should use a
white border so that your signature
can stand out and vice-versa. 

Step 11: You are free to even add your
computer specs to your signature. Just
use the Text tool (#3 in main image)
and adjust the font and font size and
fill in your details. 

Lastly, just save the image you
created, as a JPG or PNG file. Some
forums allow you to upload images
from your PC directly, while others
need you to enter it with a BB code.
Don’tworry about this either, just
upload your created signature to
www.imageshack.us or
www.photobucket.com and you’re all set
as they provide you with the required
links to your signature. 

There’re many variations to the
steps we’ve given you. For example,
instead of a single colour, you can
actually add a gradient layer using
the same layer adjustment tool
before your photo filters. You can
also add your text before you start
with the finishing touches, if you
want it to blend in more. However, at
the same time, keep it as simple as
possible. 
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Kumar Jhuremalani

Image signatures are fun and
trendy to use as a signature with
emails, or, on a forum. You can

choose from a variety of images that
suits your taste, with the text ranging
from your name, to your PC configu-
ration to even the games you play.
Here, we will show you how to make a
basic image signature using
Photoshop that you can add to our
very own ThinkDigit forum. 

A few basics concepts on flow,
colour and lighting, before you start.
It’s not about adding images and
jumbling everything, but rather focus-
ing on creating your signature in a
single flowing direction. This should
also match your render image. Always
keep the colours simple. We’ve
created more of a monotone signa-
ture as you will see. Lighting is a
crucial part in the process as it
enhances your overall signature and
also gives it some depth. It is one of

the most basic as well as
one of the toughest and
critical parts to add to a
signature.

Go to
www.deviantart.com and
search for abstract
brushes or abstract
grunge brushes and
download them. You will
also need to choose an
image render which you
can easily acquire from
sites like www.planetren-
ders.net.

Step 1: Create a new PS image with
the dimensions 350x120 pixels with a
transparent background. You can vary
the dimensions according to your
choice, but make sure it’s not too big
as most forums have size restrictions.
The ThinkDigit Forum’s signature size
is limited to 500x100.

Step 2: Make sure your colours are set

to default. If they are not just click D.
Now go to Filter > Render >
Clouds. This will give you a basic
background to your signature. 

Step 3: Create six layers (see #6 in the
main image). If your layers window is
not open, go to Windows > Layers
from the menu bar. Now select the
brush tool (see #1 in the main image),
and change the brush set to the

create a Basic Image Signature using
Photoshop
Create a Basic Image Signature using
Photoshop

A basic overview of Photoshop and the tools needed for creating the signature

Abstract brush strokes on six different layers

The ripple effect settings

Blending the render with the signature

The final outcome should look like this

Creating your Photoshop document 
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Prevent Paper JamsPrevent Paper Jams

Siddharth Parwatay

PC LOAD LETTER is perhaps the
single most annoying error
message from modern technol-

ogy. It’s been the cause of much stress
in most workplaces. If you’ve found
yourself promising to throw the
printer off the 18th floor window the
next time there’s a paper jam or
printer malfunction, then you’re not
alone. But before the printer bears the
brunt of your ire, here are some
precautions you can take. 

Loosen the sheets 
Often, sheets tend to be stuck to each
other, so while loading paper ensure
you fold the stack with the objective
of loosening the sheets. The quickest
way to do this is to roll the stack diag-
onally twice in opposite directions.
You may have seen your local photo-
copier do it each time he loads the
photocopy machine.

Store in a cool, dry place
While printer sheets are in storage,
make sure the packet is protected
from humidity. We recommend stor-
ing paper in a ziplock bag with a
small pack of silica gel.

Do not overload sheets
If your printer has a paper tray,
don’t fill the tray to capacity. If
you’re encountering frequent paper
jams, reduce the amount of paper

you place in the tray each time it’s
filled.

Slider and tray alignment is important
Make sure the tray feeding the paper
into the printer is aligned properly
and / or the slider used to hold the
paper in place in the tray is snug with
the paper. Many printers have sliders
that allow different types and sizes of
paper to be fed into the printer. If the
slider is not properly positioned it can
cause paper jams.

Which paper?
Use standard office paper — folded
paper, paper with labels, and specialty
paper such as hard bound paper can
often cause paper jams. Your printer
documentation will list the types of
paper compatible with your printer.

Don’t mix-n-match
Do not mix the types of paper you’re
feeding into the printer at one time. If
you need to change the type or size of
paper, remove any other paper
currently in the printer before insert-
ing the new paper.

Look under the hood
Examine the printer for any previous
stuck paper in the printer. Previous
paper jams, torn paper, printing
labels or other foreign objects in the
printer can cause reoccurring printer
jams.

Keep the Printer Clean
Dust, ink or toner buildup inside the
printer can lead to jams, and even
lessen the print quality. Most printers
have a built-in cleaning system. The

printer may run several pages
through the printer during the
cleaning process. Your printer’s
user guide may also advise you to
dust the outer parts of the
printer, including the paper trays.
But remember to use only recom-
mended cleaning agents.

Get to know your printer
As you use your printer, you may
notice that it often jams when
printing on certain types of
paper, or may be loading in a
certain way works better. These
quirks can be annoying, but you
can often save time (and effort)
by keeping these in mind. 

Annoying isn’t it?

PC LOAD LETTER is an error message
encountered when printing on older HP
LaserJet printers such as the LaserJet II,
III, and 4 series. The phrase is a pop joke
and cause for much confusion among
computer users because most users
could not (and still cannot) decipher its
meaning. It simply means that the
printer is asking for it to be refilled with
paper of the standard size “letter”. The
term was popularised by the comedy cult
film Office Space in which one of the
main characters on encountering the
error message asks, “‘PC Load Letter’?
What the #*%& does that mean?” The
message appeared on the display just
after he had filled the printer’s cassette
with blank paper. Frustrations such as
this led the main characters of the film to
take revenge on the malfunctioning
printer by destroying it in a vacant field
with a baseball bat.

Trivia
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Nero 9

Nero 9 is the latest version of the
world’s most widely used disk
burning software. It has several

new features, and can easily handle all
your burning and ripping needs.
Advanced options are available for
powerusers. There’re increased
multimedia and file management
capabilities. The control centre for the
suite, called StartSmart has been
upgraded with more options available off
the main interface. The only downside is
that there is an extra-long installation and
start-up time. Use our December 2008, By

Demand DVD for installing a trial version
of all Nero applications discussed here. 

Customising StartSmart with
Nero applications

StartSmart allows you to customise the
control centre, by adding the most
widely used applications by individual
users. Click on the Add / Remove
button in the Launch Application bar.
From the Add / Remove Applications
dialogue, check the applications you
want to display in StartSmart, and click
on OK. You can select upto ten
applications to display in StartSmart.  

Using the RSS feature in
StartSmart

StartSmart has a nifty little RSS feature
that allows you to subscribe to news
feeds during your burning activities. By
default, the feed reader is set to update
feeds from the Nero website, which
shows up on the bottom bar of
StartSmart. Go to Menu > Options >
News Feed or click the News button.
Click on Subscribe and paste the
address of the feed in the Add
Newsfeed dialogue box. Click on OK.
You can add a number of customised
news feeds. To increase the frequency at
which the feeds get updated, reduce the
News display interval from a default of
five minutes to a minimum of one
minute.  

Using the file recovery
options of Nero

Nero allows you to recover deleted files
from almost all kinds of memory
storage devices. This holds true for USB
drives, Digital Cameras and PMPs, apart
from your hard drive. To recover your
files, either start up Nero RescueAgent
or navigate to Back Up > Recover
Data in StartSmart. Select Deep
Scan, and then click on Next. A list
of all recognised deleted files will be
shown. Select the files you want to
recover, enter a destination directory
and click on Next. Select the
destination directory in a different
partition or hard drive to optimise the
chances of safe recovery. There are
advanced options for corrupted files or
files with invalid names.

Burning a Slide Show of 
your photos

Nero lets you burn a DVD or VCD
customisable slideshow of your photos.
You can add transition effects, record
an audio commentary and add music
to your slideshow. In Nero StartSmart,
go to Create and Edit>Make Photo

SECRETS THAT KEEP YOU AHEAD IN THE RACE
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tweaking the read speeds of your
disk drive. This can be used for a
number of purposes, including
reducing the noise your drive
makes and improving read
quality of the audio CDs. A slower
drive speed reduces noise while
increasing the accuracy of the
reads. A higher drive speed is
used for rapid file access,
especially in applications such as
games. There is also an option to
reduce the spin down time of the
disk in the drive. However, this
does not have any advantage for
the newer drives. In earlier
drives, this helps by ejecting the
disk after a read operation. This
feature is used to control how
long the disk continues to spin
inside the drive after the read
operation has been stopped. 

Disabling disk ejection
If after burning a disk, you want

to check your data once, you can save
time by disabling disk ejection after
burning. This also saves you the
incovenience of closing the tray as
soon as it is ejected. In Nero Express,
extend the side panel, go to Options
> Expert Features then select the
Do not eject the disk after
the burn is complete check box. 

Using InfoTool
Nero InfoTool is a useful little

application that can summarise all the
hardware and software features and
specifications in your computer. The
results can be used to analyse the
multimedia capabilities of your
system, as well as the points where
upgrades are necessary to suit your

requirements. The tool lists the
drivers, the audio and video codecs
installed, the features of the drive and
the nature of the disk in the drive.
Before using this tool, close all
programs, put in a blank CD / DVD in
the available drives and disable any
drive emulators that are running. Start
Nero InfoTool, go to Nero9 > Extra
> Nero InfoTool or Nero9 >
Nero Toolkit > Nero InfoTool
depending on your installation. The
application will analyse the computer,
and show you the results. 

Benchmarking your CD / DVDs
You can run advanced quality

tests on your storage medium to check
how well preserved the files are. While
the benchmark runs for blank media
as well, the disk quality test runs only
for media with files on them. Run
Nero DiscSpeed then go to Benchmark
> Start or Disc Quality >
Start. You can choose how thorough
the tests are. The light test checks only
specific points of data on the disk,
whereas the thorough test scans
through all the tracks on the disk. 

Overburning your disks
Overburning is used to burn more

than the normal amount of data onto a
disk. The extra space used is the lead
out portion of the disk, where about a
minute and a half of extra music can be
burnt (about 5 to 10 MB in a CD). Using
overburning for any other purpose apart
from music is too risky as there is a

go to Insert > ScratchBox clip.
This brings up the ScratchBox dialogue,
which has two turntables. You can mix
tracks, tweak tracks, add effects,  work
with loops and scratch. While the setup
can be used for DJing live, (there is no way
to quickly load files though), the primary
purpose is to remix tracks and save them. 

Changing the audio
distribution with SoundTrax

Nero SoundTrax automatically detects
the numbers of speakers connected to
the system. This works for 2, 2.1, 4.1,
5.1 and 7.1 systems. The numbers
signify the speakers connected to your
system plus the sub-woofer. The area
below Assignable Effects with the title
bar of the file you are working with,
has a pan slider. Here, the number of
speakers connected to the system are
represented spatially, and a green dot
can be moved around the square to
denote the origin of the sound. 

Enabling Quiet Disk in
ShowTime

Although no one is likely to use Nero
ShowTime as their default audio CD
player, we wish other software would
include thoughtful features like this.
Quiet Disk playback silences the sound
from the CD / DVD drive as much as
possible while playing back songs from
the drive. To enable this feature in
ShowTime, go to Options > Quiet
Disk Playback > Enable Quiet
Disk Playback. To navigate to the
Options menu across software in the
Nero 9 suite, click on the hammer icon. 

Setting a drive speed using
DriveSpeed

Nero DriveSpeed is an application for

Slide Show. Alternatively, start up
Nero Vision, go to Make Slide Show.
Click on either DVD, VCD, Super VCD
or Mini DVD depending on your
choice. Drag and drop photos in the
editor. Add music and / or
commentary. You can import pictures
directly from a digital camera attached
to the computer, or add images from a
website or image hosting account. Also
set the transitions. There’re few
options available, but they’re effective.
Once the photos are arranged in the
right order, you can export the
slideshow as a video instead of burning
the slideshow onto some medium.
Click on Export, then select the file
type and click on Export. For this,
AVI, MPEG and WMV formats are
supported. You can also export the
slideshow to a camcorder connected to
the computer. To burn a DVD, click
Next to add titles. Click Next again to
set up the DVD menu, add chapters
and configure the DVD. The next
screen gives you a preview of the DVD,
as it will appear on your television.
Click on Next, then Burn.

Using pause detection in 
Nero WaveEditor

If you have a single sound file of an
entire album, Nero WaveEditor can
recognise separate tracks in the song
using the pause detection feature.
Once these pauses are recognised,
either the pauses can be deleted from
the file, or the file can be separated
into individual tracks. To delete the
pauses from the file, Go to Edit >
Pause Detection > Delete
Pauses. To mark portions on either
side of the pause, go to Edit >
Pause Detection > Insert
Track Splits. This allows you to
extract individual tracks from the file.
To get rid of pauses, go to Edit >
Pause Detection > Insert
Track Splits and Delete
Pauses. This introduces markers so
that individual tracks can still be
worked on.  

Inserting a test signal in 
Nero WaveEditor

A test signal is used to test if the
sound for the presentation or video is
working properly while screening it
before an audience. It is invariably
placed at the beginning of the
presentation or video. To insert a test

signal in Nero WaveEditor, select the
entire sound file, go to Edit >
Insert Test Signal. In the test
tone generator dialogue, select a
duration for the test signal. The
default is 30 seconds. There are three
different waveforms available — sine,
sawtooth and square. These are just
different ways of generating the tone.
The start and end frequency generates
a sweep either increasing or
decreasing in frequency across the
duration of the test signal. To generate
a tone of constant frequency, keep the
values the same across both these
fields. Click on OK, the test signal will
be inserted at the beginning of the
selection. 

Creating an image file
An Image file is a package of data

that can be transferred in portable
media like an external hard drive or a
USB drive. An
image file can be
handled like a zip
file, and can be
loaded as a disk
on the computer
using a CD / DVD
Drive emulator.
This feature can
be particularly
useful in
computers
without a CD /
DVD writer, where
a package can be
made for writing
to a disc later on,
or from another

computer. In
Nero Express,
after adding files
to be burned, set
the Current
Recorder to
Image
Recorder
[DVD]. Select a
disc name, and
click on burn. An
image file will
be created on
your system. You
also have the
option of
burning image
files from other
Nero
applications like

Nero Vision.  

Saving a CD / DVD as an 
image file

You can save CDs and DVDs that are not
copy-protected, as an image file on your
computer. This image file can be used
to burn multiple copies, archive
important data, save media from
physical corruption and load data onto
emulators while keeping the drive free.
Using this feature on copyrighted
material is illegal, even if the data is
not copy protected. Extend the side
panel, go to Copy Data Track. Select a
track from the list in the dialogue that
appears. Then click on Next. The image
can be saved as an NRG or an ISO file.
Select a destination and click on Save. 

DJ with Nero
Nero 9 comes with a complete DJ

simulator. Start up Nero SoundTrax, then

Vol 9: 3Vol 9: 2

Adjusting the drive speed

Nero InfoTool analysing the computer

The tone generator

DJing with Nero
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Importing calendar from
Google Calendar

To import your Google calendar into
Sunbird, go to File > Subscribe
to Remote Calendar.  Select On
the Network and click on next.
Select the CalDAV format, and enter
the URL of your Google Calendar in the
Location field. This url is
https://www.google.com/calendar/dav/
username@gmail.com/events. Replace the
username with your user name. Type in
a name for your calendar and click on
next. Your Google calendar will now be
imported into Firebird.  

Using the Taskbar
The taskbar is on the bottom left

corner of the Firebird window. This
taskbar is used for organising your
tasks. As soon as a task is complete, you
can check on the task, and a
strikethrough will appear. Right-
clicking and selecting Progress will
allow you to set a percentage of
completion. The percentages are preset
and cannot be modified.

Changing the date 
display format

Go to Tools > Options >
General. Now change the Date Text

Format as per your preferences. There
is a long date format and the short
date format available. However, the
dates are always displayed in the
American format — mm/dd/yy. You
cannot change this to the dd/mm/yy
format used in India.

Adding Indian Holidays
The default calendar has no

holidays noted. Adding holidays will
create a small text field below the

important dates of holidays. Holiday
files are available in the .ics format. A
list of holidays for all countries is on
http://www.mozilla.org/projects/calendar
/holidays.html. To import Indian
holidays into Sunbird, go to File >
Import, type http://www.mozilla.org/

projects/calendar/caldata/
IndiaHolidays.ics in the
destination field and click
on import. Select the
calendar you want to import
the calendar file to (home
by default). The holidays
will be listed on the relevant
dates. 

Snarfer
Snarfer is the most
used RSS feed reader
around. The feed
reader offers a feature-
rich, but clean

interface. The download
is just 400 KB, available from
www.snarfware.com. 

Archiving all posts 
of a feed

If there is any syndicated content
that you happen to particularly
like, or find useful, you can choose
to archive all the posts from that
source. Once the feed is added to
your list, right-click on the feed
and go to Properties >

Updating > Keep old messages.
In the drop down box, select keep
everything. Please note that this
option doesn’t allow you to gather past
posts from the source. 

Backing up your feeds
If you’re a heavy feedreader, then

chances are that you will have taken a
lot of time to select and organise feeds.
You don’t need to lose this if your
computer develops a problem. Export
your feeds by selecting File >
Export To > OPML Feeds. A
dialogue will appear showing a list of
all the feeds you have collected. Check
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high scope for losing data. However, if it
is a small file, then it can be
accommodated. Nero lets you find out
exactly how much data can fit in. Test
the overburning capacity of your media
by starting up Nero DiscSpeed. Go to
Extra > Overburning Test. This
will take some time as Nero DiscSpeed
simulates a complete write of the drive.
It lists the capacity, the maximum
amount of data that can be
accommodated, and the extra space
available for overburning. In Nero
Burning ROM, go to File > Options
> Expert Features and check
Enable Disk-at-once CD
overburning or Enable DVD
overburning and click on apply. 

Mozilla Sunbird

Mozilla Sunbird is a calendar
application from Mozilla. It can
be used for task management for

a team or an individual. The calendars can
be published online, and there are remote
access usage options available. The
application is free, open source and
available for all platforms. The 5 MB
download is available from
www.mozilla.org/projects/calendar/

sunbird. A portable version of the
calendar is available from
http://portableapps .com/apps/
office/sunbird_portable.  

Adding Saturdays to
the Calendar

By default, both the weekend days
are turned off from display.
Although they are shown in the
calendar and can be worked on,
they are shown with a grey
highlight. To change this, go to
Tools > Options > Views

and check Saturday. You can also
change the duration of the working hours
(which is by default from 8 to 5). 

Colour coding categories
It is possible to add colour codes to

categories. There are a number of preset
categories, and adding a particular
colour to a category can be of individual
significance (like red for an anniversary).
Go to Tools > Options >
Categories and add a colour to the
preset categories. There are 70 colours
available to choose from. You can also
add or delete categories from this view. 

Setting tasks to repeat
Right-click on a day, and select

new task. Under repeat, set a
periodicity. This can be either daily,
weekly, bi-weekly, monthly or yearly. 

Setting a proxy connection
If your workplace uses a proxy

connection for the internet, these
settings have to be specified in Firebird,
so that Firebird can interface with the
internet. Go to Tools > Options >

Advanced >
Connection Settings.
If your company uses a
predefined URL with a
proxy configuration,
select Automatic proxy
configuration URL and
enter the URL in the field.
To manually enter the
proxy details, select
Manual proxy
configuration and enter
the relevant proxies and
ports. The application
cannot connect to the
internet, unless you enter
these settings. 

Adding saturdays to the calendar

Changing the date format

Archiving all feeds

Importing Indian Holidays

Testing the overburning capacity of a disk

Importing from Google Calendar
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feeds you want to save, and click on
next. Select a location on the hard
drive to save the file, and click on
Finish. To load a saved OPML file onto
Snarfer, go to File > Import From
> OPML Feeds and select the location
of the OPML file.

Changing the style of
feed display

If you want to change the default style of
the feed display, there’re a number of
options that Snarfer gives you. Go to
Tools > Add more styles. This
opens a tab in Snarfer that shows a list
of available styles. This is how the text
from feeds will be laid out in Snarfer.
Click on any of the styles that appeals to
you, and you will be directed to the link
for that style. Don’t download the style,
instead click on Open. When the file is
downloaded (usually less than 5 KB),
click on Install. If you have

downloaded a number of styles, and
want to change to another installed
style, go to Tools > Options >
Appearance > Message style >
Style and select a suitable style from
the drop down menu. 

Changing the refresh 
interval of feeds

Some feeds change rapidly. You can
configure news feeds to refresh faster
than say the podcasts or vlogs. Right-
click on a feed, go to Properties >
Updating > Refresh Interval
and change the drop down menu
according to your preferences. 
To instantly update a feed, right-click
on the feed and click on refresh. You
can do this for an entire category or to
bring all the feeds in it. 

Adding feeds by keyword
Snarfer can add feeds related to a

certain keyword. This means that if
you put in computers or technology,
all related posts across feeds from
various sites with syndicated content
will show up. Right-click on Message
Folders, go to New > Keyword
Watch. Enter the keywords in the
field and click on Next.

Protecting your feeds with a
password

You can add a password to individual
feeds. Unfortunately, you cannot add a
password to all the feeds in a category

or folder. Right-
click on the
particular feed you
want to protect
with a password.
Go to Properties
> Authenti-
cation. Check
feed requires
authentication,
and enter a
username and a
password. Click on
Apply. The next
time you access
the particular feed,
it will prompt you

for your username
and password.

Adding a plugin
In snarfer, plugins are remotely

hosted on the snarfer server and are
available from the snarfer interface.
These are global settings applied across
all the fields, like the Flare remover
plugin that removes all custom icons of
feeds or the stock watch plugin that
aggregates stock feeds and updates
them. To add a plugin, go to Tools >
Add more plugins. This will take
you to a page with a list of plugins.
Periodically, check for updates on this
page. Choose and install plugins that
you like. Once installed, you can check
for the plugins at File > New. n

Changing the feed display style

The stock watch plugin

Adding a keyword based feed
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The Keyboard is mightier than the Mouse
Outrun a Mouse using a Keyboard in Firefox

Kumar Jhuremalani

Before the mouse was invented, the
keyboard was the only way to navi-

gate around the interface. Either way,
there was not much to navigate back
then. With the advent of the mouse,
everything changed. Now the mouse is
the most convenient tool for navigating
and clicking links while browsing the
internet. What if we tell you that the
keyboard is faster than using the
mouse — in Firefox, at least? Read on...

Firefox has numerous shortcuts
that let you browse without touching a
mouse. There’re a little over 50 short-
cuts in Firefox and we’ve listed the most
useful and the best shortcuts we found.

Firefox lets you download add-ons
for additional features. One such add-
on is Mouseless Browsing 0.5.1. You
can get this from
https://addons.mozilla.org/en-
US/firefox/addon/879. Click on
Download Now on this page to
install the addon. Once you’re done,

restart Firefox.
With the add-on installed, you’ll

notice a small logo at the lower right
corner of Firefox. You will also notice
that some numbers have appeared
next to every link on a page. These are
the numerical ids given to each link by
Mouseless Browsing. To access a link,
simply type the numerical id next to it
and hit [Enter]. 

The numbers you type are also dis-
played next to the logo, and they disap-
pear rather fast. If you think they disap-
pear too fast, adjust the timing in the
settings window. For this, click on the
icon at the bottom right corner of the
browser to open the settings window.
Alternately, you can go to Tools>Add-
ons from the Menu bar, select
Mouseless Browsing and then
click on Options.

You can change the time
delay by entering values as per
your choice. The default settings
for this is 500ms. If you feel this
is too fast, you can increase it to a
value such as 750ms and 1000ms
for a more convenient browsing
experience. You can also adjust
the settings such that you don’t
need to hit [Enter]. Once you’ve
typed the id, Firefox will redirect
the page to the link directly. If
you’re one of those who prefer
using the numerical keypad, set
the numpad exclusively for
Mouseless browsing. The default
number of ids set for a single
website is 1000. This is enough for

most websites, but there might be cer-
tain websites which need more.
Mouseless Browsing also allows you to
increase the maximum number of ids. 

If you don’t like using numbers,
you can also set alphabets as ids. These
work in the same way as numbers.
However, you might get some really
weird combinations as ids, like QBE
and UGZ, but only if the website has
that many links to offer. 

Using this add-on, along with the
available shortcuts, you increase your
browsing speed by milestones and
even challenge your friend who owns
a 4000dpi mouse and beat him in
using Firefox. n

kumar.jhuremalani@thinkdigit.com

Customise Mouseless Browsing to suit your needs

Mouseless browsing lets you browse through sites using just your keyboard

New: Tab Ctrl+T
Window Ctrl+N

Select Address Bar Ctrl+L
Select Search Bar / 
Web Search Ctrl+K
Clear Private Data Ctrl+Shift+Del
Downloads Ctrl+J
Complete Address: 

.com Ctrl+Enter

.net Shift+Enter

.org Ctrl+Shift+Enter 
Bookmark: 

All Tabs Ctrl+Shift+D
This Page Ctrl+D

History Ctrl+H
Zoom: In Ctrl++

Out Ctrl--
Reset Ctrl+0

Navigation: 
Back Alt+Left Arrow / 

Backspace
Forward Alt+RightArrow / 

Shift+Backspace
Home Alt+Home
Reload F5 / Ctrl+F5 

(override cache)
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PhotoFiltre
A quick run through one of the smallest image editors ever

Rossi Fernandes

Commercial software like
Photoshop comes with an exhaus-

tive list of features that is ideal for
professional graphic designers. Here,
we’re looking at PhotoFiltre, which, is
in comparison, a tiny and free image
editor. However, it’s something that
you’ll find useful for everyday use —
crop photos, make wallpapers or do
simple artwork. You can find the soft-
ware in this month’s DVD.

A walk through the usual features
The software layout is quite simple —
the main toolbar is located to the right
and the image properties toolbar on
the top. You can access the effects in
the Adjust and Filter menu. You can
adjust the image and canvas size, and
the image properties using the Image
menu. Overall, PhotoFiltre is similar to
Photoshop itself, so getting around the
interface shouldn’t be a problem.

Adding files to PhotoFiltre
Loading files is a straight-forward process
in PhotoFiltre, as in any other image
editor. However, there is another way to
do this. A feature called Image Explorer
lets you view images in an entire folder
including subfolders. You can access this
feature by clicking on clicking on Tools
> Image Explorer. A pane will appear
at the bottom of the screen. Right-click
on it and go to Explore > A folder.
Select a folder and click OK. You can open
images shown here by double-clicking on
them.

Colour selection tool
The colour selection tool in PhotoFiltre
has a few different modes which can
be accessed by clicking on the left and
right buttons below the colour selec-
tion tool. This presents a more accurate
way of selecting colours.

Saving, loading and positioning
shapes
Every good image editor has shape
tools with presets, and PhotoFiltre is
no exception. Simple shape presets can
be selected from the toolbar on the
right. The polygon and lasso tool can
be used used to create your own paths.
With PhotoFiltre, you can also save
these shapes, for future use. To save
these shapes, click on the Selection
menu and then on Save shape. Give
it a name and click Save. To load,
click on Load shape item in the
same menu.

You can also move this shape accu-
rately to the centre or to any other
point on the image by clicking on
Selection > Manual Settings.
Size of the shape can also be changed
from the same dialog box.

The PhotoMasque feature
The PhotoMasque feature allows you to
set a mask for your entire image. The
feature can be used by clicking on
Filter > PhotoMasque. Here you
can load a mask file and a list of sup-
plied masks will be present. Select the
mask you want, and click Open. You
can choose the effect you want to get,
by using the mask. To do this, click on
the Mode dropdown menu. You can

select the intensity of the effect you
want, and the mask can also be
inverted. Click Preview to see if you
like the results, then click OK.

Batch processing in PhotoFiltre
The batch processing feature allows
you to process multiple photos or
images in one go, instead of opening
every single image and processing it.
Click on Tools > Automate /
Batch to start it. First, select the
photos that you want to process, by
selecting the source folder and then
the output folder where the processed
images need to be saved. The other tabs
can be accessed to set parameters and
effects that you need for the images. 

Reading EXIF info
Each image you capture using a digital
camera, has pieces of information stored
on it. This includes information about
the camera and the photo taken. You can
read this information by clicking on
Image Properties under the File
menu. Click on the EXIF button. You can
export this information to a text file by
clicking on the Export button.

Creating an icon
PhotoFiltre has a convenient feature
that lets you create icons for Windows,
without having to manually set colour
depths and sizes. First, open the image
or create one that you want made into
an icon. Simply click on Tools >
Export as icon to create your icon.
The ICO file can be used with any
application. n

rossi.fernandes@thinkdigit.com

The Image Explorer visible at the bottom of
the PhotoFiltre window.

Using the PhotoMasque feature to load
masks for images The EXIF Info box displaying photo details
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Businessmen and executives 
don’t need flashy play toys. 
Sure, looks are important to 

everyone, but ease of use, rugged-
ness and ergonomics take prec-
edence over chic toys when in the 
hands of a serious corporate user. 
Businessmen are also harder on 
their notebooks. Just as they’re less 
likely to pull out their notebook 
at an airport solely for the sake 
of the prestige value that many 
associate with having one; they’re 
less concerned with the finish and 
colours used on their notebook 

and would also be less concerned 
about their shiny play thing pick-
ing up the daily gamut of scratches 
and smudges. For them a notebook 
is a necessity, not a status symbol 
and something that will last the 
test of time and still look in mint 
condition is the order of the day. 
Of course this doesn’t necessarily 
mean a plain-jane notebook. Quite 
the contrary, it takes a special type 
of notebook to have a simple black 
finish and yet look special.

There are other features that a 
businessman would look at; relia-
bility and quality – not just of the 
finish but the internal compo-
nents themselves. Adequate cool-

ing is expensive, both in terms of 
money and in terms of the space 
is requires. Yet the business user 
wants something really compact. 
This usually means a screen no 
bigger than 14.1-inches or 13.3-
inches. Manufacturers spend a 
good deal of the cost price of 
the notebook on designing cool-
ing solutions for shoe-horning 
powerful components, (that gen-
erate extra heat), in a relatively 
compact chassis. Then there are 
the various methods employed 
to reduce the risk of a hard drive 
crash in the event of one drop-
ping their notebook. Certain 
brands like Lenovo and Dell actu-
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ally have an inflatable foam clad-
ding around the hard drive that 
absorbs impacts thereby protect-
ing the hard drive from crashes 
due to any sort of hard impacts. 
Business notebooks (in general) 
sport more rugged finishes that 
are less likely to wear with heavy 
usage. We call such choice of 
tough surface treatments indus-
trial grade; this largely means 
something that’s resilient to 
wear, although it’s also become 
synonymous with a very plain-
looking choice of materials. Most 
hardcore business notebooks pay 
a lot of attention to ergonom-
ics; by this we mean both the 
presence and the placement of 
shortcut keys/buttons for com-
mon tasks.

This time round we 
decided to be really selec-
tive when looking at 
business-class notebooks. 
We didn’t want our test 
to be diluted with pseu-
do-business notebooks. 
We did a more compre-
hensive test back in June 
last year and unfortunately 
all of the major players 
like HP, Dell, Lenovo, Sony, 
Toshiba and Fujitsu didn’t 
have many new models. Sadly 
all these brands have launched 
a slew of models internationally, 
but most of them haven’t released 
these models in India. In fact lat-
ter two didn’t even have a single 

new model between them. Our 
five participants consisted of two 
notebooks from Lenovo and one 
each from HP, Sony and Dell.

Dell Latitude E6400
Brick solid!

If Dell’s Vostro series is designed 
for the small to medium sized 

business on a budget, the Latitude 
series is designed for the serious 
corporate, who needs connectiv-
ity and reliability above all else. 
Think of the Latitude as Dell’s 
answer to Lenovo’s ThinkPad 
series. At first glance the Latitude 
E6400 looks very large, solid and 
also very boxy. It seems like Dell 
hewed this out of a solid hunk of 
plastic and metal. No, the black 

matt finish is fine with 
us, but it’s just that the 
box-like design brings to 
mind the oft used analogy 
“built like a tank”. The lid 
sports a black, brushed 
aluminum finish that is 
quite eye catching but 
in a more laid back sort 

of manner and you’ll 
hardly notice 

yourself giv-
ing it anoth-
er look over. 
The E6400 

is built around a 
magnesium alloy cage which is 

great for longevity and even the 
coating around the palm rest 

region looks like it’s there to 
last. In fact the mostly metal 
design does add to the weight a 
bit, but the E6400 feels surpris-
ingly dense; as if it would take 
a lot of abuse. The screen size is 
14.1-inches, although this note-
book has a rather wide bezel all 
around the screen, which makes 
it look much larger, though not 
as large as a 15.4-inch model.

It sports the double mouse 
button design that Lenovo also 
favours and the track button that 
is a must for all seriously corpo-
rate notebooks. The track button 
isn’t red however (Lenovo nee 
IBM patented that), but is black; 
and blends in with the keyboard. 
The keys themselves are well laid 
out and offer a short and very 
positive feedback. Although this 
wasn’t the best laid out keypad 
from amongst the five notebooks 
we tested, the key spacing and 
beveling is ergonomic to work 
with. The trackpad is the right 
combination of grip and comfort 
although we found tracking to 
be a bit of a problem. In fact this 
was one of the major let downs 
with the E6400; the track pad 
will stick at times or will just 
refuse to do what your finger 
commands – most annoying. The 
trackpoint works better and it’s 
clear to see that it isn’t an adorn-
ment for Dell; many ThinkPad 
users swear by the trackpoint and 
Dell implements it quite well. A 
fingerprint reader thrown in; a 
must for many corporate users 
as an additional security step as 
it restricts access like few pass-
words can.

The screen itself is a matte 
panel; so reflections are not a 
problem and the resolution of 
1440 x 900 pixels is absolutely 
perfect. We’re tired of 1280 x 800 
pixels and ultra high resolution 
notebooks are a no-no too. This 
resolution is just right for the 
screen size. The LCD panel is 
LED lit; and should bring power 
saving benefits as well. In terms 
of configurability the E 6400 
is totally customisable in true 
Dell fashion. The one we got 
came with a new T9400 proces-
sor. This CPU is quite fast and 
runs at a speed of 2.5 GHz while 
maintaining a whopping 6 MB 

of L2 cache – great for someone 
needing more CPU performance. 
It seems the E6400 ships with 
only 7200 RPM hard drives and 
this is a very good thing because 
the storage subsystem is usually 
the slowest component of any 
PC or notebook. SSD is also an 
option with the new Latitude; 
though the costs are astronom-
ical. In true workstation style 
the Latitude E6400 ships with 
an NVIDIA Quadro graphics solu-
tion; the NVS 160M which is hard-
ly powerful, being based around 
eight stream processors but is 
way faster than Intel’s GMA and 
about a tenth of the performance 
away from a GeForce 9300M GS. 
D-Sub and S-Video connects are 
provided as video outs.

The Latitude E 6400 is priced 
from Rs. 60,000 and above; 
although the model we recieved 
was priced at Rs. 95,000; not bad 
considering the processor and 
graphics solution.

HP Elitebook 6930P
All that glitters is not gold

T he 6930P is yet another rath-
er unobtrusive looking note-

book. The lid itself is a matte 
black, unlike the machined 
metal finish on the Latitude E 
6400 and looks even simpler; 
some might feel a little to plain 
looking. The body has an equally 
lack luster finish with dark grey 
and black used as tones. This 
sort of body finish is common to 
Lenovo’s ThinkPads as well; yet 
the Elitebook looks even plainer. 
The culprit, we feel, is the boxy 
build which gives it a very (yawn) 
boring look. It’s also about as 
heavy as the E6400. Once you 
open the lid, things get a lit-

tle more interesting. 
The palm rest is silver-
grey as is the outer 
bezel and lid hinges. 
The side bezel is slim-
mer than the E6400 
although the top bezel 
is just as wide, 
making this 
notebook 
a p p e a r 
s l i g h t l y 
bigger than 
its screen size of 14.1-
inches; its footprint is a little 
smaller than the Dell Latitude 
E6400 though.

HP advertises that the 
Elitebook 6930P is designed with 
conformity to certain military 
standards, (MIL-STD 810F for 
those who want to look it up), 
for resilience to vibration, dust, 
humidity, altitude and high/low 
temperatures. This notebook also 
has the option to upgrade the 
optical drive to a special space 
saver ODD which allows for using 
an additional hard drive – a cool 
option for the power business 
user. RAID 0 and 1 support is also 
available if you decide to go dual 
hard drive. The drives themselves 
have an impact protection cage 
to minimize data crashes. The 
display is LED-backlit once again 
a plus for battery life; the quality 
of display remains as good as a 
CCFL display. The resolution is 
an excellent 1440 x 900 pixels, 
although you can opt for a screen 
with a resolution of 1280 x 800 
pixels as an option.

The trackpad is small and 
quite recessed; a plus during 
heavy typing sessions as your 
wrist is less likely to come in 
contact with the touchpad sur-
face thereby causing your mouse 
pointer to jump elsewhere which 

is a most irritating phenomenon. 
The touchpad also incorporates 
dual scroll zones for both verti-
cal and horizontal scrolling. The 
keys on the 6930P sport the same 
kind of matte finish that the 
outer body sports and this adds 
a bit of welcome grip to each 
key. Key travel is a little more 
than the E 6400 and feedback 
is slightly softer. However the 
keys are well laid out and due to 
their large design lack beveling 
on the top. Needless to say this 
keypad worked well for all of 
us and although the theory this 
should not have been the case 
but in practice we could find lit-
tle fault – we’d like key travel to 
be slightly less and feedback to 
be more on the positive side of 
responsive. There are a number 
of backlit and touch sensitive 
buttons on the top of the key-
pad and the all important WLAN 
on/off control is found here. The 
backlit icon changes colour when 
WLAN is switched on and off and 
there is another indicator which 
lights up on the front of the 
notebook; although this indica-
tor will not be on eye level when 
you’re using it so is not that use-
ful. A configurable shortcut key 
and the volume buttons are also 
backlit and touch activated – this 
is a nifty addition to a business-
class notebook; after all even cor-
porate users like to indulge in 
a little soft finger touching! A 
fingerprint scan sensor is also 
provided to added security.

HP provides software that 
can manage and even repair your 
notebooks installation over a 
network; very useful for IT pro-
fessionals and business houses 
looking for a robust fleet of note-
books with minimal down times. 
The 6930P is adequately powered 

For features we looked at the bundle and 
the specifications of each laptop. We also 

looked at the connectivity options like number 
of USB ports, presence of FireWire, memory 
card readers and HDMI. We also looked for 
LAN, Bluetooth and WLAN connectivity.

We gave scores ranging on a scale of 10 for 
usability, intuitiveness, convenience and ergo-
nomics too. Such non tangible factors are often 
what make the difference to most users. Features 
like build quality, or the feel of a keypad, or even 
the presence of and placement of shortcut keys. 
We also look at the ergonomics associated with 
the placement of USB ports, LAN and RJ11 con-
nects and other connectivity options.

We used a clean install of Windows Vista 
Business 32 bit, and only the drivers and nec-
essary benchmark software were installed. 
Our tests consisted of a gamut of benchmark 
suites and real world tests.

For checking the performance of key com-
ponents like CPU, RAM, storage and video 

subsystems we used two general benchmarks: 
PC Mark 05, and SiSoft Sandra 2008 Lite. For 
specifically stressing the graphics subsystem 
we used 3D Mark 05. Maxon’s CineBench 
R10 was used for testing the CPUs rendering 
ability. For testing the quality of the display 
provided we used DisplayMate’s colour suite. 
Finally, we used WirelessMon 2.0 to check 
the strength of the WLAN solution embedded 
on each notebook. We also benchmarked the 
transfer rate of the WLAN system. We trans-
ferred a single 100 MB file for the sequential 
test and a number of small files totaling to 
100 MB in size for the random test.

For real world tests, we checked the over-
all effectiveness of each of the test subjects 
at viewing HD content and gaming, music, file 
compression/decompression (WinRAR), and 
file transfers. The former tests stress out the 
video solution and CPU and memory subsys-
tems while the file transfer test specifically 
targets the storage subsystem.

  How We Tested

Dell Latitude 
E6400

HP Elitebook 
6930P
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with a P8400 processor and 2 GB 
of DDR2 memory. It also has a 
250 GB, 5400 rpm hard drive and 
an ATi Radeon HD 3450 graph-
ics solution. This is more than 
enough grunt to push the 6930P 
through most tasks; and these 
components may even be overkill 
for most users. A D-Sub video-
out is provided as standard, we’d 
have liked something more in 
the HDMI realm; but this isn’t an 
entertainment notebook.

The price of the 6930P as quot-
ed by HP is “price on request”. 
However to our dismay we were 
unable to get a quote on request 
– it seems they will only give 
quotes to potential users; and 
there was no more information 
to be had from them. A three 
year international warranty is 
provided as standard, a huge plus 
for the globetrotting professional 
or businessman; most companies 
do not offer such warranty terms 
free of charge. If you’re looking 
for hassle free service plan and 
an excellent warranty scheme for 
a rugged product this may well 
fit the bill.

Lenovo X300
Worthy lightweight champ

The X300 series exemplifies 
extreme portability and the 

X300 we received doesn’t belie 
this belief one bit. The X300 is 
touted as an ultra portable and 
ultra light notebook and the 
weight of 1.5 kilograms with 
battery is definitely a step in 
the right direction. It’s a sweet 
looking notebook decked in a 
rubberised sort of finish. This 
coating is present all over the 
body and the inside is a hard, 
matte finished plastic. The entire 
notebook is black, and this effect 
is only relieved by the red stripes 
on the top mouse buttons and 
the red trackpoint. It’s clearly 
aimed at a corporate user and 
this is very obvious from the 
look. The screen bezel isn’t too 
wide, although it’s a little thicker 
on the outer edges. Still the X300 
is very slim and gives the impres-
sion of being built to last. The 
screen is 13.3-inches and sports a 
high resolution of 1440 x 900 pix-
els; the display is crisp with good 

colours and displays 
text really well.

The trackpad is 
a little inaccurate; 
shocking really for 
a notebook of this 
status. Moreover it 

doesn’t respond 
at times 

– mores the pity. 
The trackpoint works well; 

but we feel there’s no excuse 
for designing a poor trackpad; 
and trackpoint’s are Jurassic for 
most people anyways. The key-
pad is exactly the opposite; key 
feedback although a touch soft 
is quite positive. The keys are 
exceptionally well laid out and 
beveling is excellent; this really 
is one of the best designed key-
pads you will ever use. The only 
sore point (and a serious one) 
is the placement of the func-
tion key on the lower corner of 
the keypad; a space that’s usu-
ally reserved for the control key 
which also enables a lot of short-
cuts. People used to the control 
button do a lot of double takes 
when using it in combination 
with shortcut keys and you need 
to get used to the placement 
of the function key. The keypad 
isn’t backlit although Lenovo 
does provide the traditional lid 
light. We noted that while this 
light provides adequate illumina-
tion when working in the dark 
its inadequate when there’s a 
little ambient light which makes 
it useless seven times out of ten. 
Another little ergonomic niggle 
is that the WLAN switch is placed 
on the rear; this means you need 
to either reach behind your note-
book each time or turn it around 
so that the rear faces you in order 

to switch wireless 
connectivity off or 
on. One of the USB 
ports are placed 
on the rear as is 
the video port 
(D-Sub) but we 
have to say that 

this makes a 

lot of sense. When hooking up a 
secondary display or a printer it 
makes sense to have the connec-
tions going from the rear so you 
save on cable clutter on the front 
or side or your desk space.

With a power saving 1.2 GHz 
L7100 under the hood the X300 
is supposed to be all about bat-
tery conservation; although our 
tests clearly negated the theory 
that these CPUs are really great 
power savers. An SSD should also 
help conserve power. The X300 
has a 64 GB SSD which also adds 
performance, particularly with 
anything requiring fast read 
and access to the storage system. 
There’s no fancy graphics solu-
tion here; expected for an ultra 
compact, power-saver notebook. 
As expected the X300 will not 
win any CPU and GPU bench-
mark awards; but it does have 
a blazingly fast storage system. 
At Rs. 139,000, the X300 is quite 
costly; and do not expect this 
price to fall unless SSD prices fall 
as you cannot buy this notebook 
with a regular hard drive. For 
corporate looking for the reliabil-
ity and repute of the ThinkPad 
series and something light and 
compact the X300 makes a good, 
albeit pricey buy.

Lenovo T400
The larger sibling

Just as the X300 series exempli-
fy portability, the T400 series is 

supposed to represent a balance 
between power and performance. 
What this really means is that 
the T400 is a larger, heavier and 
cheaper notebook with a slightly 
inferior finish to the X300. The 
term inferior was meant rela-
tively in the above statement and 
the T400 is well built and feels 
solid; but perhaps being larger 
doesn’t feel as dense in-hand as 
the X300 did and the difference 
in price is evident with the qual-
ity of materials used. It also feels 
a little more plasticy than the 
X300; owing to the use of slightly 
lower grade materials than the 
X300 utilises in the construction 
of its outer body. Once again this 
matte black finish may not be to 
everyone’s liking but we feel the 
inside is a little better looking 

as the black finish looks a little 
brighter. The screen sports a de 
facto resolution of 1280 x 800 
pixels and with a diagonal size 
of 14.1-inches, this seems a little 
low resolution, especially when 
compared to the 13.3-inch, 1440 
x 900 pixel display on the X300.

The keys on the T400 are 
identical in layout to the X300 

and this is perhaps, ergonomi-
cally the best part of the T400. 
Key feedback is a little bit softer 
than the X300 but this doesn’t 
detract from the feeling that this 
is one of the best designed key-
pads around. A pity we couldn’t 
say the same for the trackpad 
which is sometimes unrespon-
sive and inaccurate. The double 

mouse buttons and trackpoint 
are also present; the latter works 
well; better than the trackpad. 
Above the keypad you will find 
an array of status icons that are 
easily visible and well laid out; 
there are indicators for battery, 
WiFi, Bluetooth and charging 
status. The volume up and down 
buttons are also present here as 
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Brand
Model

Lenovo
T400

Lenovo 
X300

Sony
Vaio VGN-Z13GN

Dell
Latitude E6400

HP
Elitebook 6930P

Features
Component Specifications
Processor Model No P8400 L7100 T9400 T9400 P8400
Processor Speed (MHz) 2260 1200 2500 2500 2260
Memory (MB) / RAM Type / Memory Speed 1024 / DDR3 / 1066 MHz 2048 / DDR2 / 667 MHz 4096 / DDR3 / 1066 

MHz
2048 / DDR2 / 800 MHz 2048 / DDR2 / 800 MHz

Chipset Intel Cantiga GM45/
GM47

Intel GM965 Intel Cantiga GM45/
GM47

Intel Cantiga PM45 Intel Cantiga PM45

Graphics Solution Intel GMA 4500MHD Intel GMA X3100 GeForce 9300M GS Quadro NVS 160M Radeon HD 3450
Onboard Video Memory (MB) Shared Shared 256 MB shared 256 MB 256 MB
Audio Solution Conexant Cx20561  AD1984A Realtek ALC262 IDT 92HD71B7  AD1984A
HDD Size (GB) 160 GB 64 GB (SSD) 320 GB 160 GB 250 GB
Optical Drive Type Matshita DVD-RAM 

UJ-844
Matshita DVD-RAM 
UJ-844

Matshita DVD/RW PLDS DVD/RW DU-8A2S NEC Optiarc DVD/RW 
AD-7561S

Bundled OS Vista Business Vista Business Vista Business + XP Prof Vista Business Vista Business
Characteristics
Screen Size (Inches) / Native Resolution 
(Pixels)

14.1 / 1280 x 800 13.3 / 1440 x 900 13.3 / 1600 x 900 14.1 / 1440 x 900 14.1 / 1440 x 900

Weight 2.13 Kg 1.5 Kg 1.48 Kg 2.1 Kg 2.1 Kg
No of Ports (USB/FireWire) 3 / 1 3 / 0 2 / 1 4 / 1 3 / 1
Connectivity (LAN/Bluetooth/WiFi) 4 / 4 / 4 4 / 4 / 4 4 / 4 / 4 4 / 4 / 4 4 / 4 / 4
Type of Memory Cards Supported SD, MMC, xD SD, MMC, xD SD, MS Pro, MMC SD, MMC, xD, MS Pro SD, MMC, MS Pro, xD
Inbuilt Webcam 6 4 4 4 4

Build Quality (So 10), Body / Keypad / Lid, 
movables

7.75 / 7.5 / 7.75 8.25 / 8.25 / 7.75 6.5 / 7.5 / 7.5 7.25 / 7.25 / 8 7.75 / 7.5 / 8

Ergonomics: (Keypad Tactility / Layout / 
Shortcut Keys)

8.25 / 7.75 / 7.5 8.25 / 7.75 / 7 7.5 / 8 / 7 8 / 8 /  7.75 7.5 / 7.5 / 7.5

Biometrics Login 4 4 4 4 4

Dedicated Buttons (WLAN / Bluetooth / 
Touchpad

4 / 6 / 6 4 / 6 / 6 4 / 6 / 6 4 / 6 / 6 4 / 6 / 6

Performance
Synthetic Scores
PC Mark 2005
CPU Score 5767 3206 6482 6398 5479
Memory Score 4990 3254 5516 5399 4741
Graphics Score 2396 1006 3880 3428 2276
HDD 4636 14565 3742 5051 4404
Overall 4780 3254 5379 5963 4541
SiSoft Sandra 2008 Lite
CPU Arithmetic (Dhrystone ALU / 
Whetstone iSSE3)

20951 / 16575 11065 / 7606 23414 / 18284 23262 / 18568 20901 / 16677

CPU Multi-Media (Integer x8 iSSE3 / 
Floating x4 iSSE2)

124913 / 68249 66000 / 35908 139603 / 76400 139541 / 76246 125016 / 68301

HDD Index / Random Access Time (ms) 51 / 10 89 / 1 50 / 13 49 / 11 48 / 9
Memory bandwidth (Integer / Floating) 5220 / 5221 3495 / 3529 5751 / 5732 5601 / 5616 5109 / 5112
3D Mark 2005
CPU Score 7785 4637 13664 12927 10967
Overall Score 1437 671 3934 3247 3962
Maxon CineBench R10 (CPU Score) 4573 2336 5324 5286 4608
Display Mate Tests
Colour Accuracy Test (Avg) (So 10) 6.5 7 7.25 5 7
Battery Life Test (Minutes) 158.58 112.33 157.44 154.30 139.52
WiFi Signal Strength Test 87 76 71 85 81
WiFi Sequential transfer test (MBps) 51 128.4 40.3 46.7 44.1
WiFi Assorted transfer test (MBps) 79 132.3 64.9 69.9 62.1
Real World Tests
Audio Test Speakers (So 10) 4.5 5 5.25 4.5 5
HD Movie Viewing (So 10) 5.5 6 7.25 5.5 5.5
WinRAR 3.8 (Compression / 
Decompression kb/s)

753 685 847 563 683

File transfer Test (Sequential / Assorted) 
(Sec)

96.4 / 92.2 24.3 / 31.7 52.6 / 59.8 44.5 / 54 63.4 / 84.8

DOOM 3 (fps) (640x480, medium detail) 13.5 9 108.8 95.4 80.9
Farcry (fps) (640x480, low detail) 50.95 31.71 193.62 182.94 194.16
Warranty (Years) 1 onsite 1 onsite 1 1 3
Price (Rupees) 68000 139000 124900 95,000 Price on Request

Lenovo X300

Lenovo T400

J a n u a r y  2 0 0 9
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is the ThinkVantage button that 
allows quick access to help and 
support. The USB ports are laid 
out vertically which is actually 
pretty clever design since two 
ports can be placed very close to 
each other thereby saving space. 
The RJ11 and RJ45 connects are 
also placed together on one side; 
convenient. The WLAN switch is 
on the front this time; so it scores 
in terms of placement ergonom-
ics over its costlier sibling.

Powered by the new P8400 
which is part of the new 
Montevina platform the T400 is 
snappy; but comes with just 1 GB 
of RAM (DDR3). We figure Vista 
users should look for at least 2 
GB of memory and cannot figure 
out why Lenovo chose to supply 
just 1 GB; unless it was to keep 
the price down. The hard drive is 
a regular 5400 rpm, 160 GB offer-
ing. The T400 also makes do with-
out any sort of discrete graph-
ics offering favouring Intel’s 
trusty old GMA 4500. Priced at 
Rs. 68,000, the T400 is very com-
petent for the build, specifica-
tions, functionality and features 
it offers. Anyone who is used to 
the build of Lenovo’s ThinkPad’s 
will not be disappointed. We wish 
for a GeForce 9300M-class graph-
ics solution and an HDMI port; 
which would make this notebook 
more of an all-rounder but as it 
is the hardware on offer is good 
enough for its target audience.

Sony Vaio VGN-Z13GN
Ultra portable performer

Sony’s Z series are aimed at the 
stylish businessman looking 

for a no compromise machine 
that serves a dual purpose — rock 
solid portability and strong mul-
timedia capabilities. The Vaio 
VGN-Z13GN is a very compact 
notebook that has an under-
stated black and steel-grey finish 
that attracts at first sight. The lid 
is one of the slimmest we’ve ever 

seen and this notebook is defi-
nitely the slimmest in this com-
parison. The lid has a nice posi-
tive snap shut action when it’s 
about an inch from being fully 
closed. The outer shell is made 
partly of carbon fiber which 
gives the Vaio Z the binary ben-
efits of tremendous robustness 
and low overall weight. We felt 
that as good as that may sound, 
this Vaio should have been built 
even better and there was some 

flex noticeable around 
the optical drive tray 
area. Shockingly even 
the hinge has some 
ugly gaps; while these 
aren’t easy to spot 
and may not matter 

to most peo-
ple being 
retentive 
is part of 
a review-

ers’ job. The rear 
plastics are good quality but not 

as good as the materials we’ve 
seen on the Vaio TZ series. The 
screen is a very high resolution 
1600 x 900 pixels and at a size of 
13.3-inches it’s not the ideal pro-
portions for someone looking to 
work with text. However, colours 
and contrast on the display are 
good, but this is a TN panel and 
you will have issues with wider 
viewing angles. 

The keypad is typically Sony, 
with a kind of soft, mushy feed-
back. The layout is very good 
though, although the keys feel 
a little smaller than some other 
Vaio’s they are also a little higher 
than normal meaning that key 
travel is more. The gap between 
the keys on this keypad seems to 
be slightly more than the gaps 
on the segregated keypad that 
Apple uses. Whether or not this 
is good, is for you to decide but 
our overall opinion is positive 
and nobody had any ergonomic 
issues while using it and the all 
important control key is at the 

left corner, just as it should be 
– Lenovo should take a leaf out of 
Sony’s book here. The trackpad is 
better than the Lenovo series in 
terms of accuracy and the choice 
of coating is also good as it aids 
finger grip. The WiFi indicator 
light is on the front bezel and 
not at all visible unless you eye 
is at the same angle which rarely 
happens; the switch is located 
below it and is easy to operate.

The VGN-Z13GN also fea-
tures the famous switch to select 
between stamina and speed 
mode. This is basically a hard-
ware level switch between the 
integrated graphics solution 
(Intel) to the NVIDIA GeForce 
9300M GS. This allows you to 
either get more graphics horse-
power or conserve battery life 
depending on your usage pat-
terns at the moment.

In terms of processing power 
the Vaio is fully loaded – with 4 
GB of DDR3 memory and an Intel 
P9500 CPU running at 2.5 GHz. 
A 320 GB hard drive offers more 
than enough storage for all but 
the most demanding of down-
load junkies. When viewing the 
specifications of this notebook 
we feel more strongly than ever 
that this Vaio is designed to per-
form dual roles. It can be a faith-
ful corporate aid and a fun-time 
plaything as well; and it’s equal-
ly adroit at both tasks, and yes; 
it’s also got an HDMI port. It was 
also the smallest and lightest 
notebook (1.48 kg) in test making 
it something of a specialty since 
it’s also the most powerful note-
book in test in terms of process-
ing power and performance. At 
Rs. 124,900 we wish it were just 
a little sturdier; but given its 
other multifaceted talents we 
have very little to nitpick about. 
If you can afford to spend this 
much cash; this is the only note-
book you need consider. n

michael.browne@thinkdigit.com
kumar.j@thinkdigit.com

 Contact Sheet                   Business Laptops

Company Phone No Email Website
Dell 080-44344359 Aparna.Grover@ogilvy.com www.dell.co.in
Hewlett Packard +124-2566111 anurag.arora@hp.com www.hp.com/in
Lenovo 1800-425-2666, 080-22108490 buy@in.lenovo.com www.lenovo.com/in
Sony 1800-11-11-88 (Toll Free) sonyindia.care@ap.sony.com www.sony.co.in

Sony Vaio 
VGN-Z13GN
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The year 2007 was characterised by
unprecedented innovation and adaptabili-
ty in the realm of security threats, as

criminals once again demonstrated their abili-
ty to continually evolve attack strategies to keep
ahead of even the most advanced human and
technical defences.

Rogue developers create such threats by
using worms, viruses, or application-embedded
attacks. Botnets can be used to seed an attack,
for example, rogue developers can use worms
or application-embedded attacks, that is an
attack that is hidden within application traffic
such as web traffic or peer-to-peer shared files,
to deposit “Trojans”. This combination of
attack techniques — a virus or worm used to
deposit a Trojan, for example-is relatively new
and is known as a blended attack. A blended
attack can also occur in phases — an initial
attack of a virus with a Trojan that might open
up an unsecured port on a computer, disable an
access control list (ACL), or disarm antivirus
software, with the goal of a more devastating
attack to follow later.  

The evolving perimeter
Changes in network architectures and evolv-
ing threats create new security challenges.
Also the concept of the network perimeter is
changing. In the past, users could only access
the network through a few ingress or egress
points — usually where the internet connect-
ed to the enterprise network. Enterprises
stacked security at the internet perimeter
using firewalls and intrusion detection sys-
tems. However today, many more means of
gaining entry to the network exist. With the
perimeter having been extended and distrib-
uted, security too needs to be applied at each
of these new ingress and egress points to
avoid damaging threats, thus complicating
security architectures.

Take for example, virtual private networks
(VPNs). These allow enterprise users remote
access to the corporate network and are much
more widely used than just a few years ago.
While previously enterprises might have
insisted that VPN software run on a specific
enterprise-configured computer, today users
run VPNs from their own PCs or even from
kiosks at copy centres or other businesses.
This phenomenon allows many more entry-
ways to the enterprise network and presents a
significant challenge to IT departments. Is the
computer equipped with virus protection? Are

visitors / employees bringing their non-corpo-
rate assets into corporate network?  

Or for that matter, let’s look at wireless-
Wireless LANs (WLANs) pose additional security
challenges. Users operating on an unsecured
wireless network at a local coffee house may be
unaware that a rogue PC, also using the same
wireless subnet, is depositing a virus on the PC.
When that PC is later docked into the corporate
network, the virus/Trojan could gain entry to
the network. 

Security — the reverse Moore’s Law
As the network is becoming more vulnerable to
attack because of the evolving perimeter, the
threats themselves are changing. In addition to
Trojans and botnets, newer, even more danger-
ous threats lurk. Two of the most troublesome
are flash threats and self-mutating worms.
Flash threats are so named because of the speed
with which viruses or worms can spread. In
1999, a virus dubbed “Melissa,” one of the earli-
est and most widespread viruses at the time,
took 16 hours to spread globally, according to
Network Associates Inc. In January 2003, the
“Slammer” virus managed to infect more than
90 per cent of the vulnerable hosts worldwide
within 10 minutes using a well-known vulnera-
bility in Microsoft’s SQL Server. New viruses in
the coming months and years are expected to
spread even faster. Therefore whatever defences
organisations create, they must be able to iden-
tify the threat and respond much more quickly
than ever before.  

The other looming threat is the self-mutat-
ing worm. Today’s worms are relatively unintel-
ligent. They are programmed to follow a specific
set of instructions, such as to infiltrate one
machine through a specific port and once on the
machine compromise it in some way, for exam-
ple, causing a buffer overflow and planting a
Trojan. If anything interferes with these planned
instructions, the worm lacks the ability to adjust
and dies. Now, however, rogue developers are
adding intelligence and logic to worms so that if
they can’t complete a specific task worms can
mutate and pursue other lines of attack.

Experts call this security dilemma “Moore’s
Law in reverse”. Whereas Moore’s Law postu-
lates that processor performance will double
every 18 months while costs will decline dra-
matically, security is moving in the opposite
direction-networks are becoming less secure
while the cost to defend them is increasing.
This prognosis is supported by mi2g, a research
firm in the UK that specialises in computer
security. Mi2g reports that the economic dam-

Threat defence
As the network
is becoming
more vulnerable
to attack
because of the
evolving perime-
ter, the threats
themselves are
changing
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Warning: Terrorists will strike
where it hurts the most
In his famous book The Little Drummer Girl
John LeCarre wrote that the absolute terrorist
is one who can blow up a room full of school
children, without any remorse or hesitation.
Abhorring as that might seem, the fright-
ening recurrence with which such
instances have occurred, necessitate cor-
porate India to be prepared for the
absolute terrorist. 

Very recently, SIMI had threatened to
blow up LIC buildings, a warning serious
enough to mobilise the Mumbai police. In
the past few months, many Indian companies
in BFSI and IT / ITES sectors have been subject
to hoax bomb threats. Though more often, the
situation was brought under control — these
incidents caused stress, confusion, disruption
of work and loss of business and / or credibili-
ty. Inarguably, the problem merits attention.
However, there is a need to remain calm and
follow the basic rules of security. Employee
awareness, training, practice and evacuation
drills help to avert disasters and increases
chances of correct response in times of crises.

Dealing with bomb threats
A bomb threat may be received on telephone
or through a written message. Experience
shows that most of the threats received on
telephones are hoaxes. However, till experts
carry out a detailed search and come to that
conclusion, the situation has to be taken seri-
ously. Statistics suggest that one in a 1,000
calls may turn out to be genuine. 

While administration and corporate secu-
rity departments play a leading role in coun-
tering bomb threats, employees are often the
first line of defence. A sound and practical
bomb threat contingency plan ensures carry-
ing out standardised drills and lays down spe-
cific responsibilities on all concerned.

Evacuation procedure
Once it is decided to evacuate, the security
manager should give wide publicity by
announcements through PA system, CCTV,
megaphone, etc.  Do not use the word “bomb”

as it may create panic and confusion. It is
preferable to announce that “the area needs
to be vacated — this is NOT a drill.” 

The announcement should specify the
evacuation route, guide, location of assembly
area and the need for staying there till fur-

ther instructions. Route and assembly area
should be searched before announcement.

Evacuation instructions
(dos/don’ts):

Ideally the organisation should have
practiced evacuation drills previously.
If they have not—then these are some
guidelines. 

The announcer must remain calm,
and advise the employees to follow the

instructions. Similar announcements could
be displayed on the monitors of CCTV, if

Bomb alert!
A well-drafted model bomb threat plan, tested and evaluated with trained staff, will enable

an organisation to promptly respond and help minimise loss
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age from malevolent network security attacks
reached somewhere between $157 billion and
$192 billion worldwide in 2004.

New threats — increase in 
operational complexity and 
manageability?  
The current security defence paradigm is to
deploy more and more of the existing security
technologies throughout every segment of the
network. This includes firewalls and ACLs to
block access and perform application inspec-
tion, intrusion protection system (IPS) technol-
ogy to provide very granular traffic inspection
and identify known threats, encryption soft-
ware to counter eavesdropping, anomaly detec-
tion to detect worms or DoS attacks, and
antivirus software to battle viruses. 

Many of today’s security technologies were
developed to perform their specific function
with little context of the overall network threat
environment. Operating alone, however, these
technologies are less effective in stopping the
newer attacks, as well as the changing ways in
which user’s access networks, because of the
“security gaps” that exist between each tech-
nique’s capabilities. With the increased com-
plexity of threats, such as the blended threats
that use a combination of techniques to disrupt
networks, security technologies must operate
in a coordinated fashion to stop attacks and bet-
ter control network activity and applications.

Unfortunately, over the years, many compa-
nies have addressed nagging security concerns
by constantly adding devices and software to
address each particular problem. This has led to
separate antivirus protection, firewalls, VPNs,
and intrusion prevention. While this addresses
the short-term needs, it creates an entirely new
and bigger problem: managing multiple sys-
tems that operate independently of one anoth-
er. As more advanced threats emerge, there is a
need for network security to become more
holistic; security technologies must act in coor-
dination to detect and defend against more
sophisticated threats. There is a growing need
for devices that can assemble the puzzle pieces
and lock down the gaps that exist in conven-
tional network security systems.  

Adaptive security for a changing
world
Transforming chaos into a clear and manage-
able security policy is essential, which is why
future network security systems need to focus
on convergence and consolidation. For robust
information security for an enterprise, a proac-
tive architectural and system approach is criti-
cal. The idea is to accurately identify and stop
attacks as early and as far from the destination
host as possible, while simultaneously simplify-
ing the security architectures required to do
this. 

Instead of a security product for each secu-
rity need in isolation, an end-to-end security
solution approach or system enables these com-
bined functions to operate as a coordinated
defence (instead of silos) that stops a broader
range of attacks and greatly reduces the num-
ber of diverse multi-vendor devices that must
be deployed, thereby simplifying security
design and management.

Historically, firewalls have generally been
considered fairly simple devices, but they are
effective at what they do — either block a pack-
et or let it through based on Layer 3 and Layer 4
information and session state. They can provide
some level of application inspection but do not
perform the detailed inspection of some other
technologies. An IPS device can pick up where a
traditional firewall leaves off by peering more
deeply into a packet’s contents to see whether
the data within conforms to company policy.
Host IPS, host firewall on servers and desk-
tops/laptops, day zero protection and intelli-
gent behavioral based protection from applica-
tion vulnerability and related flaws (within or
inserted by virus, worms or Trojans) provided
great level of confidence on what is happening
within an organisation on a normal day and
when there is a attack situation, which seg-
ment and what has gone wrong and gives flexi-
bility and control to stop such situations by hav-
ing linkages of such devices with monitoring,
log-analysis and event co-relation system. 

Adaptive threat defence is the need now
where an end-point security system can dynam-
ically generate an attack signature and push it
to the other end-points and to the perimeter IPS
devices to stop it from propagating to rest of
the infrastructure. Similarly security opera-
tions teams have challenges to fine-tune false
positives, they struggle by logging into various
devices to understand which logs are resulting
into what logs; the need of the hour is that
security operations team should be able to easi-
ly see the logs and link the same to configura-
tions which are resulting into these logs.

This type of systems approach transforms
security from operating as separate siloed tech-
nologies in a reactive mode-with limited and
static detection methods-to functioning as a
coordinated, proactive threat defense system
that adapts to the threat environment.

These systems provide numerous benefits:
improved detection, greater event classification
accuracy, lower operating costs, streamlined
administration, and services extensibility that
integrate the most advanced security technolo-
gies as they are developed. These converged sys-
tems will not compromise the quality of securi-
ty in any given category, but instead combine
the strength of each in complementary ways to
deliver a tighter, coordinated defence.

The author is Business Development Manager, Network
Security, Cisco India & SAARC
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installed.
l Walk out of the building in a calm and com-

posed manner to the given location through
the given route.

l Do not run, it will cause panic among oth-
ers.

l Do not use elevators/lifts or conveyors.
l Follow the instructions of the guide.
l Do not argue or talk with the guide. It will

waste time and obstruct evacuation.
l Carry personal valuables, but do not stop to

wind up work.
l Supervisors may need to switch off the

machinery and power supply in their respec-
tive areas.

l Open all windows, doors and cupboards.
l Do not obstruct passage of search and res-

cue squad.
l Wait in the assembly area till further

instructions.
l Do not spread rumours or speculate and

cause panic.
The supervisor must take attendance in the assembly area and if any employees/visitors

are found missing, it must be investigated.

Make “Be Prepared” your motto  
A bomb threat plan should be drawn up in
every organisation and tested to assess the
organisation’s readiness and ability to respond.
This should be part of the incident manage-
ment plan. If there is a real bomb threat or any
emergency that requires evacuation, such
efforts will reduce the damage. The organisa-
tion, depending on its structure and nature of

business, must draw
out a model plan by
assessing its risks,
deciding on a policy
and training personnel
to implement it. The
plan must be rehearsed
and lessons learnt must
be incorporated. 

It is also advisable
to carry out a threat
assessment to prevent
the organisation from
being an easy target for
potential bombers. 

Telephone operators
and PAs should be trained in questioning tech-
niques for extracting maximum information
from the caller. A “bomb threat check list”
guidance should be available with them.
Organisations should make arrangements for
tracing and recording of incoming calls. 

The organisation must train security offi-
cers, maintenance staff and othersin carrying
out search and evacuation. A suitable area
should be earmarked as assembly area.

The author is CEO, Mahindra Special Services Group

l Stay calm and listen carefully. Signal others
around you to stay quiet and if possible pick
up extension phones to listen in. 

l Write down the number displayed on the
caller ID display of your telephone.

l Get maximum information and prolong calls
as far as possible. Pretend you did not hear
correctly, ask the caller to repeat. Ask ques-
tions—location of the bomb, time to explode,
what type of bomb, how can we get rid of it,
who has placed the bomb, from where are
you calling, what is your name, reason for
placing the bomb—in that exact order. 

l Try to identify background noises such as
traffic, music, conversation that may help to
determine the location from where the call is
being made.

l Make an educated guess on sex, age, race,
voice (loud, soft, pleasant, intoxicated) or
accent, speech (fast, slow, nasal, slurred) and
manner (calm, emotional, vulgar, angry,
laughing, righteous) which may help identify
the caller. Be advised that the caller could
also be in an agitated state. 

l Alert a colleague; report the call to your
manager or security manager immediately.

l Fill up the bomb threat call check list.

l A bomb threat could also be in the form of a
mail/written message. Report these to the
security manager.

Actions on receipt of a bomb
threat call

Given the nature of blasts, it is impossible to predict the exact situation you
could be in. However, here are some generic guidelines that could be of
help.  

l Depending on your distance from the blast, you could be in various
degrees of consciousness. 

l The first effect of a blast is a numbing disorientation. Try to get your bear-
ings. If you are in a prone position, stay down. 

l Try to remain calm. If you are conscious and can move yourself, examine
yourself for injuries. Blasts commonly cause concussion and lacerations.
The former causes damage to organs and bones and the latter causes
bleeding. 

l Be aware that there could be secondary blasts. 

l Do not panic and create stampedes. 

l Do not search through debris. 

l If you are capable of it, assist others until help arrives.

And what if you are caught in a blast?
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Rossi Fernandes

T eam Fortress 2 players all over would have been a
little mad at Valve for delaying updates for
some new project called Left 4 Dead that was in

the works. It came out recently and thanks to trailers
and demos that arrived before, it’s clear that it was
going to be a survival horror game. It’s finally here
and people don’t seem to care about paying an exces-
sive $50 for a PC game that you buy online without a
fancy box pack to keep on your desk.

Left 4 Dead is an online multiplayer co-op survival
horror game that can also be played as a single player
game. You play as one of the four characters of your
choice — Francis, Zoey, Louis and Bill. There are five
separate chapters and missions within each one of
them. You typically are planted right in between a
zombie infested building and you make your way out
of there. How? By shooting hundreds of zombies
through every mission and covering your partner’s
backs. If you were wondering what kind of gameplay
and storyline you play — that’s all you do — shoot
zombies, escape alive. Fortunately that’s not all there
is to Left 4 Dead.  

The game runs on Valve’s four year old Half-life 2
engine that has been given steroids to match the visual
quality of today’s game engines. Other than the addi-
tional cosmetics to the look, it’s also easy to notice the
better textures and models in the game. If you can run
Half-life 2, you should be able to run Left 4 Dead just fine.
The animations for the zombies are also good fun. The
mood in the game is great — it’s the feeling of an aban-

doned and ruined city with pockets of zombies. To
sum it up for more experienced gamers, the environ-
ments are like the ones in SWAT4, the action is some-
thing out of Serious Sam with more crowded environ-
ments and the weapons are from Counter-Strike.

The game isn’t particularly difficult to play as far
as shooting lone zombies goes. It goes from being easy
and laid back to complete mayhem when you turn a
corner and you have some 30 to 40 zombies waiting to
pounce on you and your teammates. Being a team
player plays a major role and that’s where the online
playing component becomes much more fun and
challenging. Steam is used to download and update
the game. It also gets matches for you to play. You can
always use the Invite function to ask your friends to
join in. If you have the sufficient number of players,
you can even play Survivors versus Infected.

Valve has managed to strike gold yet again but we
don’t think it’ll be as legendary a multiplayer as Team
Fortress 2. With a lot of the fun limited to the levels
available and no matter how many variations the
game uses to send waves of zombie attacks, you are
going to get bored eventually. Obviously, if Valve keeps
updating this title with new content the same way
they have with Team Fortress 2, Left 4 Dead will last. 

Like the Orange box, Left 4 Dead is available in
stores at a low price of Rs. 999 for the PC box pack and
on Steam for $50 (Rs. 2,500). Avoid buying this if you
want a deep storyline and tactics from an FPS; it’s a
must-buy for those who like mindless killing co-op
games with plenty of zombies.

rossi.fernandes@thinkdigit.com
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Technology Beyond Work
Leisure
Digital

Far Cry 2110

Score :  8/10
Developer: Valve Corporation, 
Turtle Rock Studios
Publisher: Valve Corporation
Platforms supported: PC & Xbox 360
Website: www.l4d.com

NFS Undercover108

Minimum System Requirements:
Pentium 4 3.0 GHz, 1 GB RAM, graphics
card supporting Shader Model 2.0 — ATI
Radeon 9600 or NVIDIA GeForce 6600
and above, 7.5 GB of free disk space



Aditya Madanapalle  

After the Pro Street fiasco, EA prom-
ised gamers a return to the roots
of the NFS franchise. There was a

longer than usual nail biting wait for
the new release, with the usual buzz in
the air. The twelfth installment in the
series, Undercover is here, but the game
is as forgettable as Pro Street. 

There is an initial rush of the game,
with an opening sequence that
smoothly puts you behind the wheels a
la Most Wanted. Although you know you
are driving around like a puppet, a pre-
scripted part of the storyline, you get
that rush of adrenaline. From there, the
game goes downhill. The physics are
horrible; you can hit a car head on and
still keep going like you hardly hit a
speed breaker. The acceleration is
unreal, all the cars handle too well, with
no learning curve to talk of. You hit
something, great, you get money for
damaging state property, or evading the
law. You don’t hit something, great
again, you get nitro points for a narrow
miss or a clean section. There are only
rewards, and no punishment. The game
is just too easy, making sure you
mechanically follow the story line. 

The game plays out like a movie,
with a very linear approach. You are
hardly given a choice of races to choose
from, and you can maintain just one
save game per profile. This means that
you cannot experiment with cars or
tuning. All the decisions you make are
final, and you are hardly given any. The

game is rudely interrupted by ama-
teurish cut scenes, with sloppy acting
and done to death characters. Maggie Q
is used like a heroine in an Indian b-
grade film, with the camera zooming in
and focusing on her hips, legs, bosom
or belly every time she comes on screen.
The “plot” of the game is that you are
an undercover cop busting a gang of car
thieves by a) running away from cops to
prove that you are not a cop and b)
killing the bad guys for a bunch of really
lame reasons.

All the favorite modes have disap-
peared. You can drift only as a means to
earn nitro. The drag is replaced by some-
thing called the highway battle, and the
AI is easily fooled in this mode if you
handle the race like a cop chase, and
roam the city at random. This is because
the car follows wherever you go, and the
whole city is open. There are cop chases,
but navigate to a circuit breaker, and
you win. The helicopter is a docile little
thing, that goes in the air without fuel
every single time, and does not dive in
towards you at any point. There are no
rhino units, and the cop cars are easily
fooled. A new mode involves taking
down cars, by ramming into them
repeatedly, but somehow, the game
drains the fun out of this as well. 

There are a bunch of American,
European and Japanese cars to choose
from. The customisation of your ride is
very constricted because it kicks in well
into the game, and everything is very
costly. There is a large gallery of decals
available, and all of them look great as

long as they are not actually put on the
car. The tuning is great actually, prob-
ably the only saving grace the game has.
However, this is a wasted feature, as
tuning a car for a particular mode or a
particular race is a laborious process. 

There is however a photo mode you
can bring up at any time of the game,
change a bunch of cameras and take a
shot of your car. We just wish they
would have thought of this back in the
days of Underground, or before. There is
also some damage elements… the sur-
roundings can be demolished. Be
warned though, flimsy looking wire
mesh fences will refuse to budge,
while stockpiles of industrial metal
will litter the highway if you brush
against it. Damage to the car itself is
hardly visible, with the exception of
the bonnet flying off somewhere in
the middle of every race. 

The worst part of the game are the
glitches in the graphics. Shadows move
unrealistically, artefacts follow the car,
and the roads disappear at some point.
Many of the elements barely manage to
stay ahead of the car. 

It hurts. Seems like the good old
days are gone, and NFS is history, in the
bad sense of the word. We just wish that
EA would go deeper down into their
roots. The word on the street is that EA
is calling its losses and discontinuing
the franchise. Nothing saddens a gamer
more than watching a legendry series
exiting on such a sour note. 

aditya.madanapalle@thinkdigit.com
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Score :  5/10
Developer: EA Black Box
Publisher: Electronic Arts
Web site: http://www.needforspeed.com
Recomended Config: Core 2 Duo/ AMD
Phenom (or higher), 2 GB Ram, ATI
X1900/NVIDIA 8600 GTS (or higher)
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Robert Sovereign-Smith

Where’s Jack Carver? I
thought this was part
2 of Far Cry?

Apparently, this game is just
called Far Cry 2 to get people
like you and me to buy it and
play it, based on the popularity
of Far Cry — sucks; I hate being
made an ass of.

Initial irritation aside, I find
that the game is rather pretty.
The graphics are very, very nice.
Obviously, being set in Africa,
there’s so much more in terms
of scenery to play with. 

I’m not going to give out
too many details and spoil
what little fun is to be had
from this title. However, I will
say that this game is either
going to be one of the most
boring shooters you have
played, or is going to be one of

your all time favourites. The
main reason for all this chop-
ping and changing of opinions
is the way the game is made —
certain things will impress
you while others will  bore
you to death. 

To begin with, there’s the
AI, which at times is so smart
that you die often. Other times,
I could just walk up right
behind an enemy, and shoot
him in the back of the head,
without his buddy, who’s stand-
ing 12 feet away, ever reacting.
Standard FPS madness this.

Your character is suffering
from malaria, and you need to
find tablets to keep yourself
alive. The currency you use to
buy things are diamonds you
find along the way, and in true
African style, you can use dia-
monds to buy anything but
malaria tablets — you need to
do favours for priests for those!

The good bit of this game
is its immersiveness — great
audio effects and music, good
environment physics, a large
open world, a good feel of
being in ruthless Africa, and
time actually changing — from
day to night and back.

So is this a must buy?
Sure, if you want about 30
hours of great gameplay in
the single player mode, with
decent replayability, though
without a compelling story-
line. If you’re looking for a
Crysis-like experience, forget
it. This seems like an attempt
to bring a lot more realism
into an FPS — and I’m not
talking just graphics here.
Just remember that Far Cry 2
fails as much here as it suc-
ceeds. Besides, I’m still miffed
at being cheated out of a
proper sequel!

editor@thinkdigit.com

A far cry
from
Far Cry

Rating: 7/10
Developer: Ubisoft

Recommended sys-
tem config:
Core 2 Duo / AMD
X2 5200 or better;
2 GB RAM; NVIDIA
8600 GTS / ATI
X1900 (or better); 
5.1 surround sound
(required, or you
will not know where
your enemies are
shooting at you
from!)

Signs can change colour? Vision blurs at the edges when aiming

Buy weapons using diamonds I designed something with my Uzi

Killing them again, in gory detailDear diary... That’s right, run away and hide
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Which of these famous
worms did not spread

through e-mail?
a) Michaelangelo
b) Sobig
c) ILOVEYOU
d) MyDoom

How does a worm differ from
a virus anyway?

a) A worm does not harm the
computer directly
b) A worm can spread without
attaching itself to a program
c) A worm can only come from
computers connected to the
internet
d) A worm can infect documents
and system files

What does a firewall inspect
and restrict?

a) The bandwidth
b) The network traffic
c) Server based codes and scripts
d) Programs accessing the Internet

What is a botnet?
a) A herd of computers

remotely controlled by a hacker for
malicious intent
b) A herd of computers running
automated programs for
distributed computing
c) A herd of computers used for
remotely sending spam, denial of
service attacks or perpetuating
click fraud
d) All of the above

What does a denial of service
attack do?

a) Hack a website so that
legitimate users cannot access its
services
b) Redirect legitimate traffic to a
fake website
c) Take a web server down by
sending it too many requests
d) All of the above

What does a rootkit primarily do?
a) Freeze up all essential

system files
b) Gain administrative privileges to
a computer 
c) Format the partition with the
operating system
d) Download trojans and viruses
from the internet

Which of these popular
programs were never

distributed with spyware?
a) Kazaa
b) Morpheus 
c) DivX
d) Bearshare

From which country does
more than one-fourth of the

world's spam originate?
a) USA
b) Nigeria
c) China
d) Brazil

RealPlayer is an example of:
a) Malware

b) Spyware
c) Adware
d) Shareware
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ACROSS
7. Device that accepts a certain type of data or signal
as input transforms it and then outputs it(6)
8. To convert the file from one system or application
to the format of the system or application being
used(6)
10. Free, open source application used for exchange
of data using the TFTP(7)
16. Locate and correct errors in a computer program
code(5)
17. Representing sound or light waves as numbers(7)
18. Archive of files created with the Unix tar utility(7)
19.To come out of a machine when a button is
pressed(5)
21.Word macro virus(7)
26.Middle line or point(6)
27.-----Basic- programming environment from
Microsoft(6)

DOWN
1. Short for simulation(3)
2. Prevent completion of a program(4)
3. Dynamic Random Access Memory(abbr)(4)
4. Round shaped media to store computer data(4)
5. To read the contents of a certain file(4)
6. Binary Runtime Environment for Wireless(abbr)(4)
9. Supply with recent information(6)
11. New version of or addition to a hardware(7)
12. Router through which a data packet enters a network
from another network(7)
13. Stop a transmission(5)
14. An alloy of iron(5)
15. Electrodes as in a storage battery or capacitors(6)
20. Moser----- - world’s second largest optical storage media

manufacturer(4)
21.----frame- or big iron(4)
22.A connector(4)
23.To store a file(4)
24.ADSTAR Distributed Storage Management(abbr)(4)
25.A file showing the structure of a program after it has
been compiled(3)

Crossword

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area

Do you know your security?

A machine remotely
controlled by a hacker for

malicious activity is called a:

a) Sniffer   b) Bot   c) Ghost
d) Zombie

1

Answers

1. d
2. a
3. b
4. b
5. d

6. c
7. b
8. d
9. a
10. c

Crossword by Nitaa Jaggi

Last month’s Winner
Kayomars Batliwalla

Send in your entries to
TQ@thinkdigit.com on or
by the 20th of this month.
One lucky participant 
will win 
Wireless and Mobile All-
IP Networks
By Yi-Bing Lin and Ai-Chun
Pang
Published by

Win!

December’s Solution

Symantec and
Kaspersky plan to move

from blacklisting to whitelisting.
This means that instead of
blocking malicious programs,
they will start allowing only the
“good” programs.

Did You
Know?
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DONT JUST BLAME BAIDU

CCTV
focuses on
Google and
Yahoo!

China Central
Television is
dispersing the flak it

received, for the
controversy embroiled
Baidu search engine by
alleging that Google and
Yahoo! sport illegal medical
ads on their web sites. 

Baidu is the search
engine of choice in the
world’s most populous
country, and for a sneaky
little reason. The reason
being that a shadowy set
of constantly changing
domain names provide a
great service — free and
unlicenced music
downloads. Despite many
takedown attempts,
lawsuits and complaints,
free music continued to
be available on Baidu.
Then it came under the
scanner for a number of
advertisements of medical
supplies that were not
licenced. This forced
Baidu to drop these ads,
and the matter would
have settled there. 

Continuing on its
crackdown on illegal
medical services being
advertised through the
web, state-owned CCTV
launched a fresh wave of
attacks against Google
China and Yahoo! China for
similar offences. Both the

search giants have been
accused of taking money
for advertising medical
scams. 

Google China is
however secretly investing
in a lot of Chinese internet
services. The world’s
largest demographic
cannot be easily ignored by
the search giant. Although
Google can hardly afford
to offer free MP3
downloads, it is heavily
investing in online
Chinese-run social
networking and
entertainment services. 

WASHING DIRTY LINEN IN
PUBLIC

China courts
rule against
dead
woman’s
friend and
blogging site

In other China news, a
woman who killed
herself and the web

service that hosted her
blog were ordered to pay
Wang Fei $1,200 in
damages. The long and
sordid tale reads out like a
soap opera, complete with
adultery, emotional
turmoil and suicide. 

It started with Wang Fei
going to bed with another
woman. His wife, Jian Yan,
like any wife was pretty
distressed. But unlike other
wives, she decided that the
best way to soothe her

distress was to blog about
her husband’s ongoing
affair on daqi.com. Helping
Jian Yan at this activity was
a certain unnamed female
friend. The Chinese
blogging community was
stirred up against the cruel
indulgences of Wang Fei,
and even the mainstream
media caught on. The blog
went out of proportion
because of all the support,
and daqi.com went right
ahead and posted photos of
Wang Fei with his mistress.
What followed was a small
scale riot. Wang Fei was
fired, his parent’s
apartment was defaced
with lewd language, and
Jian Yan decided that
enough was enough and
committed suicide. 

Wang Fei
understandably sought
justice for the goings-on,
and after much
deliberation, the Beijing
court decided that he was
after all, the wronged
party. Daqi.com and the
late Jian Yan’s unnamed
female friend were
criticised for invading
Wang Fei’s privacy, and
asked to pay $1,200 as
damages.  

RUSSIAN TRADEMARKS
POPULAR EMOTICON

Its not ;-)
anymore

Patent and trademark
laws around the world
are rife with hillarious

examples of what people
try to own and reap profits
out of. After people have
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FirstEscape

The world’s most
popular video web
site, YouTube has

given rise to a breed of
celebrities in its time. These
range from the adolescent
antics of lonelygirl15, the
understanding answers
from Ask a Ninja, and the
hilarious foreign language
subtitles of Buffalax.

Unwittingly, YouTube
has become a fertile ground
for criminals, gang
members, wannabe
terrorists and small time
hoaxers grabbing their
fifteen minutes of fame.
These smart people have
taken it into their head to
show off their (sometimes
imagined) criminal exploits
on YouTube, and the result
was a bout of YouTube
related arrests. 

Anton Dunn, under the
moniker of The Trashman,
posted videos of himself in
a black mask claiming to
have poisoned several
batches of Gerber baby food
with cyanide or rat poison.
Concerned parents
understandably called up
the company about the
videos. If one video was not
enough trouble, he posted
another video claiming to
lead a bunch of assistants
who poisoned many more
batches of the food, and
that four babies had
already died because of his
efforts. The wannabe baby
killer was exposed as a
hoax, the authorities

closed in on him and now
he faces 10 years in prison
with no access to free video
hosting sites. 

A bunch of gang-
member kids styling
themselves as BV Boys
posted a video of
themselves marking out
their turf in the area. On
record were gang-signs and
concealed weapons. The
authorities homed in,
confiscated the weapons,
arrested the boys, and now
their turf is clean. 

Ahmed Abdellatif Sherif
Mohamed took it into his
head to spread a little
anarchy with a video
tutorial on how to change a
remote controlled toy car
into a detonator. His
intentions were far more
sinister, an effort by the
international terrorists
networks to permeate the
web and sow seeds of
dissent. The twelve minutes
of terrorist propaganda
uploaded to the internet
cost this young Egyptian
student 15 years behind
bars in a US prison.

THUBMS DOWN FOR MAC
ADDICTS

NY Gov
proposes
iPod tax

NY Governer, David
Peterson does not
think that the

global economic crisis is a
good time for citizens to be
entertained. A part of his
plans to ease the slowdown
is to impose a tax on all
electronically delivered
entertainment services.
This is now widely billed as
the iPod tax, which is a
misleading name as the
tax is not meant only for
iPod users. 

The law applies a 4per
cent tax on everything — e-
books downloaded from e-
library.net to porn from
adultemart.com. Popular
services like NetFlix and
Amazon will also come
under the umbrella of the
iPod tax. This is part of a
$121 billion budget
covering the next year.
Almost anything that is
liable to make Gov.
Peterson’s voters feel good
is going to be taxed, in
order to ease the credit
crunch. This includes TV,
beer, wine and cigars. Apart
from the iPod tax, or the
iTax, there is also the
strange obesity tax on
sugary soft drinks. 

Sock and Awe sold out on eBay
Post the incident where a man threw his shoe at
President Bush, an industrious developer
released Sock and Awe, a flash game that let
players lob shoes at the president. Four days, was
all the time that it took for the game to be sold
out on eBay.

LOOK MA

YouTube made me famous
Whatever 
Happened To…

The ICQ

Back in the days when there
was only IRC and a few chat
rooms as your only means

to connect to people, there came
ICQ, the first internet-wide instant
messenger. The name ICQ is a
homophone for the phrase I seek
you. It quickly captured the
imagination of the early netizens
and gathered millions of users
worldwide, with people showing
off their ICQ numbers even on
their visiting cards. Yes ICQ had
numbers for usernames and the
initial six digit ones were most
coveted. The universal internet
numbers (UIN) were handed out
sequentially. Some of the
attractive ones were even sold in
the free market. The messenger
was distinctly unique with some
silly features like typewriter
noises and online/offline status
being indicated by the colour of a
flower. In fact, it looked like the
messenger was designed by a
bunch of hippies.

Soon with the advent of MSN
and Yahoo! messengers, people
quickly switched to the jazzier
options. Besides, ICQ by then was
plagued by the scourge of spam.

The messenger was first
launched in November 1996.
America Online (AOL) acquired
Mirabilis, its holding company,
on June 8, 1998 for $407
million. Today, the ICQ protocol
can be accessed from any AIM
enabled messenger. ICQ still
claims to have 32 million active
users, but the claim is doubtful.
In India at least, its popularity
has perceptibly declined.
Abroad there might be people
logging in, but through other
messenger clients and so it
appears that the days of the
highly vocal, slim ICQ
messenger are numbered.

NASA to give away Shuttles for free
You heard right, once the Space Shuttles have
been decomissioned by the North American
Space Agency, the space shuttles will be up for
grabs for free. Only educational institutions
and museums can opt in, and they will have to
bear the shipping costs.

n  Montenegro bans Facebook and YouTube access in govt offices n  Japanese groups throw opposition to Google Street View n  NVIDIA GTX 295 benchmark results leaked n  Mobile networks need boost in Washington for Obama’s inauguration n  AMD in trouble

Daniel Bricklin
invented
something that has

completely changed the
business world — the
Spreadsheet. In the late
70s, while he was a
student at the Harvard
Business School, he
teamed up with Bob
Frankston, to come up

with VisiCalc, the world’s
first electronic
spreadsheet application.
Bricklin was watching his
university professor create
a table of calculation
results on a blackboard.
When the professor found
an error, he had to
tediously erase and
rewrite a number of
sequential entries in the
table, triggering Bricklin
to think that he could
replicate the process on a
computer, using the
blackboard as the model
to view results of
underlying formulas. His
idea became VisiCalc, for
which Bricklin designed
the interface and Bob
Frankston, wrote most of
the code. They released
VisiCalc in 1979, an act
that fomented the desktop
revolution. He also coined
the term friend-to-friend
networking as recently as
2000. He is now working
on wikiCalc, a spreadsheet
running on the web.

People Who
Changed

Computing
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Do you speaka ani
Engrish?
The Japanese are a funny lot,
and the variation of English
that they use is even funnier.
They confuse the ‘l’ and ‘r’
sounds, leading to hilarious
outcomes like Album Covers
by Eric Crapton and campaign
posters for Erections! Also
much of the English on their
signboards comes from literal
translations from Japanese,
with disastrously funny
consequences — sign on a loo
saying “Please use anyone”. At
www.engrish.com you’ll find a

huge collection of such pics
contributed by people all over
the world. The web site takes
a fun look at the various
products, signs, bags, clothing,
etc. that contain funny or far-
out English. Guaranteed to
keep you tickled for hours.

Cool site of the day
Cool site of the day is an
interesting web resource
that brings to you the
coolest web sites on the
internet right to your inbox.
You can subscribe to the
newsletter, submit your

own site, browse through
archives, and even rate a
site’s coolness. Head over to
http://www.coolsiteoftheday.
com/frmindex.html and
check out the coolest site for
today.

tried to patent fire, and the
wheel, the newest hunting
grounds for opportunistic
entrepreneurs is the web. 

A Russian businessman
has gone ahead and trade-
marked the oh brother
emoticon. Oleg Teterin
hopes to earn thousands
of dollars in licensing
fees. This means that no
emoticon can be legally
used in Russia because
they all bear a similar-
ity to the oh brother
emoticon. 

Being the benevo-
lent individual that
Teterin is, he has
allowed lay users com-
plete freedom to use
the emoticon in the
normal course of inter-
net interaction. The
trademark application
has to be ratified by the
Russian Patent Agency,
and it remains to be
seen if the trademark,
in fact, be granted. Russian
lawyers argue that the
trademark may not be
granted because of its wide
use, and being against the
interest of the general pop-
ulation. 

This is not the first time
that a smiley has been
copyrighted. Way back in
2001, the :-( emoticon was
copyrighted by a US firm
called Despair, Inc. 

THE MARCH OF THE WARRIOR
PENGUINS

Linux joins
the OS
advertising
battle

The operating systems
war have been waging
for a long time now,

and the two big players in
the field have taken on
distinct identities. Windows
users are stereotyped as
being stiff upper lip power
tie wearing formal
individuals, as against Mac
addicts with the casual

clothes and the careless
Seinfeld cut. Of course,
Seinfeld switched loyalties
in the recent $300 million
advertising campaign for
Vista that was summarily
dropped.

The 1337 tree-huggers of
the computer world have
something to celebrate.
When not trying to install
codecs into their Linux
systems, they can spend
their time making the I-am-
Linux video. The Linux
Foundation, a non-profit
organisation hoping to
spread the support for the
open source operating
system is planning to
launch an advertising
campaign made from these
videos.  

The brief for the video
according to the official
website is “in 60 seconds or
less, showcase your take on
I’m Linux. This should be
why you love it and should
inspire others to use it. The
video can be an extensive
production, a plain
testimonial or as simple as a
screen capture with a voice
over. Be creative, be
authentic and have fun.”
The winner will be decided
by a panel of judges and

Wild Wild Web

Audiophilia
The unnatural obsession with
high quality sound marked by an
excessive passion for high-end
audio equipment. The afflicted
want to experience sound
reproduced with little or no loss.
Read on to progress from audio-
enthusiast to audiophiliac.
SNR — Signal-to-noise ratio: It’s
the level of clean signal
compared to noise coming out of
your output source. Look for
higher SNR and lower TDH
THD — Total Harmonic
Distortion: The amount of
originally-recorded sound
reaching your ears compared to
distortion introduced by your
components. Figures of 0.01%
and lower are desirable for
sound cards.
Impedance: Basically resistance.
Changes as per frequency. Go for
high impedance on low-end
electronics.
Frequency response: It’s a
specification to measure how
uniformly equipment reproduces
sounds from the lowest to the
highest tones. A uniform
frequency response makes the
delicate sound of a triangle as
audible as the crash of a cymbal.
Reference speaker: Speakers
or headphones that reproduce
sound as it is, i.e. very close to
the original recording. Like
studio recording “reference
monitors”.
Soundstage: The presentation
of the sound in relation to the
listener.
Coloured: Simply to what extent,
and where, the frequency is
altered in reproduction.
Quality related terms: Warm,
rich, full-bodied etc.
Brands: Sennheiser, Denon, AKG,
Monitor Audio, Wilson Benesch.
Usage: These new AKG K-701
reference headphones I bought
have an impedance of 62 ohms
and man, what a broad
soundstage! Really rich sound,
absolutely uncoloured!

due to Lehman’s September default n  Red Hot Chili Peppers music videos no more on YouTube n  Polaroid goes bankrupt
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Opening ODF files with
Microsoft Word
Open Document Format (ODF) is
an open standard file format
OpenOffice.org and others use.
File extensions include .odt
(text), .ods (spreadsheet), and
.odp (presentation). By default,
Microsoft Office does not
recognise these file formats.
However, it is possible to open
and edit these files after
installing a plugin from Sun
Microsystems.
For office 2003 users
If you have Microsoft Office
2003, simply download and
install the Sun ODF Plugin. You
can download it from here.
For office 2007 users
1. First you need to Install
Service Pack 1 for Microsoft
Office 2007.
2. Install Sun ODF Plugin for
Microsoft Office.
3. Open ODT document via File >
Open, or by double-clicking the
ODT file and when prompted for
the application to open it with,
choose Word.
If you don't have administrator
privileges to install software, you
can try an online converter such
as Zamzar or Media Convert. You
can also upload ODT documents

to Google Docs or Zoho Writer.
http://rabspd.co.cc/archives/op
ening-odf-files-with-microsoft-
word

Best Five Online Image Editors
Image editing is always fun in
Photoshop. With Adobe
Photoshop Express, an online
version of Photoshop, you don't
even need to install Photoshop
on your computer. We made a
list of other online photo editors.
Let’s check out the top 5.
1. Picnik: This is undoubtedly one
of the most famous online image
editors. It has some great
features like Layers support,
Red-eye correction, Rotate,
Resize, Exposure etc. It is tightly
integrated with Flickr.
2. Splashup: Formerly Fauxto, it
is a powerful editing tool and
photo manager. Splashup runs in
all browsers, integrates
seamlessly with top photo
sharing sites, and even has its
own file format(.FXO) so you can
save your work in progress.
3. Picture2Life: The site offers
plenty of editing and special
effect options-including collage
and animation features.
However, We found the interface
to be little quirky. All the usual

features are present.
4. Snipshot: The interface is
Super clean and simple. No
signup were needed, and can
output image to 6 different
formats including psd. But
advanced options like layer
support were missing.
5. Pixenate: A fairly
uncomplicated site and really
simple interface is what sets
pixenate apart from other sites.
Although we found that it was
not as powerful and fast.
http://www.technonix.com/com
ment.php?comment.news.202

Useful Free Softwares
BurnAware
BurnAware Free is a free CD,
DVD, Blu-ray Disc burning
software. It is ideal for users
with basic disc burning needs as
backup, creating data, audio,
MP3 music, DVD-Video discs and
burning disc images. Free, easy
to set up, it enables you to save
your files to disc quickly and
provides clean, flexible interface
to help you complete your
burning tasks much faster. It’s
100% Free.
http://worldofy2j.blogspot.com/
2008/11/burnaware.html

Escape

votes from the global nerd
community. The contest will
be open till March 15, and
the winner gets free flight
tickets to Tokyo and
accommodation for the
October 2009 Japan Linux
Symposium. 

We have a lot of
questions. Are Mac or
Windows machines allowed
during the production of
the video? Will judges
prefer videos edited on
Cinelerra instead of Final
Cut Pro? Will the
commercials actually be
put to use over television
networks? Whatever be the
outcome, we can’t wait to
get our hands on the
rejects.

KIDS IN MARYLAND TAKE THE

Kids fool
traffic polic-
ing system

The smart people of
Maryland decided to
set up a traffic system

that did not involve any

people. Cameras recorded
speeders, and mailed them
$40 tickets with no real
police officers in the loop.

The smarter high school
kids at Maryland decided
that they needed revenge
on some people, especially
the teachers. Armed with
laser printers and glossy
paper, they replicated their
teacher’s number plates
and zoomed around town —

the teachers received 
tickets.

Since they are only high
school kids, the officials are
unsure if this new trend is a
game or a prank. Some of
the victims are
understandably unhappy
about the violation of their
civil rights. The bewildered
officials hope to control the
situation before the activity
becomes more widespread.

n  Jabalpur Nokia shops burnt because Nokia maps shows Kashmir in Pak n  Researchers develop bionic sexual stimulation chip

Featured here are
snippets from some of
the best bloggers who
have registered at the
Blog Watch section on
thinkdigit.com.

If you wish to be
featured too, head to
www.thinkdigit.com/
blogger.php and
sign-up.

Weight and watch...
The newest gadget to mesmerise the Digit
team was strangely enough — a weighing
scale. There was much excitement when
someone discovered it in the downstairs
warehouse and the whole team promptly
marched down to review it. Now, we at
Digit are really of different shapes and
sizes. Some like Vijay tried the

ol tummy tuck before getting on, but it
didn’t work. Our stick figure (Aditya) was
asked to remove his wrist watch, which
significantly affected the reading — he
weighed in at 45 kgs! Big boss editor
(Raaabo) was a decent 75, but not entirely
pleased. He said we’ll ‘weight and watch’.
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The best buy
The year end issue of Digit is indeed
useful for many reasons to cite.  Though
the cover page is prosaic and
unimpressive your justification for the
same is one step ahead in reasonable
maneuvers. Please take that as a
compliment. However, I have become a
fan of yours of late, for the language you
use and the way you make yourself clear.

The second aspect of Digit’s
December issue is that, I found many
of the articles very informative.  I was
in a state of confusion in selecting a
laptop and a inkjet printer for my son
and your ‘Best Buy’ tags helped me to
easily get the best of the class. I had
missed many issues of Digit on several
occasions, and this issue compensated
the loss. 

I am quite impressed by the
following articles: 

n The very best products of 2008
n Taming the Internet.
n Improve windows font display
n Keep it simple
The Editor also made a passing

reference to my earlier letter about
jargon in the editorial “Never judge a
book...’. I feel honoured and enthused
to make correspondence with the
Numero Uno.

Sreenath Rayasam

We’re glad our December issue was that
useful to you, and happened to cover exactly
what you were looking for. Like we’ve told our
readers all along, we really do read all your
letters. In fact, the editor has promised to
make it a point to respond to all from now on.

Team Digit

Errata
I just wanted to point out that there is
an error in the crossword puzzle on
page no. 164: the clue given in 15 down
suggests the answer is STEP UP but
since the transformer reduces output
voltage it should be a STEP DOWN
transformer, if I am not mistaken.

I’d also like to thank you about the
C++ Fast Track. I’m learning C++ and
the book was of great help.

Kayomars Batliwalla

You are absolutely right. We got it wrong in
the crossword. Since no one came close to
answering the crossword correctly, and you
spotted the mistakes we made, we feel that
you deserve the prize for the crossword. 

Team Digit

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30, 
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@thinkdigit.com

On the Digit archive
Congratulations and thank you for a
great magazine which is now is a
part of my life! I am a Web Designer
and a subscriber to Digit for the past
two years. Each and every Digit issue
is like a gift for me. I have arranged
all the CDs and DVDs month-wise so
that I can find them when I need to.
The Digit Archive helped me a lot to
manage this.

I noticed that you have stopped
providing the Digit Archive software
in the CD for the past few months.
What happened? Are you in the
process of debugging? Please make
that available as soon as you can. 

I also have a few suggestions.
Please write Fast Tracks to AJAX, PHP,
XHTML and Dynamic Flash XML. It
will help Web Designers like me.

Debraj 

The Digit Archive is undergoing a change at
the moment. We hope to launch version 2.0
soon, with added features. As to your
suggestion for Fast Tracks — we hope you
enjoy the one on PHP this issue which comes
with a video guide on the DVD.

Team Digit

Expert advice 
I’m an avid reader of Digit and
December’s issue was the best of all.
However, some part of the magazine
really let me down. A couple of
questions answered by the experts in
“Q&A” were totally wrong.

One of the questions with title “Is
the file boot.com corrupted?” gave me
a feeling  that the person (Jagdeep
Virdhi Q&A expert) is totally unaware
of what it really is. It’s actually a trojan
which creates some files in registry
and runs along with Explorer. The only
way to remove this trojan is to use
“Smart Virus Remover” software. You
also need to  click “Restore Windows
Default Settings”. The same applies to
the question titled “USB Flash drivers
and viruses”. By using that software
you can also fix folder options
problems, registry problems etc. 

R. Vivek

The solution given points readers to
remove all Autorun.inf files, which is what
this virus uses to load into the system. The
answer was incomplete, though, and the
virus removal instructions omitted. 

Team Digit

Pirates no more
I have got an amazing mag in
my hands which is called Digit.
December issue was absolutely
mind boggling. The most useful
stuff was the soft copies of your
magazine’s previous issues. I have
already started browsing their Tips
and Tricks section. Why don’t you
include mobile applications which
you used to? 

And also you guys give more
importance to Windows Mobile users
by giving a list of applications for
them and including it in the Tips
and Tricks section, while most
people in India have Nokia phones
which run on Symbian. You know I
have Nokia N95 8 GB lying unused
because of lack of applications, and I
don’t have an internet connection at
home, so I can’t get compatible apps
for it. That aside, your Mag simply
rocks! Your cover page reflected
simplicity and honestly, but inside it
was extraordinary. Robert was right
when he said “its not what’s on
covers that matter, but what’s
between them..”. 

I think you should have been
given best performer award to the
iPhone in the mobile phones
category, and not the N95 8GB, even
if it’s my phone.

I also want to tell you that Digit
has changed my life completely. I was
a bigger pirate than those in Pirates Of
The Carribean before reading your
magazine, but now I use either
licensed software or only Open
Source ones.

This is all thanks to you guys, and
that is why you are on top. It can be
said that you are the iPod Touch of
the PMP world. Thanks once again!

Kshitij Rawat

The point that symbian applications and
symbian relevent information will be more
useful to readers in India is taken. We are
recieving a lot of requests for providing phone
based software on our DVDs and we are
seriously considering it.

What really made us happy was that you
stopped software piracy and moved on to open
source software. This is really the way to go,
and glad to know that we were a small part of
this turn around. 

Team Digit
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20 questions?
First of all, I must congratulate you on
your “2008 Collector’s Edition”. I am a
regular subscriber to Digit and this is
the first time that I have been
completely satisfied by an issue.

Initially, I was not all too pleased
when our desi magazine was taken over
by videsi 9.9, but then you have done
wonderfully. Earlier, the magazine used
to reach me after a fortnight; now it
arrives within 10 days.

Earlier, I used to fear that the
package would be pilfered and I would
lose some CDs; now the packaging is
tamper-proof. The Fast Track has better
paper quality, has colour pictures and
now even features tutorials; a demand I
have making since long. The magazine
features articles that can be read even
by non-geeks (like myself), which are
informative and thankfully short. Who
on Earth would want to read a
“textbook” anyway? Referring to your
editorial column on the cover; I don’t
think Digit is a film magazine that
anyone would buy on the basis of cover.
No matter what you put on cover, we
will buy anyway. I liked the idea of
simplicity, but frankly I miss the
gorgeous babes on the cover :)

What matters most to the reader is
the stuff inside. The CDs now feature
softwares for Linux as well. What more
can I ask from Digit? But, these
compliments shouldn’t make you
complacent, you must outdo yourself
through constant innovation.

Now, coming to some shortcomings.
Sometimes, the software in your
CD/DVD labeled as Freeware turns out
to be actually Shareware or Trialware. I
usually don’t install software that I

have to uninstall later. 
Page 68 on Laptops: “Price of

notebooks range from Rs. 20,000 to
Rs. 26,000” What? Must have been a
typo. There have been many such
errors; I guess they have been missed in
a hurry to get the magazine ready. I
wonder why Evolution for windows was
left out in your e-mail clients article.
When Chrome beta was featured in
comparison of browsers in your revious
issue, why was Evolution (beta) not
included? Most important exclusion:
why was handycam / camcorders
excluded in the Zero1 awards? Why is
“Beat That!” feature missing in recent
editions? Lastly, why is your Agent 001
so muscular?

Sridhar Rao
Devangere

On page 68 of Digit December 2008, the text
reads, “prices of netbooks range...” You have
mistakenly read this as notebooks.

Although we did make an exception for
Chrome, we’re not likely to include beta
versions too often in software comparisons. 

Agent 001 has an acute body image
problem, and spends unhealthy amounts of
time in the gym. That said, he is currently
seeking therapy... fingers-crossed!

Team Digit

Feedback galore
I bought my first copy of Digit in April
2004 and have been buying it since
then. Initially, I bought it only for game
demos and software — it took me a few
months to realise that I was missing
the fun — the real cream is in the
articles inside the magazine. 

I am fascinated by computer
technology and games right from the

day I started reading Digit. It has been
invaluable to my career and personal
interests. When my dad bought me a
Computer in 2003 I didn’t even know
where the CPU was inside the cabinet!
Now I have assembled nearly ten
desktops for my friends just by reading
your mag! I even get queries about
games and software installations from
my friends. I refer to Digit heavily for
these purposes and more importantly, I
love it!

Now for some feedback:
1. I really really enjoy your regulars

especially, Agent 001, Tech Quiz, People
Who Changed Computing and Inbox.

2. The Visual Buying guide blew me
away; it rocks, it’s superb, I strongly
request you to continue the ‘Visual
Buying Guide’ hereafter.

3. The thing I like about Digit very
much is its Indian-feel and approach to
the computer and tech world. Keep it up
guys, your real style is inside the articles.

4. Regarding Fast Track, it rocks.
Though I have some suggestions for
that.

5. How about starting a new regular
section on the mag called “Digit
Projects”, which includes both
hardware and software projects that
enthusiastic students and professionals
can emulate?

6. I read on an Intel website that
game engines can be used for many
purposes other than entertainment. For
example Epic’s Unreal Engine 3 is
currently used for medical simulations
and architectural fly-throughs. Which
made me wonder if physics engines like
‘Havoc’ used in games like Half-life 2 can
be used in schools to teach complex
physics to students! Since the Doom 3
engine will also be open-sourced in the
future, is it possible to do such things?

7. I feel sad for those Indians who
see gaming as an amateurish or
childish activity.  

Krishna Prasath

We’re glad we could help you follow-up on
your passion for technology.

We also thank you for taking the time to
give us detailed feedback, which is our
favourite kind. We will try and cover points
5 and 6 in upcoming issues, and yes we
agree with you on point number 7, because
all of us are also avid gamers, and
appreciate the entertainment and skill
enhancement it brings.

Team Digit
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THIS YEAR, I spent two nights in
Jaipur, one of my favourite cities
here. On the second of these
evenings, a couple of days before
writing this, I wanted to eat some-
thing authentically local. There was
just such a dish listed on the menu of
the Handi Restaurant. I ordered it,
and was told that it was spicy! “Fine”,
I said, “I just want it done normally,
no change.” When it came it was
rather insipid and I just thought I
had ended up in a bad restaurant.
But, at the end of the meal, prompted
by my wife, I asked about this. To my
surprise, I was told that the chef had
thought I would not like the normal
dish, and had made it bland for me,
directly contradicting my order!

I was furious, and made it very
clear that I felt cheated, and that I
would not pay for that dish. The chef
then sent from the kitchen, samples
of the sauce that was served to me,
and of the one that I should have been
given! A huge difference. So, I was par-
ticularly surprised when the errant
dish appeared on the bill, and I was
expected to pay for it. Much argument
followed, and I ended up accusing the
manager of racism and threatening to
call the police before it was deducted
from the bill. I have no idea what the
police would have made of all this
fuss, and I am quite sure the restau-
rant gave in mainly because of the
attention the other diners were giving
to all the noise.

In the UK, we have an old saying
that “The customer is always right”,
and here in India we have the famous
quote from Gandhi about the cus-
tomer being the “most important vis-
itor on our premises...” But during
the last three months I have heard a
surprising number of stories from
people here about very poor after-
sales service for IT products — specifi-
cally, poor service when something
goes wrong, even if the product is still
within warranty.

Of course, poor service can be
found all over the world, but so many
have now told me that it is of particu-
lar concern here. It is something we
wish to investigate further. Naturally,
our interest is limited to the IT indus-
try (and restaurants). 

I must say that in my own experi-
ence, if you want bad customer service
in India, you just need to open a bank
account. But with the IT industry, hav-
ing purchased one PC, two laptops
and a few peripherals from a small
dealership in Nehru Place, New Delhi,
the service that I have received has
been better here than anywhere else.
Better than I usually get in the UK,
where I have bought much more
equipment over the years.

So, what is going on? I have spoken
to quite a few people in the industry
about this issue, and they make very
different observations. At one
extreme, they tell me that many con-
sumers don’t know the law and their
rights and are therefore unable to
exercise those rights when something
goes wrong. At the other extreme, I
have been told that consumers’ 
expectations here are higher than
elsewhere — China was mentioned as
being similar to India in this respect —
to an extent that is probably unrea-
sonable. They therefore complain
about not getting the service they
think they deserve.

It has long been my view that good
customer service helps the vendors as
much as it does the customer, and gen-
erally helps drive the industry towards
better quality. And magazines like ours
should help drive this process. Vendors
that I speak to, generally tell me that
they welcome complaints from cus-
tomers because this helps them deliver
a better service. Yes, they would say
that, wouldn’t they? But it is also the
only way they can find out where they
need to improve.

One thing that I have been saying
to these people is that we will invite

Digit readers to let us know when they
have serious problems.

So please do this. If you have a gen-
uine example of truly bad service, such
as a product going wrong within war-
ranty and the supplier refusing to fix
or replace it, then please let us know
at: servicewatch@thinkdigit.com. Make
sure that you have proper documenta-
tion (receipt, etc.) to back up your 
complaint. We cannot promise even to
reply to all the emails we will receive,
but we will pick a selection and take
them up with the relevant companies
at the highest level. Some of the exam-
ples that you send us — of both good
and bad service — will be reported in
the magazine or on our web site. 
I doubt I will find another restaurant
with as bad a service as I received at the
Handi in Jaipur, but who knows, maybe
we’ll start a restaurant column as well.

The Last Word

Edward Henning, Editor-in-Chief

Customer first

“If you have a genuine
example of truly bad

service, such as a product
going wrong within

warranty and the supplier
refusing to fix or replace it,

please let us know”

edward.henning@9dot9.in


